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1 Getting Started

Vehicle Dynamics Blockset Product Description

1-2

Model and simulate vehicle dynamics in a virtual 3D environment

Vehicle Dynamics Blockset™ provides fully assembled reference application models that simulate
driving maneuvers in a 3D environment. You can use the prebuilt scenes to visualize roads, traffic
signs, trees, buildings, and other objects around the vehicle. You can customize the reference models
by using your own data or by replacing a subsystem with your own model. The blockset includes a

library of components for modeling propulsion, steering, suspension, vehicle bodies, brakes, and
tires.

Vehicle Dynamics Blockset provides a standard model architecture that can be used throughout the
development process. It supports ride and handling analyses, chassis controls development, software
integration testing, and hardware-in-the-loop testing. By integrating vehicle dynamics models with a
3D environment, you can test ADAS and automated driving perception, planning, and control
software. These models let you test your vehicle with standard driving maneuvers such as a double
lane change or with your own custom scenarios.

Key Features

* Preassembled vehicle dynamics models for passenger cars and trucks

* Preassembled maneuvers for common ride and handling tests, including a double-lane change
+ 3D environment for visualizing simulations and communicating scene information to Simulink®
» Libraries of propulsion, steering, suspension, vehicle body, brake, and tire components

* Combined longitudinal and lateral slip dynamic tire models

* Predictive driver model for generating steering commands that track a predefined path

* Prebuilt 3D scenes, including straight roads, curved roads, and parking lots
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1 Getting Started

Required and Recommended Products

Required Products
Vehicle Dynamics Blockset product requires current versions of these products:

« MATLAB
e Simulink

Recommended Products

You can extend the capabilities of the Vehicle Dynamics Blockset using the following recommended

products.
Goal Recommended Products
Model events Stateflow®
Test closed-loop perception, planning, |Automated Driving Toolbox™
and control algorithms
RoadRunner
Test vehicle-level integration Powertrain Blockset™
Optimize vehicle energy consumption,
ride and handling
Generate optimized suspension Model-Based Calibration Toolbox™
parameters
Simscape™ Multibody™
See Also
More About
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
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Engine Calibration Maps

Engine Calibration Maps

Calibration maps are a key part of the Mapped CI Engine and Mapped SI Engine blocks available in
the Vehicle Dynamics Blockset. Engine models use the maps to represent engine behavior and to
store optimal control parameters. Using calibration maps in control design leads to flexible, efficient
control algorithms and estimators that are suitable for electronic control unit (ECU) implementation.

To develop the calibration maps for engine plant models in the reference applications, MathWorks®
developed and used processes to measure performance data from 1.5-L spark-ignition (SI) and
compression-ignition (CI) engine models provided by Gamma Technologies LLC.

To represent the behavior of engine plants specific to your application, you can develop your own
engine calibration maps. The data required for calibration typically comes from engine dynamometer
tests or engine hardware design models.

Engine Plant Calibration Maps

The engine plant model calibration maps in the Mapped CI Engine and Mapped SI Engine blocks
affect the engine response to control inputs (for example, spark timing, throttle position, and cam
phasing).

To develop the calibration maps in the engine plant models, MathWorks used GT-POWER models from
the GT-SUITE modeling library in a Simulink-based virtual dynamometer. MathWorks used the Model-
Based Calibration Toolbox to create design-of-experiment (DoE) test plans. The Simulink-based virtual
dynamometer executed the DoE test plan on GT-POWER 1.5-L SI and CI reference engines.
MathWorks used the Model-Based Calibration Toolbox to develop the engine plant model calibration
maps from the GT-POWER.

Calibration Maps in the Mapped Cl Engine Block

The Mapped CI Engine block implements these calibration maps.
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fuel mass and
engine speed

Map Used For In Description
Engine brake |Engine brake |Mapped CI |The engine brake torque lookup table is a function of
torque torque as a Engine commanded fuel mass and engine speed, Ty qke = f(F,
function of N), where:
commanded
fuel mass and *  Tprake is engine torque, in N-m.
engine speed + Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
£
Engine Speed (RPM) 0 o 0
Commanded Fuel (mg/inj)
Engine air Engine air mass [Mapped CI |The air mass flow lookup table is a function of
mass flow flow as a Engine commanded fuel mass and engine speed, Mjyk =
function of f(Fpax, N), where:
commanded

*  Minek is engine air mass flow, in kg/s.

Fra is commanded fuel mass, in mg per injection.

N is engine speed, in rpm.
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Map Used For In Description
Engine fuel |Engine fuel flow [Mapped CI |The engine fuel flow lookup table is a function of
flow as a function of |Engine commanded fuel mass and engine speed, MassFlow=
commanded f(F, N), where:
fuel mass and _ . .
engine speed * MassFlow is engine fuel mass flow, in kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
0.01
¥ o.008
E‘DDDE
% 0.004
=
© 0.002
o
6000
2000 20
Engine Speed (RPM) 0 0 1o
Commanded Fuel (mg/inj)
Engine Engine exhaust |[Mapped CI |The engine exhaust temperature table is a function of
exhaust temperature as |Engine commanded fuel mass and engine speed, T,,= f(F, N),
temperature |a function of where:

commanded
fuel mass and
engine speed

o T..nis exhaust temperature, in K.
* Fis commanded fuel mass, in mg per injection.
* N s engine speed, in rpm.

1400

< 1200

=]
=]
=]

400

Exhaust Temperature

200
6000

2000 20

10
Engine Speed (RPM) 0 o

Commanded Fuel (mg/inj)
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Map Used For In Description
Brake-specific | BSFC efficiency |[Mapped CI |The brake-specific fuel consumption (BSFC) efficiency
fuel as a function of |Engine is a function of commanded fuel mass and engine
consumption |commanded speed, BSFC= f(F, N), where:
(BSFC) fuel mass and . '
efficiency engine speed * BSFCis BSFC, in g/kWh.

* Fis commanded fuel mass, in mg per injection.

* N is engine speed, in rpm.

Engine Speed (RPM) 0 g 10 v

Commanded Fuel (mg/inj)

Engine-out EO hydrocarbon |[Mapped CI |The engine-out hydrocarbon emissions are a function
(EO) emissions as a |Engine of commanded fuel mass and engine speed, EO HC=
hydrocarbon |function of f(F, N), where:
emissions commanded

fuel mass and
engine speed

* EO HC is engine-out hydrocarbon emissions, in
kg/s.

* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

%1078
5

EOQHC (kg/s)
MW

2000 20

10
Engine Speed (RPM) 0 o

Commanded Fuel (mgfinj)




Engine Calibration Maps

Map Used For In Description
Engine-out EO carbon Mapped CI |The engine-out carbon monoxide emissions are a
(EO) carbon |monoxide Engine function of commanded fuel mass and engine speed,
monoxide emissions as a EO CO= f(F, N), where:
emissions function of ) . ] o ]
commanded * EO CO is engine-out carbon monoxide emissions, in
fuel mass and kg/s.
engine speed * Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
2000 20
Engine Speed (RPM) 0 9 0
Commanded Fuel (mgfinj)
Engine-out EO nitric oxide |Mapped CI |The engine-out nitric oxide and nitrogen dioxide
(EO) nitric and nitrogen Engine emissions are a function of commanded fuel mass and
oxide and dioxide engine speed, EO NOx= f(F, N), where:
nitrogen emissions as a ) ) o ) )
dioxide function of * EO NOx is engine-out nitric oxide and nitrogen

commanded
fuel mass and
engine speed

dioxide emissions, in kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

%1074
25

2

1.5

50

20
10
Engine Speed (RPM) 0 o

Commanded Fuel (mg/inj)
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commanded
fuel mass and
engine speed

Map Used For In Description

Engine-out EO carbon Mapped CI |The engine-out carbon dioxide emissions are a

(EO) carbon |dioxide Engine function of commanded fuel mass and engine speed,
dioxide emissions as a EO CO2= f(F, N), where:

emissions function of

* EO COZ2 is engine-out carbon dioxide emissions, in

kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

EO CO2 (kgis)

6000
50

2000 20

10
Engine Speed (RPM) 0 o
Commanded Fuel (mg/inj)

Calibration Maps in the Mapped SI Engine Block

The Mapped SI Engine block implements these calibration maps.

engine speed

Map Used For In Description

Engine torque |[Engine brake = |Mapped SI |The engine torque lookup table is a function of
torque as a Engine commanded engine torque and engine speed, T =
function of f(Tyma, N), where:
commanded
torque and * Tis engine torque, in N-m.

* T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.

N o= n
=] o =]
=] (=1 =]

Actual Torgue (Nm)
3

2000
50
Engine Speed (RPM) 0 o

Commanded Torque (Nm)
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Map Used For In Description
Engine air Engine air mass [Mapped SI |The engine air mass flow lookup table is a function of
mass flow flow as a Engine commanded engine torque and engine speed, Mjpsk =
function of f(T.mg, N), where:
commanded
torque and *  Mintk iS engine air mass flow, in kg/s.
engine speed * T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.
0.1
% 0.08
g 0.06
LL;'J 0.04
S
E 0.02
1]
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torgue (Nm)
Engine fuel |Engine fuel flow [Mapped SI |The engine fuel mass flow lookup table is a function of
flow as a function of |Engine commanded engine torque and engine speed,
commanded MassFlow = f(T,,g, N), where:
torque mass i ) )
and engine * MassFlow is engine fuel mass flow, in kg/s.
speed * T, is commanded engine torque, in N-m.

* N is engine speed, in rpm.

X
@ 2
la

@

Fuel Mass Flow (kg/s)
L -

=]
=]
=]
=3=}
¥

200

2000
50
Engine Speed (RPM) 0 o

Commanded Torgue (Nm)
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Map Used For In Description
Engine Engine exhaust |Mapped SI |The engine exhaust temperature lookup table is a
exhaust temperature as |Engine function of commanded engine torque and engine
temperature |a function of speed, To = f(T;g, N), where:
commanded ) .
torque and * T, is exhaust temperature, in K.
engine speed * T.ngis commanded engine torque, in N-m.
* N s engine speed, in rpm.
1200
% 1100
% 1000
é 900
'.G:L: 800
.‘.':E 700
. 600
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)
Brake-specific | Brake-specific |Mapped SI |The brake-specific fuel consumption (BSFC) efficiency
fuel fuel Engine is a function of commanded engine torque and engine

consumption
(BSFC)
efficiency

consumption
(BSEC) as a
function of
commanded
torque and
engine speed

speed, BSFC = f(T,,q4, N), where:

* BSFC is BSFC, in g/kWh.
* T,ngis commanded engine torque, in N-m.
* N s engine speed, in rpm.

200

50
Engine Speed (RPM) 0 o

Commanded Torque (Nm)
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Map Used For In Description
Engine-out  |EO hydrocarbon |Mapped SI |The engine-out hydrocarbon emissions are a function
(EO) emissions as a |Engine of commanded engine torque and engine speed, EO
hydrocarbon |function of HC = f(T g, N), where:
emissions commanded ] _ o .
torque and * EO HC is engine-out hydrocarbon emissions, in
engine speed kg/s.
* T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.
%107
12
,

g 0.8

% 0.6

I

E 04

0.2
0
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)

Engine-out EO carbon Mapped SI |The engine-out carbon monoxide emissions are a
(EO) carbon |monoxide Engine function of commanded engine torque and engine
monoxide emissions as a speed, EO CO = f(T,g, N), where:
emissions function of

commanded
torque and
engine speed

* EO CO is engine-out carbon monoxide emissions, in
kg/s.

* T, is commanded engine torque, in N-m.
* N s engine speed, in rpm.

%103

50

Engine Speed (RPM) 0 o
Commanded Torgue (Nm)
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Map Used For In Description
Engine-out EO nitric oxide |Mapped SI |The engine-out nitric oxide and nitrogen dioxide
(EO) nitric and nitrogen Engine emissions are a function of commanded engine torque
oxide and dioxide and engine speed, EO NOx = f(T,,4, N), where:
nitrogen emissions as a ) . o .
dioxide function of * EO NOx is engine-out nitric oxide and nitrogen
emissions commanded dioxide emissions, in kg/s.
torque and * T.ngis commanded engine torque, in N-m.
engine speed * N is engine speed, in rpm.
x107*
1.5
2
&
=
Q 05
w
0
6000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)
Engine-out EO carbon Mapped SI |The engine-out carbon dioxide emissions are a
(EO) carbon |dioxide Engine function of commanded engine torque and engine
dioxide emissions as a speed, EO CO2 = f(T g, N), where:
emissions function of , _ o o _
commanded * [EO CO2 is engine-out carbon dioxide emissions, in
torque and kg/s.
engine speed * T.ngis commanded engine torque, in N-m.
* N is engine speed, in rpm.
1‘_‘?"%—‘ o
=S
oY
2000
Engine Speed (RPM) 0 g
Commanded Torque (Nm)
See Also

Mapped CI Engine | Mapped SI Engine
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External Websites

. Virtual Engine Calibration: Making Engine Calibration Part of the Engine Hardware Design
Process
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Yaw Stability on Varying Road Surfaces

This example shows how to run the vehicle dynamics double-lane change maneuver on different road
surfaces, analyze the vehicle yaw stability, and determine the maneuver success.

ISO 3888-2 defines the double-lane change maneuver to test the obstacle avoidance performance of a
vehicle. In the test, the driver:

» Accelerates until vehicle hits a target velocity

* Releases the accelerator pedal

* Turns steering wheel to follow path into the left lane

* Turns steering wheel to follow path back into the right lane

Typically, cones mark the lane boundaries. If the vehicle and driver can negotiate the maneuver
without hitting a cone, the vehicle passes the test.

For more information about the reference application, see “Double-Lane Change Maneuver” on page
3-21.

helpersetupdlc;

W ﬂ Visualization
o

| VetiRet

r

Lane Change Reference . ,,' K
Generator By
Initialize: from model o 4

river Commands

Predictive: Driver

Controllers
Environment >

Sensors

Passenger Vehicle

Help
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Run a Double-Lane Change Maneuver

1. Open the Lane Change Reference Generator block. By default, the maneuver is set with these
parameters:

* Longitudinal entrance velocity setpoint — 35 mph

* Vehicle width — 2 m

* Lateral reference position breakpoints and Lateral reference data — Values that specify the
lateral reference trajectory as a function of the longitudinal distance

2. In the Visualization subsystem, open the 3D Engine block. By default, the 3D Engine parameter is
set to Disabled. For the 3D visualization engine platform requirements and hardware



Yaw Stability on Varying Road Surfaces

recommendations, see the “Unreal Engine Simulation Environment Requirements and Limitations” on
page 8-6.

3. Run the maneuver. As the simulation runs, view the vehicle information.

mdl = 'DLCReferenceApplication';
sim(mdl);

### Starting serial model reference simulation build

### Successfully updated the model reference simulation target for: Driveline

### Successfully updated the model reference simulation target for: PassVehl14DOF
### Successfully updated the model reference simulation target for: SiMappedEngineV

Build Summary

Simulation targets built:

Model Action Rebuild Reason
Driveline Code generated and compiled Driveline msf.mexw64 does not exist.
PassVeh14DOF Code generated and compiled PassVehl4DOF msf.mexw64 does not exist.

SiMappedEngineV Code generated and compiled SiMappedEngineV msf.mexw64 does not exist.

3 of 3 models built (0 models already up to date)
Build duration: 0h 5m 23.197s

1-17
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250 L Velocity: 9 mis _
Engine: 1317 RPM
Gear: 4
200 | y
E
3 150 ]
-
-
D
0 100 -
X
o0 1 T
D 1 1 1 1
-100 -50 0 20 100

Y Distance [m]

* In the Vehicle Position window, view the vehicle longitudinal distance as a function or the lateral
distance.

* In the Visualization subsystem, open the Lane Change scope block to display the lateral
displacement as a function of time. The red and orange lines mark the cone boundaries. The blue
line marks the reference trajectory and the green line marks the actual trajectory. The green line
does come close to the red line that marks the cones.
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* In the Visualization subsystem, if you enable the 3D Engine block visualization environment, you
can view the vehicle response in the AutoVrtlEnv window.

Sweep Surface Friction

Run the reference application on three road surfaces with different friction scaling coefficients. Use
the results to analyze the yaw stability and help determine the success of the maneuver.

1. In the double-lane change reference application model DLCReferenceApplication, open the
Environment subsystem. The Friction block parameter Constant value specifies the friction scaling
coefficient. By default, the friction scaling coefficient is 1.0. The reference application uses the
coefficient to adjust the friction at every time step.

2. Enable signal logging for the velocity, lane, and ISO signals. You can use the Simulink® editor or,
alternatively, these MATLAB® commands. Save the model.

* Enable signal logging for the Lane Change Reference Generator outport Lane signal.
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Lane Change Reference
Generator

Driver Commands
Predictive Driver

mdl = 'DLCReferenceApplication’;
ph=get param('DLCReferenceApplication/Lane Change Reference Generator', 'PortHandles');
set param(ph.Outport(1), 'DataLogging', 'on');

* Enable signal logging for the Passenger Vehicle block outport signal.

Passenger Vighicle

ph=get param('DLCReferenceApplication/Passenger Vehicle', 'PortHandles"');
set param(ph.Outport(1), 'DatalLogging','on');

* In the Visualization subsystem, enable signal logging for the ISO block.

|5l Block Parameters: 150 15037-1:2006
1SO 15037-1:2006 (mask)

Enables display of 1SO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements

(® Enabled
O%Isamed
set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');

3. Set up a vector with the friction scaling coefficients, Lambdamu, that you want to investigate. For
example, to examine friction scaling coefficients equal to 0.9, 0.95, and 1.0, at the command line
enter:
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lambdamu = [0.9, 0.95, 1.0];
numExperiments = length(lambdamu);

4. Create an array of simulation inputs that sets Lambdamu equal to the Friction constant block
parameter.

for idx = numExperiments:-1:1
in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Environment/Friction'], ...
'Value',['ones(4,1).*"',num2str(lambdamu(idx))]1);
end

5. Set the simulation stop time at 25 s. Save the model and run the simulations. If available, use
parallel computing.

set param(mdl, 'StopTime', '25")

save system(mdl)

tic;

simout = parsim(in, 'ShowSimulationManager', 'on');
toc;

[08-Jul-2021 10:11:51] Checking for availability of parallel pool...
[08-Jul-2021 10:11:51] Starting Simulink on parallel workers...
[08-Jul-2021 10:11:53] Loading project on parallel workers...
[08-Jul-2021 10:11:53] Configuring simulation cache folder on parallel workers...
[08-Jul-2021 10:11:53] Loading model on parallel workers...
[08-Jul-2021 10:12:13] Running simulations...

[08-Jul-2021 10:12:41] Completed 1 of 3 simulation runs

[08-Jul-2021 10:12:42] Completed 2 of 3 simulation runs

[08-Jul-2021 10:14:12] Completed 3 of 3 simulation runs

[08-Jul-2021 10:14:13] Cleaning up parallel workers...

Elapsed time is 151.636393 seconds.

6. After the simulations complete, close the Simulation Data Inspector windows.
Use Simulation Data Inspector to Analyze Results

Use the Simulation Data Inspector to examine the results. You can use the Ul or, alternatively,
command-line functions.

1. Open the Simulation Data Inspector. On the Simulink Toolstrip, on the Simulation tab, under
Review Results, click Data Inspector.

* In the Simulation Data Inspector, select Import.

Import
Import from workspace of file

* In the Import dialog box, clear Logsout. Select simout (1), simout(2), and simout(3).
Select Import.
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Import

mport bme senes dafe from the base workspace or & file

Import from: « Base workspace

File

Import to: e MNew run

Existing run

W o |

& F simoutl(1)
< ¥ simout(2)

< ¢ simout(d)

* Use the Simulation Data Inspector to examine the results.

2. Alternatively, use these MATLAB commands to create 6 plots. The first three plots mark the upper
lane boundary, UB, lower lane boundary, LB, and lateral vehicle distance, Y, for each run.

The next three plots provide the lateral acceleration, ay, lateral vehicle distance, Y, and yaw rate, r,
for each run.

for idx = l:numExperiments
% Create sdi run object
simoutRun(idx)=Simulink.sdi.Run.create;
simoutRun(idx) .Name=["'lambdamu = ', num2str(lambdamu(idx))];
add(simoutRun(idx), 'vars',simout(idx));

end

sigcolor=[1 0 O];

for idx = l:numExperiments
% Extract the maneuver upper and lower lane boundaries
ubsignal(idx)=getSignalByIndex(simoutRun(idx),1);
ubsignal(idx).LineColor = sigcolor;
lbsignal(idx)=getSignalByIndex(simoutRun(idx),2);
lbsignal(idx).LineColor = sigcolor;

end

sigcolor=[0 1 0;0 0 1;1 0 1];

for idx = l:numExperiments
% Extract the lateral acceleration, position, and yaw rate
ysignal(idx)=getSignalByIndex(simoutRun(idx),27);
ysignal(idx).LineColor =sigcolor((idx),:);
rsignal(idx)=getSignalByIndex(simoutRun(idx),77);
rsignal(idx).LineColor =sigcolor((idx),:);
asignal(idx)=getSignalByIndex(simoutRun(idx),79);
asignal(idx).LineColor =sigcolor((idx),:);

end

Simulink.sdi.view

Simulink.sdi.setSubPlotLayout (numExperiments,2);

for idx = l:numExperiments
% Plot the lateral position and lane boundaries
plotOnSubPlot(ubsignal(idx), (idx),1,true);
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plotOnSubPlot(lbsignal(idx), (idx),1,true);
plotOnSubPlot(ysignal(idx), (idx),1,true);

end
for idx = l:numExperiments

% Plot the lateral acceleration, position, and yaw rate

plotOnSubPlot(asignal(idx),1,2,true);
plotOnSubPlot(ysignal(idx),2,2,true);
plotOnSubPlot(rsignal(idx),3,2,true);

end

The results are similar to these plots, which indicate that the vehicle has a yaw rate of about

when the friction scaling coefficient is equal to 1.
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Further Analysis
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To explore the results further, use these commands to extract the lateral acceleration, steering angle,
and vehicle trajectory from the simout object.

1. Extract the lateral acceleration and steering angle. Plot the data. The results are similar to this
plot. They indicate that the greatest lateral acceleration occurs when the friction scaling coefficient is

1.
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figure

for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;
legend labels{idx} = ['lambdamu = ', num2str(lambdamu(idx))];
% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
hold on

end

% Add labels to the plots

legend(legend labels, 'Location', 'best');

title('Lateral Acceleration')

xlabel('Steering Angle [deg]')

ylabel('Acceleration [m/s"2]"')

grid on

Lateral Acceleration

10 - -

Acceleration [mfsz]

lambdamu = 0.9
lambdamu = 0.95
lambdamu = 1

_a 1 1 1 1 1 1 1
-800 600 400 -200 0 200 400 600 800

Steering Angle [deg]

2. Extract the vehicle path. Plot the data. The results are similar to this plot. They indicate that the
greatest lateral vehicle position occurs when the friction scaling coefficient is 0. 9.

figure
for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
x = log{3}.Values.Body.InertFrm.Cg.Disp.X.Data;
y = log{3}.Values.Body.InertFrm.Cg.Disp.Y.Data;
legend labels{idx} = ['lambdamu = ', num2str(lambdamu(idx))];
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% Plot vehicle location
plot(y,x)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Vehicle Path'")
xlabel('Y Position [m]"')
ylabel('X Position [m]"')
grid on

Vehicle Path

300 T T

lambdamu = 0.9
lambdamu = 0.495
250 lambdamu = 1 ]

200 t —_— l

150 _

X Position [m]
=
=

50 ]

Y Position [m)]

See Also
Simulink.SimulationInput | Simulink.SimulationOutput

References

[1]1 ISO 3888-2: 2011. Passenger cars — Test track for a severe lane-change manoeuvre.
See Also

Related Examples
. “Send and Receive Double-Lane Change Scene Data” on page 3-88
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More About

. “Double-Lane Change Maneuver” on page 3-21
. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8
. Simulation Data Inspector
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Vehicle Steering Gain at Different Speeds

This example shows how to use the vehicle dynamics slowly increasing steering reference application
to analyze the impact of the steering angle and speed on vehicle handling. Specifically, you can
calculate the steering gain when you run the maneuver with different speed set points. Based on the
constant speed, variable steer test defined in SAE J266, the slowly increasing steering maneuver
helps characterize the lateral dynamics of the vehicle. In the test, the driver:

» Accelerates until vehicle hits a target velocity.

* Maintains a target velocity.

* Linearly increases the steering wheel angle from 0 degrees to a maximum angle.
* Maintains the steering wheel angle for a specified time.

* Linearly decreases the steering wheel angle from maximum angle to O degrees.

For more information about the reference application, see “Slowly Increasing Steering Maneuver” on

page 3-50.
helpersetupsis;
P VishF bk Rl B Vet Rt

Visualization

] Ve

Slowly Increasing Steear

Driver Commands
Predictive Driver

k4

iy
(— )
| > *
l—\!z—\!'-' o
Controllers
Help Emvironment >

Pazsenger Vehicle

Copyright 2018-2021 The MathWaorks, Inc.

Run a Slowly Increasing Steering Maneuver

1. Open the Swept Sine Reference Generator block. By default, the maneuver is set with these
parameters:

* Longitudinal speed setpoint — 50 mph
* Handwheel rate — 13.5 deg
* Maximum handwheel angle — 270 deg

2. In the Visualization subsystem, open the 3D Engine block. By default, the 3D Engine parameter is
set to Disabled. For the 3D visualization engine platform requirements and hardware
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recommendations, see the “Unreal Engine Simulation Environment Requirements and Limitations” on
page 8-6.

3. Run the maneuver with the default settings. As the simulation runs, view the vehicle information.

mdl = 'ISReferenceApplication';
sim(mdl);

### Starting serial model reference simulation build

### Successfully updated the model reference simulation target for: Driveline

### Successfully updated the model reference simulation target for: PassVehl14DOF
### Successfully updated the model reference simulation target for: SiMappedEngineV

Build Summary

Simulation targets built:

Model Action Rebuild Reason
Driveline Code generated and compiled Driveline msf.mexw64 does not exist.
PassVeh14DOF Code generated and compiled PassVehl4DOF msf.mexw64 does not exist.

SiMappedEngineV Code generated and compiled SiMappedEngineV msf.mexw64 does not exist.

3 of 3 models built (0 models already up to date)
Build duration: 0h 5m 28.185s
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* In the Vehicle Position window, view the vehicle longitudinal distance as a function or the lateral
distance. The yellow line displays the yaw rate. The blue line shows the steering angle.

In the Visualization subsystem, open the Yaw Rate and Steer Scope block to display the yaw rate

and steering angle versus time.
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Sweep Speed Set Points
Run the slowly increasing steering angle reference application with three different speed set points.

1. In the slowly increasing steering reference application model ISReferenceApplication, open the
Slowly Increasing Steer block. The Longitudinal speed set point, xdot_r block parameter sets the
vehicle speed. By default, the speed is 50 mph.

2. Enable signal logging for the velocity, lane, and ISO signals. You can use the Simulink® editor or,
alternatively, these MATLAB® commands. Save the model.

» Enable signal logging for the Slowly Increasing Steer Ref signal outport.

4 M- .
el b F bk Rl f————

w.

Driver Commands

Predictive Driver

Slowly Increasing Stear
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mdl = 'ISReferenceApplication’;
ph=get param('ISReferenceApplication/Slowly Increasing Steer', 'PortHandles');
set param(ph.Outport(1), 'DataLogging', 'on');

* Enable signal logging for the Passenger Vehicle block outport signal.

Passenger Vishicke

ph=get param('ISReferenceApplication/Passenger Vehicle', 'PortHandles');
set param(ph.Outport(1), 'DataLogging', 'on');

* In the Visualization subsystem, enable signal logging for the ISO block.

\*a) Block Parameters: 150 15037-1:2006
IS0 15037-1:2006 {mask)

Enables display of 1SO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements
®) Enabled
() Disabled

set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable"');

3. Set up a speed set point vector, xdot r, that you want to investigate. For example, at the
command line, type:

vmax = [45, 50, 55];
numExperiments = length(vmax);

4. Create an array of simulation inputs that set the Swept Sine Reference Generator block parameter
Steering amplitude, theta_hw equal to amp.

for idx = numExperiments:-1:1
in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Slowly Increasing Steer'],
‘xdot r', num2str(vmax(idx)));
end

5. Save the model and run the simulations. If available, use parallel computing.

save_system(mdl)
tic;

1-31



1 Getting Started

simout = parsim(in, 'ShowSimulationManager', 'on');
toc;

[23-Jun-2021 15:45:12] Checking for availability of parallel pool...
[23-Jun-2021 15:45:12] Starting Simulink on parallel workers...
[23-Jun-2021 15:45:14] Loading project on parallel workers...
[23-Jun-2021 15:45:14] Configuring simulation cache folder on parallel workers...
[23-Jun-2021 15:45:14] Loading model on parallel workers...
[23-Jun-2021 15:45:27] Running simulations...

[23-Jun-2021 15:46:21] Completed 1 of 3 simulation runs

[23-Jun-2021 15:46:21] Completed 2 of 3 simulation runs

[23-Jun-2021 15:46:22] Completed 3 of 3 simulation runs

[23-Jun-2021 15:46:22] Cleaning up parallel workers...

Elapsed time is 81.594518 seconds.

6. After the simulations complete, close the Simulation Data Inspector windows.
Use Simulation Data Inspector to Analyze Results

Use the Simulation Data Inspector to examine the results. You can use the Ul or, alternatively,
command-line functions.

1. Open the Simulation Data Inspector. On the Simulink Toolstrip, on the Simulation tab, under
Review Results, click Data Inspector.

* In the Simulation Data Inspector, select Import.

‘ Import

- IMport irom workspace of file

* In the Import dialog box, clear Logsout. Select simout (1), simout(2), and simout(3).
Select Import.

Import

Impaort tirme sanas dafa from the base werkspace or a file

Import from: « Base workspace

File

Import to: & New run

Existing run

W g
| v simout]l)

¢ simout(2)

| » simout(3)

* Use the Simulation Data Inspector to examine the results.
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2. Alternatively, use these MATLAB commands to plot the longitudinal velocity, steering wheel angle,
lateral acceleration, longitudinal position, and lateral position.

for idx = l:numExperiments
% Create sdi run object
simoutRun(idx)=Simulink.sdi.Run.create;
simoutRun(idx).Name=['Velocity = ', num2str(vmax(idx))];
add (simoutRun(idx), 'vars',simout (idx));

end

sigcolor=[0 1 0;0 0 1;1 0 11;

for idx = l:numExperiments
% Extract the lateral acceleration, position, and steering
xsignal(idx)=getSignalByIndex(simoutRun(idx),22);
xsignal(idx).LineColor =sigcolor((idx),:);
ysignal (idx)=getSignalByIndex(simoutRun(idx),b23);
ysignal(idx).LineColor =sigcolor((idx),:);
msignal(idx)=getSignalByIndex(simoutRun(idx),256);
msignal(idx).LineColor =sigcolor((idx),:);
ssignal(idx)=getSignalByIndex(simoutRun(idx),b255);
ssignal(idx).LineColor =sigcolor((idx),:);
asignal(idx)=getSignalByIndex(simoutRun(idx),h251);
asignal(idx).LineColor =sigcolor((idx),:);

end

Simulink.sdi.view

Simulink.sdi.setSubPlotLayout(5,1);

for idx = l:numExperiments
% Plot the lateral position, steering angle, and lateral acceleration
plotOnSubPlot(msignal(idx),1,1,true);

plotOnSubPlot(ssignal(idx),2,1,true);
plotOnSubPlot(asignal(idx),3,1,true);
plotOnSubPlot(xsignal(idx),4,1,true);
plotOnSubPlot(ysignal(idx),5,1,true);

end

The results are similar to these plots, which indicate that the greatest lateral acceleration occurs
when the vehicle velocity is 45 mph.
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Further Analysis

To explore the results further, use these commands to extract the lateral acceleration, steering angle,
and vehicle trajectory from the simout object.

1. Extract the lateral acceleration and steering angle. Plot the data. The results are similar to this
plot.

figure

for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;
firstorderfit = polyfit(sa.Data,ay.Data,l);
gain(idx)=firstorderfit(1l);
legend labels{idx} = [num2str(vmax(idx)), ' mph: Gain = "',

num2str(gain(idx)), ' m/(deg s"2)'1];

% Plot steering angle vs. lateral acceleration
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plot(sa.Data,ay.Data)

hold on
end
% Add labels to the plots
legend(legend labels, 'Location',
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s"2]"')

'best');

grid on
Lateral Acceleration
10 . . : . . .
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E - -
e
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2. Extract the vehicle path. Plot the data. The results are similar to this plot.

figure
for idx 1:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
x = log{1l}.Values.Body.InertFrm.Cg.Disp.X.Data;
y = log{1}.Values.Body.InertFrm.Cg.Disp.Y.Data;
legend labels{idx} = [num2str(vmax(idx)),
% Plot vehicle location
axis('equal')
plot(y,x)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location',
title('Vehicle Path')
xlabel('Y Position [m]"')

'best');

" mph'];
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ylabel('X Position [m]"')

grid on
Vehicle Path
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References

[1] SAE ]J266. Steady-State Directional Control Test Procedures For Passenger Cars and Light Trucks.
Warrendale, PA: SAE International, 1996.

See Also
Simulink.SimulationInput | Simulink.SimulationOutput | polyfit

More About

. “Slowly Increasing Steering Maneuver” on page 3-50
. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8
. Simulation Data Inspector
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Vehicle Lateral Acceleration at Different Speeds

This example shows how to use the vehicle dynamics constant radius reference application to analyze
the impact of speed on the vehicle lateral dynamics. Specifically, you can examine the lateral
acceleration when you run the maneuver with different speeds. For information about similar
maneuvers, see standards SAE J266 199601 and ISO 4138:2012.

During the maneuver, the vehicle uses a predictive driver model to maintain a pre-specified turn
radius at a set velocity.

For more information about the reference application, see “Constant Radius Maneuver” on page 3-

helpersetupcr;
b ) N Wisualization
" veanualni !s
Referance Generator Drriver Commands
Constant Radius Predictive Driver
p—

- I SRt > >

v

—

Controllers
Help Environment »

Sensars

Passanger Vehicke

Copyright 2018-2021 The MathWorks, Inc.

Run a Constant Radius Maneuver
1. Open the Reference Generator block. By default, the maneuver is set with these parameters:

* Maneuver — Constant radius

* Use maneuver-specific driver, initial position, and scene — on

* Longitudinal velocity — 35 mph

* Radius value — 100 m

2. Select the Reference Generator block 3D Engine tab. By default, the 3D Engine parameter is

Disabled. For the 3D visualization engine platform requirements and hardware recommendations,
see the “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6.

3. Run the maneuver with the default settings. As the simulation runs, view the vehicle information.
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mdl = 'CRReferenceApplication';
sim(mdl);

### Starting serial model reference simulation build

### Successfully updated the model reference simulation target for: Driveline

### Successfully updated the model reference simulation target for: PassVehl4DOF
### Successfully updated the model reference simulation target for: SiMappedEngineV

Build Summary

Simulation targets built:

Rebuild Reason

Model Action
Driveline Code generated and compiled
PassVeh14DOF Code generated and compiled

SiMappedEngineV Code generated and compiled

Driveline msf.mexw64 does not exist.
PassVeh14DOF msf.mexw64 does not exist.
SiMappedEngineV_msf.mexwb64 does not exist.

3 of 3 models built (0 models already up to date)

Build duration: Oh 4m 52.28s
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* In the Vehicle Position window, view the vehicle longitudinal distance as a function or the lateral
distance. The yellow line displays the yaw rate. The blue line shows the steering angle.

* In the Visualization subsystem, open the Steer, Velocity, Lat Accel Scope block to display the
steering angle, velocity, and lateral acceleration versus time.

4 Steer, Velacity, Lat Accel - O *

File Tools WView Simulation Help £

Q- OP® - &-EH-F&F-

Ready Sample based T=60.000

Sweep Speed

Run the constant radius reference application with three different speeds. Stop the simulation if the
vehicle exceeds a lateral acceleration threshold of .5 g.

1. In the slowly increasing steering reference application model CRReferenceApplication, open the
Reference Generator block. The Longitudinal speed set point, xdot_r block parameter sets the
vehicle speed. By default, the speed is 50 mph.

2. Enable signal logging for the velocity, lane, and ISO signals. You can use the Simulink® editor or,
alternatively, these MATLAB® commands. Save the model.

* Select the Reference Generator block Stop simulation at lateral acceleration threshold
parameter.

Lateral acceleration threshold, ay_max [g]: |D.5

Stop simulation at lateral acceleration threshold

set param([mdl '/Reference Generator'],'cr ay stop','on');

* Enable signal logging for the Reference Generator Vis signal outport.
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Reference Generator Driver Commands
Constant Radius Predictive Driver

ph=get param('CRReferenceApplication/Reference Generator', 'PortHandles');
set param(ph.Outport(1), 'DatalLogging','on');

* Enable signal logging for the Passenger Vehicle block outport signal.

Passenger Vishicle

ph=get param('CRReferenceApplication/Passenger Vehicle', 'PortHandles');
set param(ph.Outport(1), 'DataLogging', 'on');

* In the Visualization subsystem, enable signal logging for the ISO block.

|5l Block Parameters: 150 15037-1:2006
IS0 15037-1:2006 (mask)

Enables display of 1SO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements

giﬂ:;

set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');

3. Set up a speed set point vector, xdot 1, that you want to investigate. For example, at the command
line, type:



Vehicle Lateral Acceleration at Different Speeds

vmax = [35, 40, 45];
numExperiments = length(vmax);

4. Create an array of simulation inputs that set the Reference Generator block parameter
Longitudinal velocity reference, xdot_r equal to xdot_r.

for idx = numExperiments:-1:1
in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Reference Generator'],
'xdot r', num2str(vmax(idx)));
end

5. Save the model and run the simulations.

save_system(mdl)

tic;

simout = sim(in, 'ShowSimulationManager', 'on');
toc;

[28-Jun-2021 15:44:10] Running simulations...

### Starting serial model reference simulation build

### Model reference simulation target for Driveline is up to date.

### Model reference simulation target for PassVehl4DOF is up to date.
### Model reference simulation target for SiMappedEngineV is up to date.

Build Summary

0 of 3 models built (3 models already up to date)

Build duration: Oh Om 1.874s

[28-Jun-2021 15:47:22] Completed 1 of 3 simulation runs

### Starting serial model reference simulation build

### Model reference simulation target for Driveline is up to date.

### Model reference simulation target for PassVehl4DOF is up to date.
### Model reference simulation target for SiMappedEngineV is up to date.

Build Summary

0 of 3 models built (3 models already up to date)

Build duration: Oh Om 1.134s

[28-Jun-2021 15:50:30] Completed 2 of 3 simulation runs

### Starting serial model reference simulation build

### Model reference simulation target for Driveline is up to date.

### Model reference simulation target for PassVehl4DOF is up to date.
### Model reference simulation target for SiMappedEngineV is up to date.

Build Summary

0 of 3 models built (3 models already up to date)
Build duration: Oh Om 0.932s

[28-Jun-2021 15:53:21] Completed 3 of 3 simulation runs
Elapsed time is 561.055572 seconds.
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6. Close the Simulation Data Inspector windows.

Use Simulation Data Inspector to Analyze Results

Use the Simulation Data Inspector to examine the results. You can use the Ul or, alternatively,
command-line functions.

1. Open the Simulation Data Inspector. On the Simulink Toolstrip, on the Simulation tab, under
Review Results, click Data Inspector.

* In the Simulation Data Inspector, select Import.

I |
i rn-fT']'il:J workspace or file

* In the Import dialog box, clear logsout. Select simout (1), simout(2), and simout(3). Select
Import.
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Import

Import time senes dafa from [he base workspace or & file

Import from: « Base workspace

File

Import to: e MNew run

Existing run

W o |

¥ ¢ simout(1)
< ¥ simout(2)

< v simout{3)

* Use the Simulation Data Inspector to examine the results.

2. Alternatively, use these MATLAB commands to plot the longitudinal velocity, lateral acceleration,
and the steering wheel angle.

for idx = l:numExperiments
% Create sdi run object
simoutRun(idx)=Simulink.sdi.Run.create;
simoutRun(idx).Name=['Velocity = ', num2str(vmax(idx))];
add(simoutRun(idx), 'vars',simout(idx));

end

sigcolor=[0 1 0;0 0 1;1 0 1];

for idx = l:numExperiments
% Extract the lateral acceleration, position, and steering
msignal(idx)=getSignalByIndex(simoutRun(idx),b257);
msignal(idx).LineColor =sigcolor((idx),:);
ssignal(idx)=getSignalByIndex(simoutRun(idx),b256);
ssignal(idx).LineColor =sigcolor((idx),:);
asignal(idx)=getSignalByIndex(simoutRun(idx),b241);
asignal(idx).LineColor =sigcolor((idx),:);

end

Simulink.sdi.view

Simulink.sdi.setSubPlotLayout(3,1);

for idx = l:numExperiments
% Plot the lateral position, steering angle, and lateral acceleration
plotOnSubPlot(msignal(idx),1,1,true);
plotOnSubPlot(ssignal(idx),2,1,true);
plotOnSubPlot(asignal(idx),3,1,true);

end

The results are similar to these plots, which indicate that the greatest lateral acceleration occurs
when the vehcile velocity is 45 mph.
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Further Analysis

To explore the results further, use these commands to extract the lateral acceleration, steering angle,
and vehicle trajectory from the simout object.

1. Extract the lateral acceleration and steering angle. Plot the data. The results are similar to this
plot.

figure

for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;
firstorderfit = polyfit(sa.Data,ay.Data,l);
gain(idx)=firstorderfit(1l);
legend labels{idx} = [num2str(vmax(idx)), ' mph: Gain = "',

num2str(gain(idx)), ' m/(deg s"2)'1];

% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
hold on

end
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% Add labels to the plots
legend(legend labels, 'Location',
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s"2]"')
grid on

'best');

Lateral Acceleration

Acceleration [mfsz]

35 mph: Gain = 0.082091 m/{deg s°)
40 mph: Gain = 0.10387 m/(deg s7) .
45 mph: Gain = 0.12705 m/(deg s°)

3 . . . . .
10 15 20 25

Steering Angle [deg]

30 35 40

2. Extract the vehicle path. Plot the data. The results are similar to this plot.

figure
for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');

x = log{1l}.Values.Body.InertFrm.Cg.Disp.X.Data;
y = log{1}.Values.Body.InertFrm.Cg.Disp.Y.Data;

legend labels{idx} = [num2str(vmax(idx)),
% Plot vehicle location
axis('equal')
plot(y,x)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location',
title('Vehicle Path'")
xlabel('Y Position [m]"')
ylabel('X Position [m]")
grid on

'best');

mph'];
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See Also
Simulink.SimulationInput | Simulink.SimulationOutput | polyfit

More About

. “Constant Radius Maneuver” on page 3-61
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. Simulation Data Inspector
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Frequency Response to Steering Angle Input

This example shows how to use the vehicle dynamics swept-sine steering reference application to
analyze the dynamic steering response to steering inputs. Specifically, you can examine the vehicle
frequency response and lateral acceleration when you run the maneuver with different sinusoidal
wave steering amplitudes.

The swept-sine steering maneuver tests the vehicle frequency response to steering inputs. In the test,
the driver:

» Accelerates until the vehicle hits a target velocity.
* Commands a sinusoidal steering wheel input.
* Linearly increase the frequency of the sinusoidal wave.

For more information about the reference application, see “Swept-Sine Steering Maneuver” on page

3-39.
helpersetupsss;
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P VishFlbk Ref W VohRed
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Copyright 2018-2021 The MathWorks, Inc.

Run a Swept-Sine Steering Maneuver

1. Open the Swept Sine Reference Generator block. By default, the maneuver is set with these
parameters:

* Longitudinal velocity setpoint — 30 mph
* Steering amplitude — 90 deg
* Final frequency — 0.7 Hz

2. In the Visualization subsystem, open the 3D Engine block. By default, the 3D Engine parameter is
set to Disabled. For the 3D visualization engine platform requirements and hardware
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recommendations, see the “Unreal Engine Simulation Environment Requirements and Limitations” on
page 8-6.

3. Run the maneuver with the default settings. As the simulation runs, view the vehicle information.

mdl = 'SSSReferenceApplication';
sim(mdl);

### Starting serial model reference simulation build

### Successfully updated the model reference simulation target for: Driveline

### Successfully updated the model reference simulation target for: PassVehl14DOF
### Successfully updated the model reference simulation target for: SiMappedEngineV

Build Summary

Simulation targets built:

Model Action Rebuild Reason
Driveline Code generated and compiled Driveline msf.mexw64 does not exist.
PassVeh14DOF Code generated and compiled PassVehl4DOF msf.mexw64 does not exist.

SiMappedEngineV Code generated and compiled SiMappedEngineV msf.mexw64 does not exist.

3 of 3 models built (0 models already up to date)
Build duration: 0h 5m 31.546s
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In the Vehicle Position window, view the vehicle longitudinal distance as a function or the lateral
distance. The yellow line is the yaw rate. The blue line is the steering angle.

In the Visualization subsystem, open the Yaw Rate and Steer Scope block to display the yaw rate
and steering angle versus time.
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Sweep Steering
Run the reference application with three different sinusoidal wave steering amplitudes.

1. In the swept-sine steering reference application model SSSReferenceApplication, open the Swept
Sine Reference Generator block. The Steering amplitude, theta_hw block parameter sets the
amplitude. By default, the amplitude is 90 deg.

2. Enable signal logging for the velocity, lane, and ISO signals. You can use the Simulink® editor or,
alternatively, these MATLAB® commands. Save the model.

* Enable signal logging for the Lane Change Reference Generator outport Lane signal.
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mdl = 'SSSReferenceApplication';

open_system(mdl);

ph=get param('SSSReferenceApplication/Swept Sine Reference Generator', 'PortHandles');
set param(ph.Outport(1), 'DataLogging', 'on');

* Enable signal logging for the Passenger Vehicle block outport signal.

Passenger Vighicle

ph=get param('SSSReferenceApplication/Passenger Vehicle', 'PortHandles');
set param(ph.OQutport(1), 'DatalLogging','on');

* In the Visualization subsystem, enable signal logging for the ISO block.

[l Block Parameters: 150 15037-1:2006
1SO 15037-1:2006 (mask)

Enables display of 1SO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements
®) Enabled
() Disabled

set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');

3. Set up a steering amplitude vector, amp, that you want to investigate. For example, at the
command line, type:

amp = [60, 90, 120];
numExperiments = length(amp);

4. Create an array of simulation inputs that set the Swept Sine Reference Generator block parameter
Steering amplitude, theta_hw equal to amp.

for idx = numExperiments:-1:1
in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Swept Sine Reference Generator'l], ...
"theta _hw',num2str(amp(idx)));
end

5. Save the model and run the simulations. If available, use parallel computing.
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save_system(mdl)

tic;

simout = parsim(in, 'ShowSimulationManager', 'on');
toc;

[23-Jun-2021 15:10:32] Checking for availability of parallel pool...
[23-Jun-2021 15:10:32] Starting Simulink on parallel workers...
[23-Jun-2021 15:10:34] Loading project on parallel workers...
[23-Jun-2021 15:10:34] Configuring simulation cache folder on parallel workers...
[23-Jun-2021 15:10:34] Loading model on parallel workers...
[23-Jun-2021 15:10:49] Running simulations...

[23-Jun-2021 15:12:32] Completed 1 of 3 simulation runs

[23-Jun-2021 15:12:33] Completed 2 of 3 simulation runs

[23-Jun-2021 15:12:33] Completed 3 of 3 simulation runs

[23-Jun-2021 15:12:33] Cleaning up parallel workers...

Elapsed time is 132.726107 seconds.

6. After the simulations complete, close the Simulation Data Inspector windows.
Use Simulation Data Inspector to Analyze Results

Use the Simulation Data Inspector to examine the results. You can use the Ul or, alternatively,
command-line functions.

1. Open the Simulation Data Inspector. On the Simulink Toolstrip, on the Simulation tab, under
Review Results, click Data Inspector.

* In the Simulation Data Inspector, select Import.

‘ Import

- IMport irom workspace of file

* In the Import dialog box, clear logsout. Select simout (1), simout(2), and simout(3).
Select Import.

Import
Impart tirme sanes data from the base warkspace oF & file

Import from: » Base workspacs

File

Impirt to: & New run

Existing run

W g
¥| ¥ simoutl)

< ¢ simout(2)

#| v simout(3)
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* Use the Simulation Data Inspector to examine the results.

2. Alternatively, use these MATLAB commands to plot data for each run. For example, use these
commands to plot the lateral position, steering wheel angle, and lateral acceleration. The results are
similar to these plots, which show the results for each run.

for idx = l:numExperiments
% Create sdi run object
simoutRun(idx)=Simulink.sdi.Run.create;
simoutRun(idx).Name=['Amplitude = ', num2str(amp(idx))];
add (simoutRun(idx), 'vars',simout (idx));

end

sigcolor=[0 1 0;0 0 1;1 0 11;

for idx = l:numExperiments
% Extract the lateral acceleration, position, and steering
ysignal(idx)=getSignalByIndex(simoutRun(idx),7);
ysignal(idx).LineColor =sigcolor((idx),:);
ssignal(idx)=getSignalByIndex(simoutRun(idx),b247);
ssignal(idx).LineColor =sigcolor((idx),:);
asignal(idx)=getSignalByIndex(simoutRun(idx),255);
asignal(idx).LineColor =sigcolor((idx),:);

end

Simulink.sdi.view

Simulink.sdi.setSubPlotLayout(3,1);

for idx = l:numExperiments
% Plot the lateral position, steering angle, and lateral acceleration
plotOnSubPlot(ysignal(idx),1,1,true);
plotOnSubPlot(ssignal(idx),2,1,true);
plotOnSubPlot(asignal(idx),3,1,true);

end

The results are similar to these plots, which indicate that the greatest lateral acceleration occurs
when the steering amplitude is 120 deg.
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Further Analysis

To explore the results further, use these commands to extract the lateral acceleration, steering angle,

and vehicle trajectory from the simout object.

1. Extract the lateral acceleration and steering angle. Plot the data. The results are similar to this
plot.

figure
for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;
legend labels{idx} = ['amplitude = ', num2str(amp(idx)), '"~{\circ}'];
% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
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hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s"2]"')
grid on

Lateral Acceleration

ra

Acceleration [mfsz]
=

2 F -
_4 - -
— amplitude = 60
6 r — amplitude = 90 .
amplitude = 120
" | | | . .
-150 -100 -50 0 50 100 150

Steering Angle [deg]

2. Extract the vehicle path. Plot the data. The results are similar to this plot.

figure
for idx = l:numExperiments
% Extract Data
log = get(simout(idx), 'logsout');
x = log{1l}.Values.Body.InertFrm.Cg.Disp.X.Data;
y = log{1}.Values.Body.InertFrm.Cg.Disp.Y.Data;
legend labels{idx} = ['amplitude = ', num2str(amp(idx)), '~{\circ}'l];
% Plot vehicle location
axis('equal')
plot(y,x)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Vehicle Path')
xlabel('Y Position [m]"')
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Simulink.SimulationInput | Simulink.SimulationOutput | fft
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2 Coordinate Systems

Coordinate Systems in Vehicle Dynamics Blockset

Vehicle Dynamics Blockset uses these coordinate systems to calculate the vehicle dynamics and
position objects in the 3D visualization environment.

Environment

Description

Coordinate Systems

Vehicle dynamics
in Simulink

The right-hand rule establishes the X-Y-Z
sequence and rotation of the coordinate axes
used to calculate the vehicle dynamics. The
Vehicle Dynamics Blockset 3D simulation
environment uses these right-handed (RH)
Cartesian coordinate systems defined in the SAE
J670%1 and ISO 88558! standards:

e Earth-fixed (inertial)

* Vehicle

* Tire

*  Wheel

The coordinate systems can have either
orientation:

* Z-down — Defined in SAE J670[!
¢ Z-up — Defined in SAE J670(2 and ISO 8855!3!

“Earth-Fixed (Inertial)
Coordinate System” on page 2-
2

“Vehicle Coordinate System” on
page 2-3

“Tire and Wheel Coordinate
Systems” on page 2-3

3D visualization
engine

To position objects and query the 3D visualization
environment, the Vehicle Dynamics Blockset uses
a world coordinate system.

“World Coordinate System” on
page 2-5

Earth-Fixed (Inertial) Coordinate System

The earth-fixed coordinate system (Xg, Yz, Zr) axes are fixed in an inertial reference frame. The
inertial reference frame has zero linear and angular acceleration and zero angular velocity. In
Newtonian physics, the earth is an inertial reference.

2-2
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Coordinate Systems in Vehicle Dynamics Blockset

Axis Description

Xz The X axis is in the forward direction of the vehicle.

Yz The X and Yy axes are parallel to the ground plane. The ground plane is a
horizontal plane normal to the gravitational vector.

Zy In the Z-up orientation, the positive Z; axis points upward.

In the Z-down orientation, the positive Z; axis points downward.

Vehicle Coordinate System

The vehicle coordinate system axes (Xy, Yy, Zy) are fixed in a reference frame attached to the vehicle.
The origin is at the vehicle sprung mass.

Z-Down Orientation

1l Yaw
b
zZ,
Axis Description
Xy The Xy, axis points forward and is parallel to the vehicle plane of symmetry.
Yy The Yy, axis is perpendicular to the vehicle plane of symmetry.
Zy In the Z-down orientation:

* Yy axis points to the right

* Zyaxis points downward

Tire and Wheel Coordinate Systems

The tire coordinate system axes (X1, Yy, Z7) are fixed in a reference frame attached to the tire. The
origin is at the tire contact with the ground.

The wheel coordinate system axes (X, Yy, Zy) are fixed in a reference frame attached to the wheel.
The origin is at the wheel center.

Z-Up Orientation’
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Positive "-_‘._!'_“ Tire
Inclination| . Trajectory
Angle Velocity Xy

~
Wheel Plane . Direction of
Y Positive Wheel Heading
T Slip Angle
Wheel
Road Flane Spin Axis
/1
Z-Down Orientation
Direction of
"™~ Positive Wheel Heading
© | Inclination Angle X
Wheel ! x
. SpinAxis | Wneel Fiane
N Tire
Trajectory
™ - f\- -¥ Welocity
= Paositive
Slip Angle
Foad Flane
Yl\'
YT
Z
Xr Xr and Y are parallel to the road plane. The intersection of the wheel plane and
Yy the road plane define the orientation of the X axis.
Zr Z7 points:
¢ Upward in the Z-up orientation
¢ Downward in the Z-down orientation
Xw Xy and Yy, are parallel to the wheel plane:

Reprinted with permission Copyright © 2008 SAE International. Further distribution of this material is not permitted
without prior permission from SAE.

2-4




Coordinate Systems in Vehicle Dynamics Blockset

Axis Description
Yo * Xy is parallel to the local road plane.
* Yy is parallel to the wheel-spin axis.

Zw Zy points:

* Upward in the Z-up orientation
* Downward in the Z-down orientation

World Coordinate System

The 3D visualization environment uses a world coordinate system with axes that are fixed in the
inertial reference frame.

Z

Yaw

<O Rl oy

R

Axis Description
X Forward direction of the vehicle

Roll — Right-handed rotation about X-axis
Y Extends to the right of the vehicle, parallel to the ground plane

Pitch — Right-handed rotation about Y-axis
Z Extends upwards

Yaw — Left-handed rotation about Z-axis
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See Also

More About

. “Coordinate Systems in Automated Driving Toolbox” (Automated Driving Toolbox)

External Websites

. SAE International Standards
. ISO Standards
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3 Reference Applications

Passenger Vehicle Dynamics Models

3-2

To analyze the dynamic system response in common ride and handling maneuvers, Vehicle Dynamics

Blockset provides these pre-assembled vehicle dynamics models.

Vehicle |Description |Vehicle Body Degrees-of-Freedom Wheel DOFs
Model (DOFs)
Passenger|e Vehicle Six Two per wheel - eight total
14DOF with four
Vehicle wheels Translational Rotational Translational |Rotational
¢ Available as || Longitudinal v |Pitch v Vertical v |Rolling | v
mo‘,iel ) Lateral v  |Yaw v
variant in
the Vertical v [Roll 4
maneuver
reference
applications
Passenger|* Vehicle Three One per wheel - four total
7DOF with four
Vehicle wheels Translational Rotational Rotational
* Available as || Longitudinal v |Pitch Rolling v
model Lateral v |Yaw
variant in -
the Vertical Roll
maneuver
reference
applications
Passenger|e Vehicle Three None
3DOF with ideal
Vehicle tire Translational Rotational
Longitudinal v |Pitch
Lateral v |Yaw
Vertical Roll

From the Simulink start page, you can open project files that contain the vehicle models.




Passenger Vehicle Dynamics Models

4 Simulink Start Page — ]
New Examples
3 Open.. All Templates  w
Recent
P2 mymodel six > System Composer

i v \ehicle Dynamics Blockset
Projects

i@ From Source Control «

Passenger 3DOF Vehicle Passenger TDOF Vehicle

See Also
Vehicle Body 6DOF | Vehicle Body 3DOF

More About
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. “Vehicle Reference Applications”
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This reference application represents an in-plane longitudinal motorcycle undergoing a braking test.
You can create your own versions, establishing a framework to test that your motorcycle meets the
design requirements under normal and extreme driving conditions. Use this reference application in
ride and handling studies and chassis controls development to characterize the vehicle dynamics of a
motorcycle during a braking test.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine
platform requirements and hardware recommendations, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To create and open a working copy of the longitudinal motorcycle braking test reference application,

enter

vdynblksMotoLongBrakingStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems

contain variants.

Reference Application
Element

Description

Variants

Straight Maneuver
Reference Generator

Generates accelerator and brake commands to conduct a
straight line maneuver. The acceleration begins at the specified
rate until the motorcycle achieves the longitudinal velocity
setpoint. The motorcycle controller maintains the longitudinal
velocity setpoint for the specified time or distance. The
controller then decelerates the motorcycle.

Optionally, specify fault conditions before braking during a test.
If the motorcycle speed, steering angle, or yaw rate is not
within the allowable range before braking, the block sets a fault
condition.

NA

Longitudinal Rider

Implements the rider model that the reference application uses
to generate acceleration, braking, gear, and steering
commands.

By default, Longitudinal Rider subsystem use is the
Longitudinal Driver block with Control type, cntrlType set to
Predictive.

NA

Environment

Implements wind and road forces, including a constant or split
friction coefficient scaling factor.

Controllers

Implements controllers for engine control units (ECUs),
transmissions, anti-lock braking systems (ABS), and active
differentials.
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Longitudinal Motorcycle Braking Test

Reference Application [Description Variants
Element
Motorcycle Vehicle Implements the: v
* Body, suspension, and wheels
* Engine
» Steering, transmission, driveline, and brakes
Visualization Provides the motorcycle trajectory, rider response, and 3D v
visualization.

To enable 3D visualization, set the 3D Engine block parameter
3D Engine parameter to Enabled.

For the minimum 3D visualization environment hardware
requirements, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Set as Label Model Active Choice.

Straight Maneuver Reference Generator

The Straight Maneuver Reference Generator block generates accelerator and brake commands to
conduct a straight line maneuver. The acceleration begins at the specified rate until the motorcycle
achieves the longitudinal velocity setpoint. The motorcycle controller maintains the longitudinal
velocity setpoint for the specified time or distance. The controller then decelerates the motorcycle.

Use the Maneuver Parameters to specify the maneuver start time, velocity setpoint, acceleration,
and deceleration.

Optionally, on the Tracking Parameters tab, select Enable fault tracking before braking. Use the
parameters to specify fault conditions before braking. If the motorcycle speed, steering angle, or yaw
rate is not within the allowable range before braking, the block sets a fault condition.

For more information, see Straight Maneuver Reference Generator.

Longitudinal Rider
The Longitudinal Rider subsystem implements the rider model that the reference application uses to

generate acceleration, braking, gear, and steering commands. By default, Longitudinal Rider
subsystem use is the Longitudinal Driver block with Control type, cntrlType set to Predictive.

Environment

The Environment subsystem implements wind and road forces. The reference application has these
ground feedback variants.
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Environment Variant Description
Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment.
Constant (default) [Implements a constant friction coefficient scaling
factor.
Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.

ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable

EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited
engine torque command, the ECU sets the engine torque command to the commanded differential

torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller

includes these variants.

Variant Description
Transmission Implements a transmission control module (TCM) that uses Stateflow
Controller logic to generate the gear command based on the motorcycle

acceleration, wheel speed, and engine speed.

Driver - No Clutch
(default)

Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller

Implements a transmission control module (TCM) that uses Stateflow
logic to generate the gear command based on the motorcycle
acceleration, brake command, wheel speed, engine speed, and gear
request.

Paddles

Implements a paddle controller that uses the motorcycle acceleration
and engine speed to generate the gear command.

Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.

Variant

Description

Bang Bang ABS

Implements an ABS feedback controller that switches between two
states to regulate wheel slip. The bang-bang control minimizes the
error between the actual slip and desired slip. For the desired slip,
the controller uses the slip value at which the mu-slip curve reaches a
peak value. This desired slip value is optimal for minimum braking
distance.
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Variant

Description

Open Loop

Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.

Five-State ABS for
Motorcycle (default)

Five-state ABS control when you simulate the brake test. The five-
state ABS controller uses logic-switching based on wheel deceleration
and motorcycle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver.

The default ABS parameters are set to work on roads that have a
constant friction coefficient scaling factor of 1.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch

* Brake command

*  Wheel speed

* Gear

» Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Motorcycle Vehicle

The Motorcycle Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the motorcycle contains these subsystems.

Subsystem Variant Description
Body, Suspension, Wheels [Longitudinal Motorcycle with two wheels:
(default)

* Motorcycle — Implemented with Motorcycle
Body Longitudinal In-Plane block

¢ Wheels — Implemented with Combined Slip
Wheel CPI blocks
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Subsystem Variant Description
Simscape Multibody Simscape Motorcycle with two wheels implemented with
Multibody Simscape Multibody.

Engine Subsystem Variant Description

Engine Mapped (default) Implemented with Simple Engine block.

Steering, Transmission, Description

Driveline, and Brakes

Subsystem

Two Wheels Transmission Implements an ideal fixed gear transmission.

Chain Driven Motorcycle Chain |Implements the dynamic effects of a motorcycle chain on the
Motorcycle Body Longitudinal In-Plane block, including dynamic
tension and moment drive coupling.

Visualization

When you run the simulation, the Visualization subsystem provides rider and motorcycle response
information. The reference application logs motorcycle signals during the maneuver, including
steering, motorcycle and engine speed, and lateral acceleration. By default, the Yaw Rate, Brake
Pressure, Velocity, Accel Scope block shows the signals as the simulation runs. You can use the
Simulation Data Inspector to import the logged signals and examine the data.

Element Description

Driver Commands Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response Motorcycle response:

* Engine speed

* Motorcycle speed

* Longitudinal acceleration
* ABS indicator
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Element Description

Yaw Rate, Brake Pressure,
Velocity, Accel Scope .
block

<g> — Yaw rate versus time
BrkPrs — Brake pressure versus time

e BrkPrs:1 — Front wheel
e BrkPrs:2 — Rear wheel
* Signals

* <xdot> — Longitudinal vehicle velocity versus time
* VehWh1Spd:1 — Front wheel velocity versus time

* VehWh1Spd:2 — Rear wheel velocity versus time

* LngRef — Longitudinal reference velocity

* <ax> — Longitudinal acceleration versus time

If you enable 3D visualization on the Reference Generator block 3D Engine tab by selecting
Enabled, you can view the vehicle response in the AutoVrt1lEnv window.

To smoothly change the camera views, use these key commands.

Camera View
Back left
Back

Back right
Left

Internal

Right

Front left
Front

>
<

Front right
Overhead

S|l O|| IO U Bl WIN| -~

For additional camera controls, use these key commands.

Key Camera Control
Tab Cycle the view between all vehicles in the scene.
Mouse scroll wheel Control the camera distance from the vehicle.
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Key

Camera Control

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

See Also

3D Engine | Straight Maneuver Reference Generator | Motorcycle Body Longitudinal In-Plane |

Motorcycle Chain

More About

“Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
“Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

Simulation Data Inspector
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Braking Test

This reference application represents a full vehicle dynamics model undergoing a braking test,
including a split-mu test. You can create your own versions, establishing a framework to test that
your vehicle meets the design requirements under normal and extreme driving conditions. Use this
reference application in ride and handling studies and chassis controls development to characterize
the vehicle dynamics during a braking test. For information about this and similar maneuvers, see
standards SAE J299 200901* and ISO 21994:20075.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine
platform requirements and hardware recommendations, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To create and open a working copy of the braking test reference application, enter
vdynblksBrakingStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element
Straight Maneuver Generates accelerator and brake commands to conduct a v

Reference Generator straight line maneuver. The acceleration begins at the specified
rate until the vehicle achieves the longitudinal velocity setpoint.
The vehicle controller maintains the longitudinal velocity
setpoint for the specified time or distance. The controller then
decelerates the vehicle.

Optionally, specify fault conditions before braking during a split-
mu test. If the vehicle speed, steering angle, or yaw rate is not
within the allowable range before braking, the block sets a fault
condition. The default values represent compliance with ISO
145126,

Driver Commands Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands subsystem variant is the
Predictive Driver block.

Environment Implements wind and road forces, including a constant or split v
friction coefficient scaling factor.

Controllers Implements controllers for engine control units (ECUs), v
transmissions, anti-lock braking systems (ABS), and active
differentials.
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Reference Application [Description Variants
Element
Passenger Vehicle Implements the: v

* Body, suspension, and wheels
* Engine
» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization.

To enable 3D visualization, set the 3D Engine block parameter
3D Engine parameter to Enabled.

For the minimum 3D visualization environment hardware
requirements, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Straight Maneuver Reference Generator

The Straight Maneuver Reference Generator block generates accelerator and brake commands to
conduct a straight line maneuver. The acceleration begins at the specified rate until the vehicle
achieves the longitudinal velocity setpoint. The vehicle controller maintains the longitudinal velocity
setpoint for the specified time or distance. The controller then decelerates the vehicle.

Use the Maneuver Parameters to specify the maneuver start time, velocity setpoint, acceleration,
and deceleration.

Optionally, on the Tracking Parameters tab, select Enable fault tracking before braking. Use the
parameters to specify fault conditions before braking during a split-mu test. If the vehicle speed,
steering angle, or yaw rate is not within the allowable range before braking, the block sets a fault
condition. The default values represent compliance with ISO 145125,

For more information, see Straight Maneuver Reference Generator.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.
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Vehicle Command
Mode Setting

Implementation

Longitudinal Driver

Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver
(default)

Predictive Driver block — Controller that generates normalized steering,
acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for
optimal single-point preview control.

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,
and gear command input.

Environment

The Environment subsystem implements wind and road forces, including a constant or split friction

coefficient scaling factor.

Use the Road Track Friction block Type of surface parameter to specify the friction coefficient

scaling factor:

* Constant friction coefficient scaling factor — Constant surface friction during the

maneuver

* Split friction coefficient scaling factor — Two friction coefficients

Select this option to specify the friction scaling coefficients for a split-mu braking test. Use the
enabled parameters to set the ground friction and rectangular surface friction coefficient scaling

factors.

For more information, see Road Track Friction.

The reference application has these ground feedback variants.

Environment Variant Description
Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment.

Constant (default) {Implements a constant or split friction coefficient
scaling factor based on the Road Track Friction
block output.

Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.
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ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable
EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited

engine torque command, the ECU sets the engine torque command to the commanded differential
torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller
includes these variants.

Variant Description

Transmission Implements a transmission control module (TCM) that uses Stateflow

Controller logic to generate the gear command based on the vehicle
acceleration, wheel speed, and engine speed.

Driver - No Clutch Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller Implements a transmission control module (TCM) that uses Stateflow

(default) logic to generate the gear command based on the vehicle
acceleration, brake command, wheel speed, engine speed, and gear
request.

Paddles Implements a paddle controller that uses the vehicle acceleration and

engine speed to generate the gear command.

Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.

Variant Description

Bang Bang ABS Implements an ABS feedback controller that switches between two
states to regulate wheel slip. The bang-bang control minimizes the
error between the actual slip and desired slip. For the desired slip,
the controller uses the slip value at which the mu-slip curve reaches a
peak value. This desired slip value is optimal for minimum braking
distance.

Open Loop (default) Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.
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Variant

Description

Five-State ABS

Five-state ABS control when you simulate the maneuver.'>3 The five-
state ABS controller uses logic-switching based on wheel deceleration
and vehicle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver.

The default ABS parameters are set to work on roads that have either:

* Constant friction coefficient scaling factor of 0.6.
» Split friction coefficient scaling factors of 0.6 and 0.8.

To specify the road surface, see “Environment” on page 3-13.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch, yaw, and roll

* Brake command

*  Wheel speed

* Gear

* Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.

Wheels Subsystem

Body, Suspension, Variant Description

PassVeh7DOF PassVeh7DOF Vehicle with four wheels:

* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw

* Each wheel has one DOF — Rolling
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Body, Suspension, Variant Description
Wheels Subsystem
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
(default)
* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll
* Each wheel has two DOFs — Vertical and
rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline Al1l Wheel Drive |[Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model rear-wheel, or rear-wheel active differential drive
Front Wheel ) )
Gear Bl and specify the type of torque coupling.
Rear Wheel Drive
Rear Wheel Drive
Active
Differential
(default)
Transmission |Ideal (default) Implements an ideal fixed gear transmission.
Brake NA Implements the heuristic response of a hydraulic
Hydraulics system when the controller applies a brake
command to a cylinder. Includes front and rear
wheel bias coefficients. The subsystem converts
the applied pressure to a cylinder spool position.
To generate the brake pressure, the spool applies
a flow downstream to the cylinders.
Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.

Element Description

Driver Commands Driver commands:

* Handwheel angle
e Acceleration command

¢ Brake command
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Element Description

Vehicle Response Vehicle response:

* Engine speed
* Vehicle speed
* Lateral acceleration
* ABS indicator

* FElectronic stability program (ESP) indicator - Indicates when traction
control system (TCS) is active

Steer, Velocity, Lat Accel |¢ SteerAngle — Steering angle versus time
Scope block + <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block |Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

If you enable 3D visualization on the Reference Generator block 3D Engine tab by selecting
Enabled, you can view the vehicle response in the AutoVrt1lEnv window.

To smoothly change the camera views, use these key commands.

Key Camera View
Back left
Back

Back right
Left

Internal

Right

Front left
Front

OO J|O| 0| B WN| e~

Front right
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Key

Camera View

Overhead

View Animated GIF

For additional camera controls, use these key commands.

Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF
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Key

Camera Control

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF
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Key Camera Control

F Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF
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See Also
3D Engine | Road Track Friction | Straight Maneuver Reference Generator

More About
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
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Double-Lane Change Maneuver

Double-Lane Change Maneuver

This reference application represents a full vehicle dynamics model undergoing a double-lane change
maneuver according to standard ISO 3888-2[4l. You can create your own versions, establishing a
framework to test that your vehicle meets the design requirements under normal and extreme driving
conditions. Use the reference application to analyze vehicle ride and handling and develop chassis
controls. To perform vehicle studies, including yaw stability and lateral acceleration limits, use this
reference application.

ISO 3888-2 defines the double-lane change maneuver to test the obstacle avoidance performance of a
vehicle. In the test, the driver:

* Accelerates until vehicle hits a target velocity

* Releases the accelerator pedal

* Turns steering wheel to follow path into the left lane

» Turns steering wheel to follow path back into the right lane

Typically, cones mark the lane boundaries. If the vehicle and driver can negotiate the maneuver
without hitting a cone, the vehicle passes the test.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine
platform requirements and hardware recommendations, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To create and open a working copy of the double-lane change reference application project, enter

vdynblksDblLaneChangeStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element
Lane Change Reference |Generates lane signals for the visualization subsystem and
Generator trajectory signals
Driver Commands Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands subsystem variant is the
Predictive Driver block.

Environment Implements wind and ground forces v

Controllers Implements controllers for engine control units (ECUs), v
transmissions, anti-lock braking systems (ABS), and active
differentials.
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Reference Application [Description Variants
Element
Passenger Vehicle Implements the: v

* Body, suspension, and wheels
* Engine
» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Lane Change Reference Generator

Use the Lane Change Reference Generator block to generate:

* Lane signals for the Visualization subsystem — The left and right lane boundaries are a function of
the Vehicle width parameter.

* Velocity and lateral reference signals for the Predictive Driver block — Use the Lateral reference
position breakpoints and Lateral reference data parameters to specify the lateral reference
trajectory as a function of the longitudinal distance.

To start simulations from a non-zero steady-state velocities, use the Steady-state initial conditions
and Steady-State Solver tab parameters. For an example, see “Start Double-Lane Change Maneuver
at Target Velocity” on page 3-98.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.

Vehicle Command Implementation
Mode Setting

Longitudinal Driver |Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver |Predictive Driver block — Controller that generates normalized steering,
(default) acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for

optimal single-point preview control.
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Vehicle Command Implementation

Mode Setting

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,
and gear command input.

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description
Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment
Constant (default) [Implements a constant friction value
Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.

ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable
EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited
engine torque command, the ECU sets the engine torque command to the commanded differential

torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller

includes these variants.

Variant

Description

Driver - No Clutch

Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller
(default)

Implements a transmission control module (TCM) that uses Stateflow
logic to generate the gear command based on the vehicle
acceleration, brake command, wheel speed, engine speed, and gear

request.
Paddles Implements a paddle controller that uses the vehicle acceleration and
engine speed to generate the gear command.
Transmission Implements a transmission control module (TCM) that uses Stateflow
Controller logic to generate the gear command based on the vehicle

acceleration, wheel speed, and engine speed.
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Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.

Variant

Description

Bang Bang ABS

Implements an anti-lock braking system (ABS) feedback controller
that switches between two states to regulate wheel slip. The bang-
bang control minimizes the error between the actual slip and desired
slip. For the desired slip, the controller uses the slip value at which
the mu-slip curve reaches a peak value. This desired slip value is
optimal for minimum braking distance.

Open Loop (default)

Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.

Five-State ABS

Five-state ABS control when you simulate the maneuver.23 The five-
state ABS controller uses logic-switching based on wheel deceleration
and vehicle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver. The default ABS parameters are set to work on roads that
have a constant friction coefficient scaling factor of 0.6.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch, yaw, and roll

* Brake command

*  Wheel speed

* Gear

* Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.
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Body, Suspension, Variant Description
Wheels Subsystem
PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw
* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
(default)
* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll
e Each wheel has two DOFs — Vertical and
rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model rear-wheel, or rear-wheel active differential drive
Front Wheel ) )
Gear Drive and specify the type of torque coupling.
Rear Wheel Drive
Rear Wheel Drive
Active
Differential
(default)
Transmission |Ideal (default) Implements an ideal fixed gear transmission.
Brake NA Implements the heuristic response of a hydraulic
Hydraulics system when the controller applies a brake
command to a cylinder. Includes front and rear
wheel bias coefficients. The subsystem converts
the applied pressure to a cylinder spool position.
To generate the brake pressure, the spool applies
a flow downstream to the cylinders.
Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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Element Description

Driver Commands Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response Vehicle response:

* Engine speed
* Vehicle speed
e Acceleration command

Lane Change Scope block |Lateral vehicle displacement versus time:

* Red line — Cones marking right lane boundary
* QOrange line — Cones marking left lane boundary
* Blue line — Reference trajectory

* Green line — Actual trajectory
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Element

Description

Steer, Velocity, Lat Accel
Scope block

* SteerAngle — Steering angle versus time
* <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter

Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block

Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “Unreal Engine Simulation
Environment Requirements and Limitations” on page 8-6. After you open the reference application,
in the Visualization subsystem, open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.

* Scene to one of the scenes, for example Straight road.

3D Engine
(O Enabled
(® Disabled

Scene: |Double lane change

Parking lot

o

Double lane change
Open surface

» To position the vehicle in the scene:

1 Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for

the scene

* User-specified — Set your own initial vehicle position

2 (Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.

Note

* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrtlEnv window, Simulink stops the simulation with an error.

*  When you enable the 3D visualization environment, you cannot step the simulation back.
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To smoothly change the camera views, use these key commands.

Key Camera View

Back left
Back

Back right
Left
Internal
Right
Front left
Front

Front right
Overhead

S|l Ol IOl W| N -

For additional camera controls, use these key commands.
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Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

T em—— I

o
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Key

Camera Control

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF

Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF
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See Also

Predictive Driver | Mapped SI Engine | Vehicle Terrain Sensor | 3D Engine | Lane Change Reference
Generator

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-88

. “Start Double-Lane Change Maneuver at Target Velocity” on page 3-98
. “Yaw Stability on Varying Road Surfaces” on page 1-16

More About

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “ISO 15037-1:2006 Standard Measurement Signals” on page 5-2

. “Passenger Vehicle Dynamics Models” on page 3-2

. “Send and Receive Double-Lane Change Scene Data” on page 3-88

. Simulation Data Inspector
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Scene Interrogation in 3D Environment

The scene interrogation with camera and ray tracing reference application provides the Simulink
interface with the 3D visualization environment. For the minimum hardware required to run the
reference application, see “Unreal Engine Simulation Environment Requirements and Limitations” on
page 8-6.

The scene interrogation with camera and ray tracing reference application contains:

* One passenger vehicle with a simple driveline, combined slip wheel, and 3DOF vehicle dynamics
model.

* One camera mounted on the passenger vehicle rear-view mirror.

» Steering, acceleration, gear, and braking controls.

* Vehicle light controls.

* 3D visualization environment configured for the Virtual Mcity scene.

Create and open a working copy of the camera and ray tracing reference application project.

vdynblksSceneCameraRayStart

Controls o M Dynamics and Controls Displays
.
-30 30
1 |
R —sD
. . = B X )
|:'—> HidWhi Frofih . .
¥ Gear:Value Info ek = =y
60 60 — »{WhiAngF = S T
wdot [-w-— -
§ Steering = | faw
-80 a0 P yelot [-—] | =3
SteerVelua [ Fronk F > FaF psi [+
BT S 1 P2
|IIIIIIHI|IIIIIIIII|IIIHIIII|IIIIIIIH|IIIIIIHI| - [ ]
0 o0z 04 08 08 Brak FzF [+
Acceleratar-Value VehFdbk . P PR
Acceleral value FzR _.5
I T A AT Powertrain & Driveline Vehicle Body 3DOF Dual Track Help
i} 02 04 08 LIE:
Brake:\alue
Simulation 3D Scene Configuration
Sensors
Translation ) Translation
Rotation # Rotation
Scale ) Scale
Simulation 3D Actor Transform Get TranaformDisplay
Simulation 30 Camera Get ImageDisplay

When you run the simulation, the reference application provides this vehicle and scene information.
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Scene Interrogation in 3D Environment

Window Description

AutoVrtlEnv |Video output of the Unreal Engine® 3D visualization environment image feedback. By
default, the display shows the view from the Simulation 3D Scene Configuration block
Scene view parameter SimulinkVehiclel.

To smoothly change the camera views, use these key commands.

Key Camera View
Back left
Back

Back right
Left
Internal
Right
Front left
Front

Front right
Overhead

S|l Ol || Ul kx|l w| N -

View Animated GIF

B o R T

For additional camera controls, use these key commands.

Key Camera Control

Tab Cycle the view between all vehicles in the scene.
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Window Description

Key Camera Control
View Animated GIF

Mouse scroll wheel |[Control the camera distance from the vehicle.

View Animated GIF

L Toggle a camera lag effect on or off. When you enable the lag
effect, the camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle
acceleration and rotation.
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Window Description
Key Camera Control
View Animated GIF
- T =
F Toggle the free camera mode on or off. When you enable the
free camera mode, you can use the mouse to change the pitch
and yaw of the camera. This mode enables you to orbit the
camera around the vehicle.
View Animated GIF
SDL Video |Video image output of Simulation 3D Camera Get block. By default, the display shows
Display the view specified by these parameter settings:

* Vehicle name — SimulinkVehiclel
* Vehicle mounting location — Rearview mirror

This table summarizes the parts of the reference application.
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Name Description

Controls Dials and gauges that control the vehicle steering, gear, acceleration, and braking.
The braking control turns on the vehicle brake lights. Setting the gear control to R
turns on the vehicle reverse lights.

Sensors The Simulation 3D Actor Transform Get block returns the translation, rotation, and
scale for the vehicle passenger vehicle and four wheels from the 3D visualization
environment.

The Simulation 3D Camera Get block returns the camera image from the 3D
visualization environment. By default, the block returns image data for a camera
location specified by these parameter settings:

* Vehicle name — SimulinkVehiclel

* Vehicle mounting location — Rearview mirror

Dynamics Interfaces with Simulink to calculate the dynamic response of the vehicle plant and
and Controls |controller. By default, the subsystem contains a simple driveline and the Vehicle 3DOF
Dual Track block vehicle dynamics model.

Implements a Light Controls subsystem that you can use to control the headlights and
signal lights.

of @ @ tHich Left @ @ Fioht

Headlights:Value Signal Lights:viz

Displays The Simulation 3D Vehicle with Ground Following block implements a passenger
vehicle in the 3D visualization environment. The block uses the vehicle position to
adjust the vehicle elevation, roll, and pitch so that the vehicle follows the ground
terrain. By default, the block has these parameter settings:

* Type — Muscle car

* Color — Red

* Name — SimulinkVehiclel

* Enable light controls — On

The Simulation 3D Scene Configuration block configures the Unreal Engine 3D
visualization environment. By default, the block has these parameter settings:

* Scene name — Virtual Mcity
* Scene view — SimulinkVehiclel

The TransformDisplay subsystem displays the translation, rotation, and scale of the
SimulinkVehiclel vehicle body and four wheels.

The ImageDisplay subsystem displays the video image output of Simulation 3D
Camera Get block in the SDL Video Display window.
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Displays Subsystems
TransformDisplay Subsystem

In the TransformDisplay subsystem, the Display block provides the translation, rotation, and scale of
the vehicle body and four wheels. Use the Constant block value to control the display.

¢ 1 — Translation
e 2 — Rotation
e 3 — Scale

For example, to display translation information, set the value to 1.

Displays
EE
\ -212.5) 65.66)| 0.0112]
) > \ ol o] g
1
53311 fisxa) 0 q q
Translate L ‘
5x3] 2 |i6x3]|| Gl 0| 0|
2D =1
Rotate (531 ‘ OH OH O|
: [5x3] *
3 g mad
[5x3]
Scale —
Multiport
Switch

The display indicates that the:

* Vehicle body is at -212.5m, 65.66 m, and 0.0112 m along the world X-, Y-, and Z- axes,
respectively.

* Wheels are at their initial positions along the world X-, Y-, and Z- axes, respectively.

The Display block provides an array of the vehicle and wheel locations.

Vehiclex Vehicley Vehicley
FrontLefty FrontLefty FrontLefty
FrontRightx FrontRighty FrontRight,
RearLefty RearLefty RearLefty
RearReary RearReary RearReary

* Vehicle translation and rotation are along the world coordinate system axes.

* Wheel translations and rotations are with respect to their initial positions, along the world
coordinate system axes.

ImageDisplay Subsystem
In the ImageDisplay subsystem, the Level-2 MATLAB S-Function block uses the

VideoDisplayMSfcnWin function to display the video image output of Simulation 3D Camera Get
block.
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See Also

Simulation 3D Actor Transform Get | Simulation 3D Camera Get | Simulation 3D Scene Configuration
| Virtual Mcity | Simulation 3D Vehicle with Ground Following

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-88
More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3

. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8

External Websites

. Unreal Engine


https://www.unrealengine.com/en-US/unreal

Swept-Sine Steering Maneuver

Swept-Sine Steering Maneuver

This reference application represents a full vehicle dynamics model undergoing a swept-sine steering
maneuver. You can create your own versions, providing a framework to test that your vehicle meets
the design requirements under normal and extreme driving conditions. Use the reference application
to analyze vehicle ride and handling and develop chassis controls. To analyze the dynamic steering
response, use this reference application.

The swept-sine steering maneuver tests the vehicle frequency response to steering inputs. In the test,
the driver:

* Accelerates until the vehicle hits a target velocity.

* Commands a sinusoidal steering wheel input.

* Linearly increase the frequency of the sinusoidal wave.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine

platform requirements and hardware recommendations, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To create and open a working copy of the swept-sine steering reference application project, enter
vdynblksSweptSineSteeringStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element
Swept Sine Reference |Generate the sinusoidal steering commands for a swept-sine
Generator block steering maneuver.
Driver Commands Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands subsystem variant is the
Predictive Driver block.

\

Environment Implements wind and road forces.

Controllers Implements controllers for engine control units (ECUs), v
transmissions, anti-lock braking systems (ABS), and active
differentials.

Passenger Vehicle Implements the: v
* Body, suspension, and wheels

* Engine

» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization.
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To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Swept Sine Reference Generator

Use the Swept Sine Reference Generator block to generate the sinusoidal steering commands for a
swept-sine steering maneuver.

* Longitudinal velocity setpoint — Target velocity

* Steering amplitude — Sinusoidal wave amplitude

* Final frequency — Cut off frequency to stop the maneuver

To start simulations from a steady-state condition, use the Steady-state initial conditions and
Steady-State Solver tab parameters.

For more information, see Swept Sine Reference Generator.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.

Vehicle Command Implementation
Mode Setting

Longitudinal Driver |Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver |Predictive Driver block — Controller that generates normalized steering,
(default) acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for
optimal single-point preview control.

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,
and gear command input.

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement

ray tracing in 3D environment
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Environment Variant Description

Constant (default) [Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.

ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable
EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited
engine torque command, the ECU sets the engine torque command to the commanded differential
torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller
includes these variants.

Variant Description

Driver - No Clutch Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller Implements a transmission control module (TCM) that uses Stateflow

(default) logic to generate the gear command based on the vehicle
acceleration, brake command, wheel speed, engine speed, and gear
request.

Paddles Implements a paddle controller that uses the vehicle acceleration and
engine speed to generate the gear command.

Transmission Implements a transmission control module (TCM) that uses Stateflow

Controller logic to generate the gear command based on the vehicle

acceleration, wheel speed, and engine speed.

Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.

Variant Description

Bang Bang ABS Implements an anti-lock braking system (ABS) feedback controller
that switches between two states to regulate wheel slip. The bang-
bang control minimizes the error between the actual slip and desired
slip. For the desired slip, the controller uses the slip value at which
the mu-slip curve reaches a peak value. This desired slip value is
optimal for minimum braking distance.

Open Loop (default) Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.
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Variant

Description

Five-State ABS

Five-state ABS control when you simulate the maneuver.'>3 The five-
state ABS controller uses logic-switching based on wheel deceleration
and vehicle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver. The default ABS parameters are set to work on roads that
have a constant friction coefficient scaling factor of 0.6.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch, yaw, and roll

* Brake command

*  Wheel speed

* Gear

* Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.

Body, Suspension, Variant Description
Wheels Subsystem
PassVeh7DOF PassVeh7DOF Vehicle with four wheels:

* Vehicle body has three degrees-of-freedom

(DOFs) — Longitudinal, lateral, and yaw

* Each wheel has one DOF — Rolling

PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
(default)

* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll

¢ Each wheel has two DOFs — Vertical and
rolling
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Engine Subsystem Variant Description

Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)

Steering, Transmission, |Variant Description

Driveline, and Brakes

Subsystem

Driveline |Driveline A1l Wheel Drive |Configure the driveline for all-wheel, front-wheel,

Ideal Fixed |[model rear-wheel, or rear-wheel active differential drive
Front Wheel ) )

Gear e and specify the type of torque coupling.

Rear Wheel Drive

Rear Wheel Drive

Active

Differential

(default)
Transmission |Ideal (default) Implements an ideal fixed gear transmission.
Brake NA Implements the heuristic response of a hydraulic
Hydraulics system when the controller applies a brake

command to a cylinder. Includes front and rear
wheel bias coefficients. The subsystem converts
the applied pressure to a cylinder spool position.
To generate the brake pressure, the spool applies
a flow downstream to the cylinders.

Visualization Subsystem

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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Element Description

Driver Commands

Driver commands:

Handwheel angle

Brake command

Acceleration command

Vehicle Response

Vehicle response:

Engine speed

Vehicle speed

Lateral acceleration
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Element Description
Yaw Rate and Steer Scope |Yaw rate and steering angle versus time:
block

* Yellow line — Yaw rate

* Blue lines — Steering angle

Steer vs Ay Scope block |Steering angle versus lateral acceleration

Steer, Velocity, Lat Accel |+ SteerAngle — Steering angle versus time

Scope block + <xdot> — Longitudinal vehicle velocity versus time

e <ay> — Lateral acceleration versus time
Vehicle XY Plotter Plot of vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block |Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “Unreal Engine Simulation
Environment Requirements and Limitations” on page 8-6. After you open the reference application,
in the Visualization subsystem, open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.
* Scene to one of the scenes, for example Straight road.

3D Engine
() Enabled
(@ Disabled

Double lane change

Scene:

Engine

Parking lot
Double lane change
Open surface

Initial

» To position the vehicle in the scene:
1 Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for
the scene
* User-specified — Set your own initial vehicle position

2 (Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.

Note
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* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrtlEnv window, Simulink stops the simulation with an error.

*  When you enable the 3D visualization environment, you cannot step the simulation back.

To smoothly change the camera views, use these key commands.

Camera View

A
<

Back left
Back

Back right
Left
Internal
Right
Front left
Front

Front right
Overhead

S| O| | J|| U B|lW|IN| e~

View Animated GIF

For additional camera controls, use these key commands.
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Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

T em—— I

o
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Key

Camera Control

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF

Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF
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See Also

Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor | 3D Engine | Swept Sine Reference
Generator

Related Examples
. “Frequency Response to Steering Angle Input” on page 1-47

More About

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
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This reference application represents a full vehicle dynamics model undergoing a slowly increasing
steering maneuver according to standard SAE J266%. You can create your own versions, establishing a
framework to test that your vehicle meets the design requirements under normal and extreme driving
conditions. Use the reference application to analyze vehicle ride and handling and develop chassis
controls. To characterize the steering and lateral vehicle dynamics, use this reference application.

Based on the constant speed, variable steer test defined in SAE J2664, the slowly increasing steering
maneuver helps characterize the lateral dynamics of the vehicle. In the test, the driver:

* Accelerates until vehicle hits a target velocity.

* Maintains a target velocity.

* Linearly increases the steering wheel angle from 0 degrees to a maximum angle.

* Maintains the steering wheel angle for a specified time.

* Linearly decreases the steering wheel angle from maximum angle to O degrees.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine
platform requirements and hardware recommendations, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To create and open a working copy of the increasing steering reference application project, enter

vdynblksIncreasingSteeringStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element

Slowly Increasing Steer |Generates steering, accelerator, and brake commands.
block

Driver Commands Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands subsystem variant is the
Predictive Driver block.

Environment Implements wind and road forces. v

Controllers Implements controllers for engine control units (ECUs), v
transmissions, anti-lock braking systems (ABS), and active
differentials.

Passenger Vehicle Implements the: v

* Body, suspension, and wheels
* Engine

» Steering, transmission, driveline, and brakes
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Slowly Increasing Steering Maneuver

Reference Application [Description Variants

Element

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Slowly Increasing Steer Block

Use the Slowly Increasing Steering block to generate steering, accelerator, and brake commands for
a slowly increasing steering maneuver.

* Longitudinal speed setpoint — Target velocity setpoint

* Handwheel rate — Linear rate to increase steering wheel angle

* Maximum handwheel angle — Maximum steering wheel angle

To start simulations from a steady-state condition, use the Steady-state initial conditions and
Steady-State Solver tab parameters.

For more information, see Slowly Increasing Steer Reference Generator.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.

Vehicle Command Implementation
Mode Setting

Longitudinal Driver |Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver |Predictive Driver block — Controller that generates normalized steering,
(default) acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for
optimal single-point preview control.

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,
and gear command input.
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Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) |[Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.

ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable
EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited
engine torque command, the ECU sets the engine torque command to the commanded differential
torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller
includes these variants.

Variant Description

Driver - No Clutch Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller Implements a transmission control module (TCM) that uses Stateflow

(default) logic to generate the gear command based on the vehicle
acceleration, brake command, wheel speed, engine speed, and gear
request.

Paddles Implements a paddle controller that uses the vehicle acceleration and
engine speed to generate the gear command.

Transmission Implements a transmission control module (TCM) that uses Stateflow

Controller logic to generate the gear command based on the vehicle

acceleration, wheel speed, and engine speed.

Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.

3-52




Slowly Increasing Steering Maneuver

Variant

Description

Bang Bang ABS

Implements an anti-lock braking system (ABS) feedback controller
that switches between two states to regulate wheel slip. The bang-
bang control minimizes the error between the actual slip and desired
slip. For the desired slip, the controller uses the slip value at which
the mu-slip curve reaches a peak value. This desired slip value is
optimal for minimum braking distance.

Open Loop (default)

Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.

Five-State ABS

Five-state ABS control when you simulate the maneuver.!">3 The five-
state ABS controller uses logic-switching based on wheel deceleration
and vehicle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver. The default ABS parameters are set to work on roads that
have a constant friction coefficient scaling factor of 0.6.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch, yaw, and roll

* Brake command

*  Wheel speed

* Gear

* Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.
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Body, Suspension, Variant Description
Wheels Subsystem
PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw
* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
(default)
* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll
e Each wheel has two DOFs — Vertical and
rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model rear-wheel, or rear-wheel active differential drive
Front Wheel ) )
Gear Drive and specify the type of torque coupling.
Rear Wheel Drive
Rear Wheel Drive
Active
Differential
(default)
Transmission |Ideal (default) Implements an ideal fixed gear transmission.
Brake NA Implements the heuristic response of a hydraulic
Hydraulics system when the controller applies a brake
command to a cylinder. Includes front and rear
wheel bias coefficients. The subsystem converts
the applied pressure to a cylinder spool position.
To generate the brake pressure, the spool applies
a flow downstream to the cylinders.
Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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Element Description

Driver Commands

Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
¢ Lateral acceleration
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Element Description
Yaw Rate and Steer Scope |Yaw rate and steering angle versus time:
block

* Yellow line — Yaw rate
* Blue lines — Steering angle

Steer, Velocity, Lat Accel |¢ SteerAngle — Steering angle versus time
Scope block + <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter Plot of vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block |Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “Unreal Engine Simulation
Environment Requirements and Limitations” on page 8-6. After you open the reference application,
in the Visualization subsystem, open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.

* Scene to one of the scenes, for example Straight road.
3D Engine
(O Enabled
(® Disabled

Double lane change

Scene:

Engine { curved road
Parking lot
Double lane change

Open surface

Initial
* To position the vehicle in the scene:
1 Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for
the scene

* User-specified — Set your own initial vehicle position

2 (Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.

Note
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* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrtlEnv window, Simulink stops the simulation with an error.

*  When you enable the 3D visualization environment, you cannot step the simulation back.

To smoothly change the camera views, use these key commands.

Camera View
Back left
Back

Back right
Left

Internal

Right

Front left
Front

A
<

Front right
Overhead

S| O| | J|| U B|lW|IN| e~

View Animated GIF

For additional camera controls, use these key commands.
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Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

T em—— I

o
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Key

Camera Control

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF

Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF
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Constant Radius Maneuver

Constant Radius Maneuver

This reference application represents a full vehicle dynamics model undergoing a constant radius test
maneuver. For information about similar maneuvers, see standards SAE J266 199601!! and ISO
4138:201251. You can create your own versions, establishing a framework to test that your vehicle
meets the design requirements under normal and extreme driving conditions. Use this reference
application in ride and handling studies and chassis controls development to characterize the
steering and lateral vehicle dynamics.

You can configure the reference application for open-loop and closed-loop tests:

* Open-loop — Maintain the target velocity and steering wheel angle to determine the lateral
acceleration, side-slip characteristics, and steering angles for specific accelerations and
subsequent test maneuvers. For the open-loop test, set the Reference Generator block Maneuver
parameter to Increasing Steer.

* Closed-loop — Use the predictive driver to maintain a prespecified turn radius at different
velocities for drivability and handling performance studies. For the closed-loop test, set the
Reference Generator block Maneuver parameter to Constant radius.

To create and open a working copy of the constant radius reference application, enter

vdynblksConstRadiusStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element

Reference Generator Sets the parameters that configure the maneuver and 3D v
block visualization environment. By default, the block is set for the

constant radius maneuver with the 3D simulation engine
environment disabled.

For the minimum 3D visualization environment hardware
requirements, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

To enable 3D visualization, on the 3D Engine tab, select
Enabled.

Driver Commands Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands subsystem variant is the
Predictive Driver block.

Environment Implements wind and road forces. v

Controllers Implements controllers for engine control units (ECUs), v
transmissions, anti-lock braking systems (ABS), and active
differentials.
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Reference Application [Description Variants
Element
Passenger Vehicle Implements the: v

* Body, suspension, and wheels
* Engine
» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory and driver response v

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Reference Generator

The Reference Generator block sets the parameters that configure the maneuver and 3D simulation
environment. By default, the block is set for the constant radius maneuver with the 3D simulation
engine environment disabled.

Use the Maneuver parameter to specify the type of maneuver. You can specify the double lane
change, swept sine, sine with dwell, and slowly increasing maneuvers.

If you select the Use maneuver-specific driver, initial position, and scene parameter, the
reference application sets the driver, initial position, and scene for the maneuver that you specified.

For more information, see Reference Generator.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.

Vehicle Command Implementation
Mode Setting

Longitudinal Driver |Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver |Predictive Driver block — Controller that generates normalized steering,
(default) acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for
optimal single-point preview control.

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,

and gear command input.
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Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) |[Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, brake pressure, and
differential pressure commands.

ECU

The ECU controller generates the engine torque command. The controller prevents over-revving the
engine by limiting the engine torque command to the value specified by model workspace variable
EngRevLim. By default, the value is 7000 rpm. If the differential torque command exceeds the limited
engine torque command, the ECU sets the engine torque command to the commanded differential
torque.

Transmission Control

The Transmission Controller subsystem generates the transmission gear command. The controller
includes these variants.

Variant Description

Driver - No Clutch Open loop transmission control. The controller sets the gear
command to the gear request.

PRNDL Controller Implements a transmission control module (TCM) that uses Stateflow

(default) logic to generate the gear command based on the vehicle
acceleration, brake command, wheel speed, engine speed, and gear
request.

Paddles Implements a paddle controller that uses the vehicle acceleration and
engine speed to generate the gear command.

Transmission Implements a transmission control module (TCM) that uses Stateflow

Controller logic to generate the gear command based on the vehicle

acceleration, wheel speed, and engine speed.

Brake Pressure Control

The Brake Controller subsystem implements a Brake Pressure Control subsystem to generate the
brake pressure command. The Brake Pressure Control subsystem has these variants.
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Variant

Description

Bang Bang ABS

Implements an anti-lock braking system (ABS) feedback controller
that switches between two states to regulate wheel slip. The bang-
bang control minimizes the error between the actual slip and desired
slip. For the desired slip, the controller uses the slip value at which
the mu-slip curve reaches a peak value. This desired slip value is
optimal for minimum braking distance.

Open Loop (default)

Open loop brake control. The controller sets the brake pressure
command to a reference brake pressure based on the brake
command.

Five-State ABS

Five-state ABS control when you simulate the maneuver.!">3 The five-
state ABS controller uses logic-switching based on wheel deceleration
and vehicle acceleration to control the braking pressure at each
wheel.

Consider using five-state ABS control to prevent wheel lock-up,
decrease braking distance, or maintain yaw stability during the
maneuver. The default ABS parameters are set to work on roads that
have a constant friction coefficient scaling factor of 0.6.

Active Differential Control

The Active Differential Control subsystem generates the differential pressure command. To calculate
the command, the subsystem has these variants.

Variant

Description

Rear Diff Controller

Implements a controller that generates the differential pressure
command based on the:

* Steer angle

* Vehicle pitch, yaw, and roll

* Brake command

*  Wheel speed

* Gear

* Vehicle acceleration

No Control (default)

Does not implement a controller. Sets the differential pressure
command to 0.

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.
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Body, Suspension, Variant Description
Wheels Subsystem
PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw
* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
(default)
* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll
e Each wheel has two DOFs — Vertical and
rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model rear-wheel, or rear-wheel active differential drive
Front Wheel ) )
Gear Drive and specify the type of torque coupling.
Rear Wheel Drive
Rear Wheel Drive
Active
Differential
(default)
Transmission |Ideal (default) Implements an ideal fixed gear transmission.
Brake NA Implements the heuristic response of a hydraulic
Hydraulics system when the controller applies a brake
command to a cylinder. Includes front and rear
wheel bias coefficients. The subsystem converts
the applied pressure to a cylinder spool position.
To generate the brake pressure, the spool applies
a flow downstream to the cylinders.
Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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Element Description

Driver Commands

Driver commands:

Handwheel angle
Acceleration command
Brake command

Vehicle Response

Vehicle response:

Engine speed
Vehicle speed
Lateral acceleration

Steer, Velocity, Lat Accel

SteerAngle — Steering angle versus time

Scope block + <xdot> — Longitudinal vehicle velocity versus time
e <ay> — Lateral acceleration versus time
Vehicle XY Plotter Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block

Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

If you enable 3D visualization on the Reference Generator block 3D Engine tab by selecting
Enabled, you can view the vehicle response in the AutoVrt1lEnv window.

To smoothly change the camera views, use these key commands.
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Key Camera View
Back left
Back

Back right
Left

Internal

Right

Front left
Front

Front right
Overhead

S| O| 0| IO B W|N| —

For additional camera controls, use these key commands.
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Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF
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Key

Camera Control

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF

Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF
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Kinematics and Compliance Virtual Test Laboratory

Kinematics and Compliance Virtual Test Laboratory

Model-Based Calibration Toolbox allows you to generate optimized suspension parameters for the
Independent Suspension - Mapped and Solid Axle Suspension - Mapped blocks by using the
kinematics (K) and compliance (C) virtual test laboratory.

To create and open a working copy of the K and C virtual test laboratory reference application, enter
vdynblksKandCTestLabStart

The K and C virtual test laboratory contains vehicle, test system, and test control subsystems. The
vehicle system has two variants:

* Simscape Multibody Vehicle — Vehicle with a Simscape Multibody suspension system
* VDBS Vehicle — Vehicle with an Independent Suspension - Mapped block

DoE Chirp Test
* \eh
LabCtrl
» Lab
i » Veh
Test Control
# LabCtr Weh —
» LabCtrl Lab —
# Lab ‘u’ehF‘hysE[ VehPhys
Test System
Vehicle

This table summarizes the virtual test laboratory tests.
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Test

Objective

Method

Generate Mapped
Suspension from
Spreadsheet Data

Use measured vertical
force and suspension
geometry data to
generate calibrated
suspension parameters
for the mapped
suspension blocks.

Note You can use a
third-party simulation
model to generate the
measured suspension
data.

The virtual test lab uses Model-Based Calibration
Toolbox to fit camber angle, toe angle, and vertical
force response models for the data. The virtual
test lab then uses the response models to generate
suspension parameters for the suspension blocks.

Generate Mapped
Suspension from
Simscape Suspension

Use a Simscape
Multibody suspension
system to generate
calibrated suspension
parameters for the
suspension mapped
blocks.

The virtual test lab uses Model-Based Calibration
Toolbox to perform a Sobol sequence design of
experiments (DoE) on the suspension height and
handwheel angle operating points. At each
operating point, the reference application
stimulates the Simscape Multibody suspension
system with a chirp signal over a frequency range
of 0.1 to 2 Hz. The virtual test lab then uses the
data to fit the suspension vertical force, camber
angle, and toe angle with a Gaussian process
model (GPM) as a function of the suspension state.
Finally, the reference application uses the GPM to
generate suspension parameters for the
suspension blocks.

Compare Mapped and
Simscape Suspension
Responses

Compare the mapped
suspension with the
Simscape Multibody
suspension results.

The virtual test laboratory stimulates the
Simscape Multibody suspension at one operating
point and then compares the response to the
mapped suspension.

Generate Mapped Suspension from Spreadsheet Data

The virtual test lab uses Model-Based Calibration Toolbox to fit camber angle, toe angle, and vertical
force response models for the data. The virtual test lab then uses the response models to generate

suspension parameters for the suspension blocks.

Generate Mapped Suspension Calibration

1 Use the Spreadsheet file field to provide a data file. By default, the reference application has
KandCTestData.xlsx containing required data. The table summarizes the data file

requirements for generating calibrated tables.
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Data Description Data Requirements for
Generating Mapped
Suspension Tables

z Vertical axis suspension height, in |Required
m

zdot Vertical axis suspension height Required
velocity breakpoints, in m/s

str Steering angle, in rad Required

Fz Vertical axis suspension force, in |Required
N

ca Camber angle, in rad Required

ta Toe angle, in rad Required

2 Click Generate mapped suspension calibration to generate response surface models in
Model-Based Calibration Toolbox.

The model browser opens when the process completes. You can view the camber angle, caq, toe
angle, ta, and vertical force, Fz, response model fits for the data.

File Model  View Outliers  Window  Help

@ LOcd & kXxE 7 o db ‘23| @[] [ [ ] &

All Models /@ Response Model: ca
@ MappedSuspensionil
- E MappedSuspensic

Model type: Gaussian Process Model (ARDSquaredExponential, Constant)

@ i3 Response Surface fm X
- MappedSuspensic Plot: Surface >
@ Fz X-axis: |str w
Y-axiz. |z w
Name: Walue Tolerance
sir -0.382604f || Linked to X-... E
z -0.027561¢L_|[Linked to ¥'-... H

Select Data Point... str [rad]

Apply Calibration to Mapped Suspension Model

1 Click Apply calibration to mapped suspension model. The virtual test lab uses the response
models to generate calibrated suspension and breakpoint data.

2 Click OK to update the model workspace and suspension blocks.

In the Model Explorer, you can view the generated suspension parameters.
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Model Hierarchy

2 =

v P21 simulink Root
E Base Workspace

v [*a] KandcvirtuarTestLab
E Model Workspace*

'@,‘; Configurations

Subsystem4

E Contents of; Model Workspace* (only)

Veh_PARAM
% f_susp_axl_bp

Column View: |Data Objects * | Show Details
Mame Value
% DOEMAT [0.0500.05 0.1 2 100]

<1x1 struct>

Test Control [12]

Test System % f_susp_dz_bp [-0.0275619067514496 -0.02067

Vehicle % f_susp_dzdot_bp [-0.720046014836431 -0.54003<
% f_susp_fmz <5D double=
% f_susp_geom <4-D double=
% f_susp_strgdelta_bp [-0.382604972274104 -0.369851
[s] vtol 0.1

Parameter Model Workspace Description

Variable

Axle breakpoints,
f susp_axl bp

f susp axl bp

Axle breakpoints, P, dimensionless.

Vertical axis
suspension height
breakpoints,
f susp _dz_bp

f susp dz bp

Vertical axis suspension height breakpoints, M,
in m.

Vertical axis
suspension height
velocity breakpoints,
f susp_dzdot_bp

f susp dzdot bp

Vertical axis suspension height velocity
breakpoints, N, in m/s.

Vertical axis
suspension force and
moment responses,

f susp fmz

f susp fmz

M-by-N-by-0-by-P-by-4 array of output values as
a function of:

* Vertical suspension height, M

» Vertical suspension height velocity, N

* Steering angle, O

e Axle, P

* 4 output types

e 1 — Vertical force, in N'm
e 2 — User-defined

* 3 — Stored energy, in ]

* 4 — Absorbed power, in W
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Parameter

Model Workspace
Variable

Description

Suspension geometry
responses,
f susp_geom

f susp _geom

M-by-0-by-P-by-3 array of geometric suspension
values as a function of:

* Vertical suspension height, M

* Steering angle, O

* Axle, P

* 3 output types

e 1 — Camber angle, in rad
* 2 — Caster angle, in rad
* 3 — Toe angle, in rad

Steering angle
breakpoints,
f susp_strgdelta_bp

f susp strgdelta bp

Steering angle breakpoints, O, in rad.

Generate Mapped Suspension from Simscape Suspension

The virtual test lab uses Model-Based Calibration Toolbox to perform a Sobol sequence design of
experiments (DoE) on the suspension height and handwheel angle operating points. At each
operating point, the reference application stimulates the Simscape Multibody suspension system with
a chirp signal over a frequency range of 0.1 to 2 Hz. The virtual test lab then uses the data to fit the
suspension vertical force, camber angle, and toe angle with a Gaussian process model (GPM) as a
function of the suspension state. Finally, the reference application uses the GPM to generate
suspension parameters for the suspension blocks.

The test laboratory exercises the suspension system with the DOE settings contained in the DOEMAT
array. To view the DOEMAT array values, open the Model Explorer.

Element

Description

DOEMAT(1,1)

Suspension height

DOEMAT(1,2)

Handwheel angle

DOEMAT(1,3)

Chirp signal amplitude

DOEMAT(1,4)

Starting chirp frequency

DOEMAT(1,5)

Ending chirp frequency

DOEMAT(1,6)

Simulation time to complete chirp signal frequency range

The generation can take time to run and slow other computer processes. View progress in the

MATLAB® window.

In the Model Explorer, you can view the generated suspension parameters.
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Model Hierarchy

2 =

v P21 simulink Root
E Base Workspace

v [*a] KandcvirtuarTestLab
E Model Workspace*

'@,‘; Configurations

Subsystem4

E Contents of; Model Workspace* (only)

Veh_PARAM
% f_susp_axl_bp

Column View: |Data Objects * | Show Details
Mame Value
% DOEMAT [0.0500.05 0.1 2 100]

<1x1 struct>

Test Control [12]

Test System % f_susp_dz_bp [-0.0275619067514496 -0.02067

Vehicle % f_susp_dzdot_bp [-0.720046014836431 -0.54003<
% f_susp_fmz <5D double=
% f_susp_geom <4-D double=
% f_susp_strgdelta_bp [-0.382604972274104 -0.369851
[s] vtol 0.1

Parameter Model Workspace Description

Variable

Axle breakpoints,
f susp_axl bp

f susp axl bp

Axle breakpoints, P, dimensionless.

Vertical axis
suspension height
breakpoints,
f susp _dz_bp

f susp dz bp

Vertical axis suspension height breakpoints, M,
in m.

Vertical axis
suspension height
velocity breakpoints,
f susp_dzdot_bp

f susp dzdot bp

Vertical axis suspension height velocity
breakpoints, N, in m/s.

Vertical axis
suspension force and
moment responses,

f susp fmz

f susp fmz

M-by-N-by-0-by-P-by-4 array of output values as
a function of:

* Vertical suspension height, M

» Vertical suspension height velocity, N

* Steering angle, O

e Axle, P

* 4 output types

e 1 — Vertical force, in N'm
e 2 — User-defined

* 3 — Stored energy, in ]

* 4 — Absorbed power, in W
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Parameter

Model Workspace
Variable

Description

Suspension geometry
responses,
f susp_geom

f susp _geom

M-by-0-by-P-by-3 array of geometric suspension
values as a function of:

* Vertical suspension height, M

* Steering angle, O

* Axle, P

* 3 output types

e 1 — Camber angle, in rad
* 2 — Caster angle, in rad
* 3 — Toe angle, in rad

Steering angle
breakpoints,
f susp_strgdelta_bp

f susp strgdelta bp

Steering angle breakpoints, O, in rad.

Compare Mapped and Simscape Suspension Responses

The virtual test laboratory stimulates the Simscape Multibody suspension at one operating point and
then compares the response to the mapped suspension.

» To stimulate the Simscape Multibody suspension model, the test laboratory uses with the DOE
settings contained in the DOEMAT array.

During the simulation, to view the suspension system, select the Mechanics Explorers tab.
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MECHANICS EXPLORERS VIEW

MATLAE » Projects » slexamples » KandCVirtualTestLab »
Simulink Project - KandCVirtualTestLab | Mechanics Explorers - Mechanics Explorer-Kand CVirtualTestLabAg
| Mechanics Explorer-KandCVirtualTestLabActuater 0 |

2, r:andcwrtuawestLab.qctuat4f
---DDD Actuator_LF
---':'D':' Actuator_LR
---Dg':' Actuator_RF
---DDD Actuator_ RR
- Body

- Steering
---Dg':' Susp_LF
---DDD Susp_LR v
---DD':' Susp_RF L
---':'D':' Susp_RR :
---Dg':' World_Clamp
-4 Prismatic_Rack
-4 Spherical_Spindle_TiL f :
- i@ Spherical_Spindle_TiR

F-Connection Frames
£

~
.

L.

» After the simulation completes, use the Simulation Data Inspector to compare the suspension
system response for the mapped suspension and Simscape Multibody suspension model. For
example, compare the vertical force, camber angle, and toe angle responses.
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2esd

0.3

0.1

® FzLF = MappedSuspFz

‘ \ i 1 Milig o0 A
A T ) (LTS AR o e

N/

i} 10 20 30 40 50 80 0 a0 a0 100

W calF W Mapped3SuspCamber

i

d (1 0 ¢

(A

1] 102 20 30 40 50 80 70 0 a0 100

mtaLF m MappedSuspToe

A L

See Also
Independent Suspension - Mapped | Solid Axle Suspension - Mapped

More About

. Simulation Data Inspector
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Run a Vehicle Dynamics Maneuver in 3D Environment

3-80

This example shows how to run a vehicle dynamics maneuver in a 3D environment. By integrating
vehicle dynamics models with a 3D environment, you can test advanced driver assistance systems
(ADAS) and automated driving (AD) perception, planning, and control software. For the 3D
visualization engine platform requirements and hardware recommendations, see “Unreal Engine
Simulation Environment Requirements and Limitations” on page 8-6.

1 Create and open a working copy of a maneuver reference application. For example, open the
double-lane change reference application.

vdynblksDblLaneChangeStart
2  Run the maneuver simulation. By default, the 3D environment is disabled.

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including
steering, vehicle and engine speed, and lateral acceleration. You can use the Simulation Data
Inspector to import the logged signals and examine the data.

[=]
<LeftBng= [= Le#@acundary
Lane i
. <RightBnd= = M| Rignt Boundary | D
<LinRe>
pl -
. oy Lare Change

=AocFdbic:

<DecaiFdbk=

e B o )
L
<SteerFdbk> (deg)| o

<EngSpd>

’ R i ) SwarAngle
VehFdbi @ vehFdbk e ] mp 'J dot_mpn 3 2, D

x>

>
zay»

<ay>

S, Welocity, Lal Acosl

5

3D Engine
Diouble lane change
Disa bled
Inerix¥Z
Inerdng
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‘ehFebk
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Run a Vehicle Dynamics Maneuver in 3D Environment

3

Element

Description

Driver Commands

Driver commands:

* Handwheel angle
e Acceleration command
¢ Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
* Acceleration command

Lane Change Scope
block

Lateral vehicle displacement versus time:

* Red line — Cones marking right lane boundary

* QOrange line — Cones marking left lane boundary
* Blue line — Reference trajectory

* (Green line — Actual trajectory

Steer, Velocity, Lat
Accel Scope block

+ SteerAngle — Steering angle versus time
* <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter

Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block

Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal
and lateral velocity, and sideslip angle

Enable the 3D visualization environment. In the Visualization subsystem, open the 3D Engine

block. Set these parameters.

* 3D Engine to Enabled.

* Scene description to one of the scenes, for example Double lane change.

3D Engine
® Enabled
) Disabled

Scene: |Double lane change

| Straight road
Engine | curved road
Initial Parking lot

Open surface

Double lane change

* To position the vehicle in the scene:

a  Select the position initialization method:
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* Recommended for scene — Set the initial vehicle position to values recommended
for the scene

* User-specified — Set your own initial vehicle position

b Click Update the model workspaces with the initial values to overwrite the initial
vehicle position in the model workspaces with the applied values.

4 Rerun the reference application. As the simulation runs, in the AutoVrt1lEnv window, view the
vehicle response.

To smoothly change the camera views, use these key commands.

Key Camera View

Back left
Back

Back right
Left
Internal
Right
Front left
Front

Front right
Overhead

S| O|O|J| OO0 B WIN| -~

View Animated GIF

For additional camera controls, use these key commands.
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Key

Camera Control

Tab

Cycle the view between all vehicles in the scene.

View Animated GIF

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

T —— R

R
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Key Camera Control
L Toggle a camera lag effect on or off. When you enable the lag effect,
the camera view includes:
» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity
This lag enables improved visualization of overall vehicle
acceleration and rotation.
View Animated GIF
- e =
F Toggle the free camera mode on or off. When you enable the free

camera mode, you can use the mouse to change the pitch and yaw
of the camera. This mode enables you to orbit the camera around
the vehicle.

View Animated GIF

For example, when you run the double-lane change maneuver, use the cameras to visualize the

vehicle as it changes lanes.
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e Back

* Front left
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e Internal
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Note

* To open and close the AutoVrtlEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrt1lEnv window, Simulink stops the simulation with an error.

*  When you enable the 3D visualization environment, you cannot step the simulation back.

See Also

More About

. “Double-Lane Change Maneuver” on page 3-21

. “Slowly Increasing Steering Maneuver” on page 3-50

. “Swept-Sine Steering Maneuver” on page 3-39

. Simulation Data Inspector

. “Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3
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Send and Receive Double-Lane Change Scene Data

3-88

This example shows you how to use the Simulation 3D Message Set and Simulation 3D Message Get
blocks to communicate with the 3D visualization environment when you run the double-lane change
maneuver. Specifically, you use the:

* Simulation 3D Message Get block to retrieve how many cones the vehicle hits during the
maneuver.
« Simulation 3D Message Set block to control the traffic signal light.

For the minimum hardware required to run the example, see the “Unreal Engine Simulation
Environment Requirements and Limitations” on page 8-6.

Run a Double-Lane Change Maneuver That Hits Cones

With the 3D visualization environment enabled, run a double-lane change maneuver that hits the
cones.

1 Create and open a working copy of the double-lane change reference application project.

vdynblksDblLaneChangeStart

2 Enable the 3D visualization environment. In the Visualization subsystem, open the 3D Engine
block mask and select Enabled. Apply the changes and save the model.

Alternatively, at the MATLAB command prompt, enter this code.
See Code That Enables 3D Environment

% Enable the 3D visualization environment

mdl = 'DLCReferenceApplication’;

set param([mdl '/Visualization/3D Engine'l], 'engine3D', 'Enabled');
save_system(mdl)

3 In the top level of the model, set the Lane Change Reference Generator block parameters so that
the vehicle does not successfully complete the maneuver. Set these block parameters, apply the
changes, and save the model.

* Maneuver start time to 5.

* Longitudinal entrance velocity setpoint to 36.
Alternatively, at the MATLAB command prompt, enter this code.
See Code That Sets Parameters

% Set Lane Change Reference Generator block parameters

mdl = 'DLCReferenceApplication’;

set param([mdl '/Lane Change Reference Generator'],'t start','5');
set param([mdl '/Lane Change Reference Generator'], 'xdot r','36"');
save_system(mdl)

4 Run the maneuver for 30 seconds. As the simulation runs, in the AutoVrtlEnv window, you can
see the vehicle hitting the cones.


matlab:vdynblksDblLaneChangeStart

Send and Receive Double-Lane Change Scene Data

See Code That Runs Simulation

% Run simulation for 30s.

mdl = 'DLCReferenceApplication’;
set param(mdl, 'StopTime', '30");
save(mdl);

sim(mdl);

Use Simulation 3D Message Get Block to Retrieve Cone Data

Use the Simulation 3D Message Get block to retrieve how many cones the vehicle hits during the
maneuver. By default, the maneuver uses the double-lane change scene.

1

Navigate to the Visualization > 3D Engine subsystem. Right-click the 3D Engine block and select
Mask > Look Under Mask. In the Visualization > 3D Engine > 3D Engine subsystem, insert
these blocks:

* Simulation 3D Message Get

* Display

* Math Function

Set the Simulation 3D Message Get block parameters so that the block retrieves cone data from
the double-lane change scene. Set these block parameters, apply the changes, and save the
model.

* Signal name, SigName to NumOfConesHit

* Data type, DataType to boolean

* Message size, MsgSize to [2 15]

* Sample time to -1
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Block Parameters: Simulation 3D Message Get X
Simulation 3D Message Get (mask) (link)

Retrieves data from the 3D visualization environment. To use the
block, install the support package for customizing scenes. If you set
the sample time to -1, the block uses the sample time specified in the
Simulation 3D Scene Configuration block. Ensure that the Simulation
3D Scene Configuration block is in your model.

Parameters

Signal name, SigName []: |Num0ﬂ;‘onesHit |

Data type, DataType []: |boolean -

Message size, MsgSize []: |[2 15] | g

Sample time: |—1 | g

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set these Simulation 3D Message Get block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';

set param([visualss '/Simulation 3D Message Get'],'SigName', 'NumOfConesHit"');
set param([visualss '/Simulation 3D Message Get'], 'DataType', 'boolean');

set param([visualss '/Simulation 3D Message Get'], 'MsgSize','[2 15]");

set param([visualss '/Simulation 3D Message Get'],'Ts','-1');

save system(mdl)

3  Set the Math Function block Output dimensionality parameter to transpose. When you run
the simulation, the Math Function block outputs a [15 2] array.

Block Parameters: Math Function x
Math

Mathematical functions including logarithmic, exponential, power, and
modulus functions. When the function has more than one argument, the
first argument corresponds to the top (or left) input port.

Main  Signal Attributes
Function: | transpose A

Output signal type: |auto -

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set the Math Function block parameter to transpose the array
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';
set param([visualss '/Math Function'], 'Function', 'transpose');
save system(mdl)

4 Connect the Simulation 3D Message Get, Math Function, and Display blocks as shown. Confirm
the block parameters. Save the model.
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054
wp | 2 2 3| ReadMsg p ul o1
E B 1
Math Dizplay
Function

Simulation 3D Meszage Get

IﬁI

Simulation 3D Scene Configuration

Verify that the Simulation 3D Scene Configuration block executes before the Simulation 3D
Message Get block. That way, the Unreal Engine 3D visualization environment prepares the data
before the Simulation 3D Message Get block receives it. To check the block execution order,
right-click the blocks and select Properties. On the General tab, confirm these Priority
settings:

* Simulation 3D Scene Configuration — 0
* Simulation 3D Message Get — 1

For more information about execution order, see “Control and Display Execution Order”.

Run the maneuver. As the simulation runs, the display block updates with the ReadMsg boolean
value 1 when the vehicle hits the corresponding cone.

o]l
o[
all
o]
o]
0] |
0]
0]

|
I
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ol

ol

=1{=1{E=1{E=1E=1 E=] E=1]E=11E=1 E [=J{E=1][=1|E=]]|E=]]

Display
The results indicate that the vehicle hits SM_Cone20 during the maneuver.

This table provides the Double Lane Change scene cone name that corresponds to the ReadMsg
array element.
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Simulation 3D Unreal® Editor Cone |Simulation 3D Unreal Editor Cone
Message Get Block |Name Message Get Block |Name
ReadMsg Value Array Element

ReadMsg(1,1) SM Cone5 ReadMsg(2,1) SM Conel0
ReadMsg(1,2) SM Cone4 ReadMsg(2,2) SM Cone09
ReadMsg(1,3) SM Cone3 ReadMsg(2,3) SM Cone08
ReadMsg(1,4) SM Cone2 ReadMsg(2,4) SM Cone07
ReadMsg(1,5) SM Cone01 ReadMsg(2,5) SM Cone06
ReadMsg(1,6) SM Conel5 ReadMsg(2,6) SM Cone20
ReadMsg(1,7) SM Conel4 ReadMsg(2,7) SM Conel9
ReadMsg(1,8) SM Conel3 ReadMsg(2,8) SM Conel8
ReadMsg(1,9) SM Conel2 ReadMsg(2,9) SM Conel7?
ReadMsg(1,10) SM Conell ReadMsg(2,10) SM Conel6
ReadMsg(1,11) SM Cone25 ReadMsg(2,11) SM Cone30
ReadMsg(1,12) SM Cone24 ReadMsg(2,12) SM Cone29
ReadMsg(1,13) SM Cone23 ReadMsg(2,13) SM Cone28
ReadMsg(1,14) SM Cone22 ReadMsg(2,14) SM Cone27
ReadMsg(1,15) SM Cone21 ReadMsg(2,15) SM Cone26

Use Simulation 3D Message Set Block to Control Traffic Signal Light

1 Navigate to the Visualization > 3D Engine subsystem. Right-click the 3D Engine block and select
Mask > Look Under Mask. In the Visualization > 3D Engine > 3D Engine subsystem, insert
these blocks:

* Simulation 3D Message Set
* Repeating Sequence Stair

2 Set the Simulation 3D Message Set block parameters so that the block sends traffic signal data to
the double-lane change scene. Set these block parameters, apply the changes, and save the
model.

* Signal name, SigName to TrafficLightl
* Sample time to -1

Block Parameters: Simulation 3D Message Set X
Simulation 3D Message Set (mask) (link)

Sends data to the 3D visualization environment. To use the block,
install the support package for customizing scenes. If you set the
sample time to -1, the block uses the sample time specified in the
Simulation 3D Scene Configuration block. Ensure that the Simulation
3D Scene Configuration block is in your model.

Parameters

Signal name, SigName []: |Trafﬁcljght1 |

Sample time: |—1 | g

3-92



Send and Receive Double-Lane Change Scene Data

This table provides the scene traffic signal light color that corresponds to the WriteMsg value in
the Double Lane Change scene.

Simulation 3D Message Set Block TrafficlLightl Color
WriteMsg Value

0 Red

1 Yellow

2 Green

Alternatively, at the MATLAB command prompt, enter this code.
See Code That Sets Parameters

% Set Simulation 3D Message Set block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';

set param([visualss '/Simulation 3D Message Set'],'SigName','TrafficLightl');
set param([visualss '/Simulation 3D Message Set'],'Ts','-1');

save system(mdl)

Set the Repeating Sequence Stair block parameters to send a command that corresponds to red,

yellow, and green traffic light signals. Set these block parameters, apply the changes, and save
the model.

* Vectorofoutputvalues:to [0 0 0 1 1 2 22 2222222222222222
222222]."

* Sample time to 1

Block Parameters: Repeating Sequence Stair X
Repeating Sequence Stair (mask) (link)
Discrete time sequence is output, then repeated.

Main  Signal Attributes

Vector of output values:

|[CIOCIl12222222222222222222222222].' |

Sample time:

! i

J Cancel Help Apply
*  Output data type to int32
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Block Parameters: Repeating Sequence Stair X
Repeating Sequence Stair (mask) (link)
Discrete time sequence is output, then repeated.

Main  Signal Attributes

Output minimum: Output maximum:
[i Il o
Output data type: | int32 MIF .

[ Lock ocutput data type setting against changes by the fixed-point tools

‘)- Cancel Help Apply

Alternatively, at the MATLAB command prompt, enter this code. Apply the block changes and
save the model.

See Code That Sets Parameters

% Set Repeating Sequence Stair block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';

open_system([visualss '/Repeating Sequence Stair']l);
set param([visualss '/Repeating Sequence Stair'],'OutValues',"[0 0 0 1 1222222222222222222222

set param([visualss '/Repeating Sequence Stair'],'tsamp','1l");
set param([visualss '/Repeating Sequence Stair'],'OutDataTypeStr','int32"');

4 Connect the blocks as shown. Confirm the block parameters and signal connections. Save the
model.
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bt

— Translation

— Rotation

.H_I;W

— Scale

05 4
!H M WriteMsg | 2 2 3 +
5 8 1
Repeating
Sequence
Stair

Simulation 30 Message Set

Verify that the Simulation 3D Message Set block executes before the Simulation 3D Scene
Configuration block. That way, Simulation 3D Message Set prepares the signal data before the
Unreal Engine 3D visualization environment receives it. To check the block execution order,
right-click the blocks and select Properties. On the General tab, confirm these Priority
settings:

» Simulation 3D Scene Configuration — 0

* Simulation 3D Message Set — -1

For more information about execution order, see “Control and Display Execution Order”.

Run the maneuver. As the simulation runs, in the AutoVrtlEnv window, you can see the
TrafficLight1l light change from red to yellow to green.
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Time Range (s) WriteMsg Value TrafficLightl Color
0-3 0 Red
3-5 1 Yellow
5-30 2 Green
See Also

Double Lane Change | Simulation 3D Message Get | Simulation 3D Message Set | 3D Engine |

Simulation 3D Scene Configuration

Related Examples

. “Double Lane Change Reference Application” on page 7-9

. “Yaw Stability on Varying Road Surfaces” on page 1-16

More About

. “Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3
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“Get Started Communicating with the Unreal Engine Visualization Environment” on page 6-20
“Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
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Start Double-Lane Change Maneuver at Target Velocity

3-98

This example shows you how to use the steady-state operating points to start the maneuver at the
target velocity set point. When you start the simulation with the vehicle at rest, the vehicle
accelerates until it achieves the target velocity before it starts the maneuver. The simulation run-time
includes the time for getting the vehicle up-to-speed. For example, with the default double-lane
change maneuver settings, the simulation takes ~11 s to achieve the target velocity and ~17 s to
start the maneuver. The maneuver takes ~5 s of 25 s of simulation time.
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- / / N
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L ~~ | Reaches target Start /
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P velocily = Finishes
0 // maneuver
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B Driver Commands:1.AccelCmd
1.0 4 —
A
a. d \
I \
05 [\
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|I T |
04—/ I.
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B Drnver Commands:1.SteerCmd
[] ]
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To save simulation time, you can start the simulation at the target velocity. First, you find the steady-
state conditions when the vehicle is operating at the target velocity. Once you have the steady-state
solution, you can use it to initialize the vehicle and start the maneuver at the target velocity.

Follow these steps.
1 Create and open a working copy of the double-lane change reference application project.
vdynblksDblLaneChangeStart

2  On the Lane Change Reference Generator block, set the Steady-state initial conditions
parameter to Solve using block parameters.

The block Longitudinal entrance velocity setpoint, xdot_r parameter specifies a target
velocity of 35 mph.


matlab:vdynblksDblLaneChangeStart

Start Double-Lane Change Maneuver at Target Velocity

Eﬁ Block Parameters: Lane Change Reference Generator
Double Lane Change Source (mask) (link)

Once the target longitudinal velocity is achieved, this block will comman
signal and generate a lateral reference trajectory as a function of longitt
Signals indicating the left and right lane boundaries are also generated :
specified track width. An additional distance may be prescribed after the
velocity prior to beginning the maneuver.

Maneuver Parameters  Steady-State Solver

Steady-state initial conditions: |Initialize from model

) |Initialize from model
Steady-state solution to start frE e ———

Maneuver start time, t_start [S]!if.igume from a workspace variable

Inertial longitudinal position of gate entrance, XGate [m]: |1?5

| Longitudinal entrance velocity setpoint, xdot_r: '35 |

Longitudinal entrance velocity setpoint units, xdotUnit []: mph

On the Steady-State Solver tab, verify the initial conditions, workspace variable, and solver
setting parameters. For this example, set Workspace variable name to generate, ssWSName
to d1cSS35mph.

Maneuver Parameters  Steady-State Solver
Parameters

Initial longitudinal position, X_o [m]: 175 IF

Initial lateral position, ¥_o, [m]: [VEH.InitialLatPosition

Initial heading (yaw) angle, psi_o [rad]: 'vEH,InitialYawAngre

Steady-state solver tolerance, ssTol [xdotUnit]: 15

Maximum simulated time to reach steady-state, ssMaxTime [s]: 5_3[:' :

Workspace variable name to generate, ssWSName []: !dlc5535mphl

Generate steady state solution

Click Apply.

Click Generate steady state solution. After the simulation completes, examine the
d1cSS35mph workspace variable. It contains the logged states for approximately 40 model state
variables at the steady-state operating points, including the suspension.
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|j./5 dlcS535mph.loggedStates

lﬁ Open~¥ Rows Columns Transpose
New fr_om Print ¥ | || | Insert Delete Sort ¥
Selection
VARIABLE SELECTION EDIT

|

>

EES - I @ 4 o °H

d|

dIcSS35mph.loggedStates

Index « Value Name
@ DSTATE
@] 10 1x1 State

|11 1x1 State

0|12 1x1 State

0|13 1x1 State

] 14 1x1 State

|15 1x1 State

0|16 1x1 State

|17 1x1 State

0|18 1x1 State

<

BlockPath

ey

DLCReferenceApplication/Lane Change Reference Generator/150 38...
DLCReferenceApplication/Passenger Vehicle/Pedal Cluster and Cabi...
DLCReferenceApplication/Sensors/Three-axis Inertial Measurement ...
DLCReferenceApplication/Sensors/Three-axis Inertial Measurement ...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...
DLCReferenceApplication/Passenger Vehicle/Body, Suspension, Whe...

N

Class

Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State
Simulink.SimulationData.State

Note Verify that generating the steady-state solution created or updated the workspace. If the

model cannot find a steady-state solution, try different parameter or solver settings.

5 On the Lane Change Reference Generator block, set:

* Steady-state initial conditions to Resume from a workspace variable.

* Steady-state solution to start from, ssVar to the workspace variable that you specified in

step 3. For this example, set it to d1cSS35mph.

Maneuver Parameters

Steady-State Solver

Steady-state initial conditions: |Resume from a workspace variable Iy

|Steady-state solution to start from, ssVar []: |dIcSS35mph |

Click Apply.

Run the simulation.

7 Examine the results. The simulation starts at the steady-state operating point with the vehicle at
the target velocity of 35 mph. The vehicle maneuver takes ~5 s of 7 s of simulation time. This is

18 s less than the original simulation time.
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W xdot_mph
35 4
30 - / Finishes
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maneuver
25 /
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M Driver Commands:1.AccelCmd
024
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|
ol
0 1 2 3 4 5
M Driver Commands:1.5teerCmd
10 4
N
{ \
U J ‘ \-J '\\
' \
‘ \/
10 J
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See Also
Lane Change Reference Generator
Related Examples
. “Double-Lane Change Maneuver” on page 3-21
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4 Project Templates

Vehicle Dynamics Blockset Project Templates

Vehicle Dynamics Blockset provides preassembled vehicle dynamics models that you can use to
analyze the dynamic system response to common ride and handling tests. Use the templates to create
vehicle dynamic model variants for the maneuver reference applications. Open project files that
contain the vehicle models from the Simulink start page.

1 In Simulink, on the Simulation tab, select New > Project > New Project.

In the Simulink start page, browse to Vehicle Dynamics Blockset and select Passenger 3DOF
Vehicle, Passenger 7DOF Vehicle, or Passenger 14DOF Vehicle.

In the Create Project dialog box, in Project name, enter a project name.

In Folder, enter a project folder or browse to the folder to save the project.

Click OK.

If the folder does not exist, the dialog box prompts you to create it. Click Yes.

The software compiles the project and populates the project folders. All models and supporting
files are in place for you to customize your vehicle dynamics model.

This table summarizes the vehicle dynamics project templates.

Vehicle |Description Vehicle Body Degrees-of-Freedom Wheel DOFs
Model (DOFs)
Passeng |* Vehicle with |Six Two per wheel - eight total
er four wheels
LADIOIE | el o Translational Rotational Translational [Rotational
Vehicle model Longitudinal v/ |Pitch v Vertical |v |Rolling | v
;’;rlant I llLateral v |Yaw v
e
maneuver || Vertical v |Roll 4
reference
applications
Passeng |* Vehicle with |Three One per wheel - four total
er 7DOF four wheels
Vehicle (I, Available as Translational Rotational Rotational
model Longitudinal v |Pitch Rolling v
:ﬁglant n Lateral v |Yaw v
maneuver || Vertical Roll
reference
applications
Passeng |¢ Vehicle with |Three None
er 3DOF ideal tire
Vehicle Translational Rotational
Longitudinal v |Pitch
Lateral v |Yaw v
Vertical Roll
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Vehicle Dynamics Blockset Project Templates

See Also

More About

. “Double-Lane Change Maneuver” on page 3-21
. “Slowly Increasing Steering Maneuver” on page 3-50
. “Swept-Sine Steering Maneuver” on page 3-39
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5 Maneuver Standards

ISO 15037-1:2006 Standard Measurement Signals

5-2

You can configure the maneuver reference applications to display ISO 15037-1:2006!"! standard
measurement signals in the Simulation Data Inspector, including steering wheel angle and torque,
longitudinal and lateral velocity, and sideslip angle.

To configure the ISO signal display, in the reference application Visualization subsystem, open the
ISO 15037-1:2006 block. Select Enabled. After you run the maneuver, the Simulation Data Inspector
opens with standard measurements.

For example, to display the ISO signals when you run the double lane change maneuver:
1 Create and open a working copy of the double-lane change reference application project.

vdynblksDblLaneChangeStart

2 In the Visualization subsystem, open the ISO 15037-1:2006 block. Select Enabled. Save the
reference application.

3  Run the maneuver. As the simulation runs, view the ISO standard measurement signals in the
Simulation Data Inspector, including steering wheel angle and torque, longitudinal and lateral
velocity, and sideslip angle.

W Steering-wheel angle

0 2 4 3} 8 10 12 14 16 13

W Steering-wheel torgue

0 2 4 3} 8 10 12 14 16 13

W Longitudinal velocity m Lateral velocity

[
-]

a 2 4 5] g 10 12 14 16 18

W Sideslip angle

[
-]

References

[1]1ISO 15037-1:2006. Road vehicles -- Vehicle dynamics test methods -- Part 1: General conditions for
passenger cars. ISO (International Organization for Standardization), 2014.


matlab:vdynblksDblLaneChangeStart

ISO 15037-1:2006 Standard Measurement Signals

See Also

More About

. “Double-Lane Change Maneuver” on page 3-21

. “Slowly Increasing Steering Maneuver” on page 3-50
. “Swept-Sine Steering Maneuver” on page 3-39

. Simulation Data Inspector

External Websites

. International Organization for Standardization
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6 Supporting Data

Support Package For Maneuver and Drive Cycle Data

This example shows how to install additional maneuver and drive cycle data from a support package.
By default, the Drive Cycle Source block has the FTP-75 drive cycle data. The support package has
drive cycles that include the gear shift schedules, for example JC08 and CUEDC.
In the Drive Cycle Source block, click Install additional drive cycles to start the installer.
Follow the instructions and default settings provided by the installer to complete the installation.
On the Select a support package screen, select the data you want to add:

Accept or change the Installation folder and click Next.

Note You must have write permission for the Installation folder.

See Also
Drive Cycle Source
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Customize 3D Scenes for Vehicle Dynamics Simulations

Customize 3D Scenes for Vehicle Dynamics Simulations

%3] ScRReferencenppication b

Vehicle Dynamics Blockset contains prebuilt scenes in which to simulate and visualize the
performance of vehicles modeled in Simulink. These scenes are visualized using a standalone Unreal
Engine executable within the toolbox. If you have the Unreal from Epic Games and the Vehicle
Dynamics Blockset Interface for Unreal Engine 4 Projects installed, you can customize these scenes.
You can also use the Unreal Editor and the support package to simulate within scenes from your own
custom project.

With custom scenes, you can co-simulate in both Simulink and the Unreal Editor so that you can
modify your scenes between simulation runs. To customize scenes, you should be familiar with
creating and modifying scenes in the Unreal Editor.

Displays

N

WhiAngF

FwF

FwR

Il

‘I I‘ Inf <Y>
F B xdot
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FzR

iR

Vehicle Body 3DOF Dual Track Help

To customize 3D scenes, follow these steps:

1 “Install Support Package and Configure Environment” on page 6-5

2 “Migrate Projects Developed Using Prior Support Packages” on page 6-8
3  “Customize Scenes Using Simulink and Unreal Editor” on page 6-9

4 “Package Custom Scenes into Executable” on page 6-17

See Also

Simulation 3D Scene Configuration

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-88

More About

. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6

External Websites
. Unreal Engine
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https://www.unrealengine.com/en-US/unreal
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. Unreal Engine 4 Documentation
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Install Support Package and Configure Environment

Install Support Package and Configure Environment

To customize scenes in your installation of the Unreal Editor and simulate within these scenes in
Simulink, you must first install and configure the Vehicle Dynamics Blockset Interface for Unreal
Engine 4 Projects support package.

Note These installation instructions apply to R2021b. If you are using a previous release, see the
documentation for Other Releases.

Verify Software and Hardware Requirements

Before installing the support package, make sure that your environment meets the minimum software
and hardware requirements described in “Unreal Engine Simulation Environment Requirements and
Limitations” on page 8-6.

Install Support Package

To install the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package,
follow these steps:

1 Onthe MATLAB Home tab, in the Environment section, select Add-Ons > Get Add-Ons.

J.vf @ {*% Community
E Request Support

- *  [E] Learn MATLAB

Get Add-Ons

Manage Add-Ons

Package Toolbox

200 &

Package App

2 In the Add-On Explorer window, search for the Vehicle Dynamics Blockset Interface for Unreal
Engine 4 Projects support package. Click Install.

Note You must have write permission for the installation folder.

Configure Environment

The Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package includes these
components:

* An Unreal project, AutoVrtlEnv.uproject, and its associated files. The project includes
editable versions of the prebuilt 3D scenes that you can select from the Scene description
parameter of the Simulation 3D Scene Configuration block. To use this project, you must copy the
file to a folder on your local machine.


https://www.mathworks.com/help/doc-archives.html

6 Supporting Data

6-6

* A plugin, MathWorkSimulation. This plugin establishes the connection between MATLAB and
the Unreal Editor and is required for co-simulation. You must copy this plugin to your local
installation of the editor.

To copy the project to a local folder and the plugin to your Unreal Editor installation, follow these
one-time steps. Use the “Code That Configures Scene Configuration (Steps 1-4)” on page 6-6.

St |Description
ep

1 |Specify the location of the support package project files and a local folder destination.

Note You must have write permission for the local folder destination.

2 | Specify the location of the Unreal Engine installation, for example C:\Program Files\Epic
Games\UE 4.25.

3 |Copy the MathWorksSimulation plugin folder to the Unreal Engine plugin folder.

Copy the support package folder that contains the AutoVrtlEnv.uproject files to the local
folder destination.

Code That Configures Scene Configuration (Steps 1-4)

%% STEP1
% Specify the location of the support package project files and a local folder destination
s Note: Only one path is supported. Select latest download path.
dest root = "C:\Local";
src_root = fullfile(matlabshared.supportpkg.getSupportPackageRoot, ...
"toolbox", "shared", "sim3dprojects", "spkg");

°

%% STEP2
% Specify the location of the Unreal Engine installation.
ueInstFolder = "C:\Program Files\Epic Games\UE 4.25";

%% STEP3
% Copy the MathWorksSimulation plugin to the Unreal Engine plugin folder.
mwPluginName = "MathWorksSimulation";

mwPluginFolder = fullfile(src_root, "plugins");
uePluginFolder = fullfile(ueInstFolder, "Engine", "Plugins");
uePluginDst = fullfile(uePluginFolder, "Marketplace", "MathWorks");

cd(uePluginFolder)
foundPlugins = dir("**/" + mwPluginName + ".uplugin");

if ~isempty(foundPlugins)
numPlugins = size(foundPlugins, 1);
msg2 = cell(1l, numPlugins);
pluginCell = struct2cell(foundPlugins);

msgl = "Plugin(s) already exist here:" + newline + newline;
for n = 1l:numPlugins
msg2{n} = " " + pluginCell{2,n} + newline;
end
msg3 = newline + "Please remove plugin folder(s) and try again.";
msg = msgl + msg2 + msg3;
warning(msg);
else

copyfile(fullfile(mwPluginFolder, 'mw simulation', 'MathWorksSimulation'), uePluginDst);
disp("Successfully copied MathWorksSimulation plugin to UE4 engine plugins!")
end

%% STEP4
Copy the support package folder that contains the AutoVrtlEnv.uproject
files to the local folder destination.
projFolderName = "AutoVrtlEnv";
projSrcFolder = fullfile(src_root, "project", projFolderName);
projDstFolder = fullfile(dest root, projFolderName);
if ~exist(projDstFolder, "dir")
copyfile(projSrcFolder, projDstFolder);
end

[
c
[
c




Install Support Package and Configure Environment

If you want to use a project developed using a prior release of the Vehicle Dynamics Blockset
Interface for Unreal Engine 4 Projects support package, you must migrate the project to make it
compatible with Unreal Editor 4.25. See “Migrate Projects Developed Using Prior Support Packages”
on page 6-8. Otherwise, you can “Customize Scenes Using Simulink and Unreal Editor” on page 6-

9.

See Also
Simulation 3D Scene Configuration

More About

. “Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3
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Migrate Projects Developed Using Prior Support Packages

6-8

After you install the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support
package as described in “Install Support Package and Configure Environment” on page 6-5, you may
need to migrate your project. If your Simulink model uses an Unreal Engine executable or project
developed using a prior release of the support package, you must migrate the project to make it
compatible with Unreal Editor 4.25. Follow these steps:

1

Open Unreal Engine 4.25. For example, navigate to C:\Program Files\Epic Games
\UE_4.25\Engine\Binaries\Win64 and open UE4Editor.exe.

Use the Unreal Project Browser to open the project that you want to migrate.

Follow the prompts to open a copy of the project. The editor creates a new project folder in the
same location as the original, appended with 4.25. Close the editor.

In a file explorer, remove the space in the migrated project folder name. For example, rename
MyProject 4.25toMyProject4.25.

Use MATLAB to open the migrated project in Unreal Editor 4.25. For example, if you have a
migrated project saved to the C:/Local folder, use this MATLAB code:

path = fullfile('C:','Local', 'MyProject4.25"', '"MyProject.uproject');
editor = sim3d.Editor(path);
open(editor);

Note The support package may includes changes in the implementation of some actors.
Therefore, if the original project contains actors that are placed in the scene, some of them might
not fully migrate to Unreal Editor 4.25. To check, examine the Output Log.

EX Output Log

3
port_ 2 save 1 K

The log might contain error messages. For more information, see the Unreal Engine 4
Documentation or contact MathWorks Technical Support.

Optionally, after you migrate the project, you can use the project to create an Unreal Engine
executable. See “Package Custom Scenes into Executable” on page 6-17.

After you migrate the project, you can create custom scenes. See “Customize Scenes Using Simulink
and Unreal Editor” on page 6-9.

See Also
Simulation 3D Scene Configuration

More About

“Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3


https://docs.unrealengine.com/en-us
https://docs.unrealengine.com/en-us
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Customize Scenes Using Simulink and Unreal Editor

After you install the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support
package as described in “Install Support Package and Configure Environment” on page 6-5, you can
simulate in custom scenes simultaneously from both the Unreal Editor and Simulink. By using this co-
simulation framework, you can add vehicles and sensors to a Simulink model and then run this
simulation in your custom scene.

To use a project that you developed using a prior release of the support package, first migrate the
project to be compatible with Unreal Engine 4.25. See “Migrate Projects Developed Using Prior
Support Packages” on page 6-8.

Open Unreal Editor

If you open your Unreal project file directly in the Unreal Editor, Simulink is unable to establish a
connection with the editor. To establish this connection, you must open your project from a Simulink
model or use a MATLAB function.

The first time that you open the Unreal Editor, you might be asked to rebuild UE4Editor DLL files or
the AutoVrt1lEnv module. Click Yes to rebuild these files or modules. The editor also prompts you
that new plugins are available. Click Manage Plugins and verify that the MathWorks Interface
plugin is installed. This plugin is the MathWorksSimulation.uplugin file that you copied into your
Unreal Editor installation in “Install Support Package and Configure Environment” on page 6-5.

When the editor opens, you can ignore any warning messages about files with the name
' BuiltData' that failed to load.

If you receive a warning that the lighting needs to be rebuilt, from the toolbar above the editor
window, select Build > Build Lighting Only. The editor issues this warning the first time you open
a scene or when you add new elements to a scene. To use the lighting that comes installed with
AutoVrtlEnv in Vehicle Dynamics Blockset, see “Use AutoVrtlEnv Project Lighting in Custom
Scene” on page 6-12.

Open Unreal Editor from Simulink

1 Open a Simulink model configured to simulate in the 3D environment. At a minimum, the model
must contain a Simulation 3D Scene Configuration block.

2 In the Simulation 3D Scene Configuration block of this model, set the Scene source parameter
toUnreal Editor.

3 In the Project parameter, browse for the project file that contains the scenes that you want to
customize.

For example, this sample path specifies the AutoVrt1lEnv project that comes installed with the
Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package.

C:\Local\AutoVrtlEnv\AutoVrtlEnv.uproject
This sample path specifies a custom project.

Z:\UnrealProjects\myProject\myProject.uproject
4 Click Open Unreal Editor. The Unreal Editor opens and loads a scene from your project.
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Open Unreal Editor Using Command-Line Function

To open the AutoVrtlEnv.uproject file that was copied from the Vehicle Dynamics Blockset
Interface for Unreal Engine 4 Projects support package, specify the path to where you copied this
project. For example, if you copied the AutoVrtlEnv.uproject to C:/Local/AutoVrtlEnv, use
this code:

path = fullfile('C:"', 'Local', 'AutoVrtlEnv', 'AutoVrtlEnv.uproject');
editor = sim3d.Editor(path);
open(editor);

The editor opens the AutoVrtlEnv.uproject file. By default, the project displays the Straight
Road scene.

To open your own project, use the same commands used to open the AutoVrtlEnv.uproject file.
Update the path variable with the path to your .uproject file. For example, if you have a project
saved to the C: /Local folder, use this code:

path = fullfile('C:', 'Local', 'myProject', 'myProject.uproject');

editor = sim3d.Editor(path);
open(editor);

Reparent Actor Blueprint

Note If you are using a scene from the AutoVtrlEnv project that comes installed with the Vehicle
Dynamics Blockset Interface for Unreal Engine 4 Projects support package, skip this section.
However, if you create a new scene based off of one of the scenes in this project, then you must
complete this section.

The first time that you open a custom scene from Simulink, you need to associate, or reparent, this
project with the Sim3dLevelScriptActor level blueprint used in Vehicle Dynamics Blockset. The
level blueprint controls how objects interact with the 3D environment once they are placed in it.
Simulink returns an error at the start of simulation if the project is not reparented. You must reparent
each scene in a custom project separately.

To reparent the level blueprint, follow these steps:

In the Unreal Editor toolbar, select Blueprints > Open Level Blueprint.

In the Level Blueprint window, select File > Reparent Blueprint.

Click the Sim3dLevelScriptActor blueprint. If you do not see the Sim3dLevelScriptActor
blueprint listed, use these steps to check that you have the MathWorksSimulation plugin
installed and enabled:

a In the Unreal Editor toolbar, select Settings > Plugins.

In the Plugins window, verify that the MathWorks Interface plugin is listed in the installed
window. If the plugin is not already enabled, select the Enabled check box.

If you do not see the MathWorks Interface plugin in this window, repeat step 3 in
“Configure Environment” on page 6-5 and reopen the editor from Simulink.

¢ Close the editor and reopen it from Simulink.
4  Close the Level Blueprint window.
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Create or Modify Scenes in Unreal Editor
After you open the editor, you can modify the scenes in your project or create new scenes.
Open Scene

In the Unreal Editor, scenes within a project are referred to as levels. Levels come in several types,
and scenes have a level type of map.

To open a prebuilt scene from the AutoVrtlEnv.uproject file, in the Content Browser pane
below the editor window, navigate to the Content > Maps folder. Then, select the map that
corresponds to the scene you want to modify.

Unreal Editor Map Vehicle Dynamics Blockset Scene
HwCurve Curved Road

Db1lLnChng Double Lane Change

BlackLake Open Surface

LargeParkinglLot Large Parking Lot

SimplelLot Parking Lot

HwStrght Straight Road

USCityBlock US City Block

USHighway US Highway

Note The AutoVrtlEnv.uproject file does not include the Virtual Mcity scene.

To open a scene within your own project, in the Content Browser pane, navigate to the folder that
contains your scenes.

Send Data to Scene

The Simulation 3D Message Get block retrieves data from the Unreal Engine 3D visualization
environment. To use the block, you must configure scenes in the Unreal Engine environment to send
data to the Simulink model.

For detailed information about using the block to send data to the scenes, see “Get Started
Communicating with the Unreal Engine Visualization Environment” on page 6-20.

Receive Data from Scene

The Simulation 3D Message Set block sends data to the Unreal Engine 3D visualization environment.
To use the block, you must configure scenes in the Unreal Engine environment to receive data from
the Simulink model.

For detailed information about using the block to receive data from the scene, see “Get Started
Communicating with the Unreal Engine Visualization Environment” on page 6-20.

Create New Scene

To create a new scene in your project, from the top-left menu of the editor, select File > New Level.
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Alternatively, you can create a new scene from an existing one. This technique is useful if you want to
use one of the prebuilt scenes in the AutoVtrlEnv project as a starting point for creating your own
scene. To save a version of the currently opened scene to your project, from the top-left menu of the
editor, select File > Save Current As. The new scene is saved to the same location as the existing
scene.

Add Assets to Scene

In the Unreal Editor, elements within a scene are referred to as assets. To add assets to a scene, you
can browse or search for them in the Content Browser pane at the bottom and drag them into the
editor window.

When adding assets to a scene that is in the AutoVrtlEnv project, you can choose from a library of
driving-related assets. These assets are built as static meshes and begin with the prefix SM . Search
for these objects in the Content Browser pane.

For example, to add a traffic cone to a scene in the AutoVrt1lEnv project:

In the Content Browser pane at the bottom of the editor, navigate to the Content folder.

In the search bar, search for SM_Cone. Drag the cone from the Content Browser into the editing
window. You can then change the position of the cone in the editing window or on the Details
pane on the right, in the Transform section.

The Unreal Editor uses a left-hand Z-up coordinate system, where the Y-axis points to the right. The
vehicle blocks in Vehicle Dynamics Blockset uses a right-hand Z-down coordinate system, where the
Y-axis points to the right. When positioning objects in a scene, keep this coordinate system difference
in mind.

For more information on modifying scenes and adding assets, see Unreal Engine 4 Documentation.

To migrate assets from the AutoVrtlEnv project into your own project file, see Migrating Assets in
the Unreal Engine documentation.

Use AutoVrtlEnv Project Lighting in Custom Scene

To use the lighting that comes installed with the AutoVrtlEnv project in Vehicle Dynamics Blockset,
follow these steps.

1  On the World Settings tab, clear Force no precomputed lighting.

T\ Details M World Settings

nputed Visibility
Precompute Visibility -

4 Game Mode
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2 Under Build, select Lighting Quality > Production to rebuild the maps with production
quality. Rebuilding large maps can take time.

5. p Al

Build Play Launch

Build Lighting Only

Run Simulation

Verify that the Simulink model and Unreal Editor are configured to co-simulate by running a test
simulation.

1 In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation does
not start. Instead, you must start the simulation from the editor.

2 Verify that the Diagnostic Viewer window in Simulink displays this message:

In the Simulation 3D Scene Configuration block, you set the scene source
to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the scene.

This message confirms that Simulink has instantiated vehicles and other assets in the Unreal
Engine 3D environment.

3 In the Unreal Editor, click Play. The simulation runs in the scene currently open in the Unreal
Editor. If your Simulink model contains vehicles, these vehicles drive through the scene that is
open in the editor.

To control the view of the scene during simulation, in the Simulation 3D Scene Configuration block,
select the vehicle name from the Scene view parameter. To change the scene view as the simulation
runs, use the numeric keypad in the editor. The table shows the position of the camera displaying the
scene, relative to the vehicle selected in the Scene view parameter.

To smoothly change the camera views, use these key commands.

Key Camera View
Back left
Back

Back right
Left

Internal

Right

Front left

N OO AW N -
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Key Camera View

8 Front View Animated GIF
9 Front right

0 Overhead

For additional camera controls, use these key commands.

Key Camera Control

Tab Cycle the view between all vehicles in the scene.

View Animated GIF
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Key

Camera Control

Mouse scroll wheel

Control the camera distance from the vehicle.

View Animated GIF

Toggle a camera lag effect on or off. When you enable the lag effect, the
camera view includes:

» Position lag, based on the vehicle translational acceleration
* Rotation lag, based on the vehicle rotational velocity

This lag enables improved visualization of overall vehicle acceleration and
rotation.

View Animated GIF
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Key Camera Control

F Toggle the free camera mode on or off. When you enable the free camera
mode, you can use the mouse to change the pitch and yaw of the camera.
This mode enables you to orbit the camera around the vehicle.

View Animated GIF

To restart a simulation, click Run in the Simulink model, wait until the Diagnostic Viewer displays the
confirmation message, and then click Play in the editor. If you click Play before starting the
simulation in your model, the connection between Simulink and the Unreal Editor is not established,
and the editor displays an empty scene.

If you are co-simulating a custom project, to enable the numeric keypad, copy the
DefaultInput.ini file from the support package installation folder to your custom project folder.
For example, copy DefaultInput.ini from:

C:\ProgramData\MATLAB\SupportPackages\<MATLABRelease>\toolbox\shared\sim3dprojects\driving\AutoV
to:

C:\<yourproject>.project\Config

After tuning your custom scene based on simulation results, you can then package the scene into an

executable. For more details, see “Package Custom Scenes into Executable” on page 6-17.

See Also
Simulation 3D Scene Configuration | sim3d.Editor

External Websites
. Unreal Engine
. Unreal Engine 4 Documentation
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Package Custom Scenes into Executable

When you finish modifying a custom scene as described in “Customize Scenes Using Simulink and
Unreal Editor” on page 6-9, you can package the project file containing this scene into an executable.
You can then configure your model to simulate from this executable by using the Simulation 3D Scene
Configuration block. Executable files can improve simulation performance and do not require opening
the Unreal Editor to simulate your scene. Instead, the scene runs by using the Unreal Engine that
comes installed with Vehicle Dynamics Blockset.

Package Scene into Executable Using Unreal Editor

1

Open the project containing the scene in the Unreal Editor. You must open the project from a
Simulink model that is configured to co-simulate with the Unreal Editor.

In the Unreal Editor toolbar, select Settings > Project Settings to open the Project Settings
window.

In the left pane, in the Project section, click Packaging.

In the Packaging section, set or verify the options in the table. If you do not see all these
options, at the bottom of the Packaging section, click the Show Advanced expander

R

Packaging Option Enable or Disable
Use Pak File Enable

Cook everything in the project content |Disable
directory (ignore list of maps below)

Cook only maps (this only affects Enable
cookall)

Create compressed cooked packages Enable
Exclude editor content while cooking Enable

Specify the scene from the project that you want to package into an executable.

a Inthe List of maps to include in a packaged build option, click the Adds Element
button .

b Specify the path to the scene that you want to include in the executable. By default, the
Unreal Editor saves maps to the /Game/Maps folder. For example, if the /Game/Maps folder
has a scene named myScene that you want to include in the executable, enter /Game/Maps/
myScene.

¢ Add or remove additional scenes as needed.

Specify the required asset directories to include in the executable. These directories are located
in the MathWorksSimulation plugin.

Under Additional Asset Directories to Cook, click the Adds Element button ksl to add
elements and specify these directories:

* /MathWorksSimulation/Characters
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* /MathWorksSimulation/VehiclesCommon
* /MathWorksSimulation/Vehicles
« /MathWorksSimulation/Weather

Rebuild the lighting in your scenes. If you do not rebuild the lighting, the shadows from the light
source in your executable file are incorrect and a warning about rebuilding the lighting displays
during simulation. In the Unreal Editor toolbar, select Build > Build Lighting Only.

Close the Project Settings window.

In the top-left menu of the editor, select File > Package Project > Windows > Windows (64-
bit). Select a local folder in which to save the executable, such as to the root of the project file
(for example, C: /Local/myProject).

Note Packaging a project into an executable can take several minutes. The more scenes that you
include in the executable, the longer the packaging takes.

Once packaging is complete, the folder where you saved the package contains a
WindowsNoEditor folder that includes the executable file. This file has the same name as the
project file.

Note If you repackage a project into the same folder, the new executable folder overwrites the
old one.

Suppose you package a scene that is from the myProject.uproject file and save the
executable to the C: /Local/myProject folder. The editor creates a file named
myProject.exe with this path:

C:/Local/myProject/WindowsNoEditor/myProject.exe

Simulate Scene from Executable in Simulink

To improve co-simulation performance, consider configuring the Simulation 3D Scene Configuration
block to co-simulate with the project executable.

1

4

In the Simulation 3D Scene Configuration block of your Simulink model, set the Scene source
parameter to Unreal Executable.

Set the File name parameter to the name of your Unreal Editor executable file. You can either
browse for the file or specify the full path to the file by using backslashes. For example:
C:\Local\myProject\WindowsNoEditor\myProject.exe

Set the Scene parameter to the name of a scene from within the executable file. For example:

/Game/Maps/myScene
Run the simulation. The model simulates in the custom scene that you created.

If you are simulating a scene from a project that is not based on the AutoVtrlEnv project, then the
scene simulates in full screen mode. To use the same window size as the default scenes, copy the
DefaultGameUserSettings.ini file from the support package installation folder to your custom
project folder. For example, copy DefaultGameUserSettings.ini from:
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C:\ProgramData\MATLAB\SupportPackages\<MATLABrelease>\toolbox\shared\sim3dprojects\automotive\Au
to:

C:\<yourproject>.project\Config

Then, package scenes from the project into an executable again and retry the simulation.

See Also
Simulation 3D Scene Configuration
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You can set up communication with Unreal Engine by using the Simulation 3D Message Get and
Simulation 3D Message Set blocks:

+ Simulation 3D Message Get receives data from the Unreal Engine environment.

* Simulation 3D Message Set sends data to the Unreal Engine environment.

To use the blocks and communicate with Unreal Engine, make sure you install the Vehicle Dynamics

Blockset Interface for Unreal Engine 4 Projects support package. For more information, see “Install
Support Package and Configure Environment” on page 6-5.

Next, follow these workflow steps to set up the Simulink model and the Unreal Engine environment
and run a simulation.

Workflow Description
“Set Up Simulink Model to Send and Configure the Simulation 3D Message Get and
Receive Data” on page 6-21 Simulation 3D Message Set blocks in Simulink to send

and receive the cone location from Unreal Editor. The
steps provides the general workflow for communicating
with the editor.

The Simulation 3D Message Get and Simulation 3D
Message Set blocks can send and receive these data
types: double, single, int8, uint8, int16, uintle,
int32, uint32, and Boolean. The Simulation 3D Actor
Transform Set and Simulation 3D Actor Transform Get
blocks can send and receive only the single data type.

Set Up Unreal “C++ Workflow: Set |Specific Unreal C++ workflow to send and receive
Engine to Send Up Unreal Engine to |Simulink cone location data.

and Receive Data |Send and Receive ' _ _
Data” on page 6-22 * Simulation 3D Message Get receives data from an

Unreal Engine environment C++ actor class. In this
example workflow, you use the block to receive the
cone location from Unreal Editor.

* Simulation 3D Message Set sends data to an Unreal
Engine C++ actor class. In this example, you use the
block to set the initial cone location in the Unreal
Editor.

To follow this workflow, you should be comfortable
coding with C++ in Unreal Engine. Make sure that your
environment meets the minimum software requirements
described in “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

“Blueprint Workflow: |Generalized Unreal Editor blueprint workflow to send
Set Up Unreal Engine |and receive Simulink data.

to Send and Receive
Data” on page 6-30




Get Started Communicating with the Unreal Engine Visualization Environment

Workflow Description

“Run Simulation” on page 6-35 After you set up the Simulink model and Unreal Editor
environment, run a simulation.

Set Up Simulink Model to Send and Receive Data

Step 1: Install Support Package

If you have already downloaded and installed Unreal Engine and the Vehicle Dynamics Blockset
Interface for Unreal Engine 4 Projects support package, go to the next step.

To install and configure the support package, see “Install Support Package and Configure
Environment” on page 6-5.

Before installing the support package, make sure that your environment meets the minimum software
and hardware requirements described in “Unreal Engine Simulation Environment Requirements and
Limitations” on page 8-6.

Step 2: Set Up Simulink Model

Open a new Simulink model. Connect the blocks as shown.

'

Simulation 30 Scene Configuration

L

054
100 10 50] » single elwitehtsg |2 2 3 | wpn
381
Constant Data Type Conversion

Simulation 3D Meszsage Set

054

* 2 2 3 ReadMsg .“:-I:l
5 31

Display

Simulation 30 Message Get

Step 3: Configure Blocks

Use these block settings to configure blocks to send and receive cone data from the Unreal Editor.
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Block Parameter Settings

Constant ¢ Constant value — [100,10,50]

Sets the initial cone location in the Unreal Editor coordinate
system (in cm, left-handed, in Z-up coordinate system)

* Interpret vector parameters as 1-D — off
*  Output data type — single

Data Type Conversion *  Output data type — single
Simulation 3D Scene * Scene Source — Unreal Editor
Configuration .

Project — Your Project Path
\TestSim3dGetSet.uproject

* Open Unreal Editor — Select to open the editor

Simulation 3D Message Get |¢ Signal name, SigName — ConelLocGet

* Data type, DataType — single
* Message size, MsgSize — [1 3]
* Sample time — -1

Simulation 3D Message Set * Signal name, SigName — ConelLocSet

¢ Sample time — -1

C++ Workflow: Set Up Unreal Engine to Send and Receive Data

Step 4: Open Unreal Editor in Editor Mode

1

In the Unreal Editor, on the Edit tab, select Plugins. Make sure that the MathWorks
Interface plugin is enabled. If prompted, restart the Unreal Editor.

Create an Unreal Engine C++ project. Name it TestSim3dGetSet. For steps on how to create C
++ project, see the Unreal Engine 4 Documentation.

In the Unreal Editor, click the Edit tab in the top left corner. Select Plugins and make sure that
the MathWorks Interface plugin is enabled. If the MathWorks Interface plugin is disabled,
enable it and restart Unreal Editor, if prompted.

Close the Unreal.
If Visual Studio® is not open, open it.
Add the MathWorksSimulation dependency to the TestSim3dGetSet project build file.
* The project build file, TestSim3dGetSet.Build.cs, is located in this
folder: .. .\TestSim3dGetSet\Source\TestSim3dGetSet.

* In the build file, TestSim3dGetSet.Build. cs, edit the line 11 to add the
“MathWorksSimulation” dependency:

PublicDependencyModuleNames.AddRange(new string[] { "Core", "CoreUObject",
"Engine", "InputCore", "MathWorksSimulation"});

Save the change. In Visual Studio, rebuild the TestSim3dGetSet project. Close Visual Studio.

Tip Before rebuilding the project in Visual Studio, make sure that Unreal is not open.
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8 Start MATLAB. Change the current folder to the location of the Unreal Engine
TestSim3dGetSet project.

9 In MATLAB, open the project:

editor = sim3d.Editor('TestSim3dGetSet.uproject');
editor.open();

Step 5: Create Actor Class

1 In the Unreal Editor, from the MathWorksSimulation C++ classes directory, select Sim3dActor.

== Content Browser

s AddNew ~ L Imp [ Save All & = | I MathWorksSimulation C++ Classes » MathWorksSimulati

¥ LEFICCR N “carch Public

 mm MathWorksSimulation Content
4 g MathWorksSimulation C++ Classes
4 fy Math‘_;*.fc:rk.’:‘.Simulatic:n
T
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2 Name the new Sim3dActor SetGetActorLocation. Select Public. Click Create Class.

3  Close the Unreal Editor.
Step 6: Open SetGetActorLocation.h

Visual Studio opens with new C++ files in the project folder:

 SetGetActorLocation.h
* SetGetActorLocation.cpp

Make sure you close the Unreal Editor.

In Visual Studio, build the solution TestSim3dGetSet:

1 In the Solution Explorer, right-click Solution 'TestSim3dGetSet' (2 projects).

2 Select Build Solution.

3 After the solution builds, open SetGetActorLocation.h. Edit the file as shown.

Replacement Code: SetGetActorLocation.h

This is the replacement code for SetGetActorLocation.h.

// Copyright 2019 The MathWorks, Inc.
#pragma once

#include "Sim3dActor.h"
#include "SetGetActorLocation.generated.h"

UCLASS ()

class TESTSIM3DGETSET API ASetGetActorLocation : public ASim3dActor

GENERATED_BODY ()

void *SignalReader;
void *SignalWriter;

public:
// Sets default values for this actor's properties
ASetGetActorLocation();

virtual void Sim3dSetup() override;
virtual void Sim3dRelease() override;
virtual void Sim3dStep(float DeltaSeconds) override;

};

Step 7: Open SetGetActorLocation.cpp

Open SetGetActorLocation. cpp and replace the block of code.

Replacement Code: Set Pointer to Parameter

This code allows you to set a pointer to the parameter Signal Name parameter for the Simulink
blocks Simulation 3D Message Set and Simulation 3D Message Get, respectively.

// Sets default values

ASetGetActorLocation: :ASetGetActorLocation():SignalReader(nullptr), SignalWriter(nullptr)

{
}
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Replacement Code: Access Actor Tag Name

The following code allows you to access the tag name of this actor after it is instantiated in the scene
with an assigned tag name. The code also initializes the pointers SignalReader and
SignalWriter, to initiate a link between Unreal Editor and Simulink. The variables represent these
block Signal Name parameter values:

+ SignalReaderTag — Simulation 3D Message Set
* SignalWriterTag — Simulation 3D Message Get

void ASetGetActorLocation::Sim3dSetup()

{
Super::Sim3dSetup();
if (Tags.Num() !'= 0) {
unsigned int numElements = 3;
FString tagName = Tags.Top().ToString();

FString SignalReaderTag = tagName;
SignalReaderTag.Append (TEXT("Set"));
SignalReader = StartSimulation3DMessageReader(TCHAR TO ANSI(*SignalReaderTag), sizeof(float)*numElements);

FString SignalWriterTag = tagName;
SignalWriterTag.Append (TEXT("Get"));
SignalWriter = StartSimulation3DMessageWriter(TCHAR TO ANSI(*SignalWriterTag), sizeof(float)*numElements);

}
}

Additional Code: Read and Write Data During Run Time

Add this code to allow Unreal Engine to read the data value set by Simulation 3D Message Set and
then write back to Simulation 3D Message Get during run time. Unreal Engine uses this data to set
the location value of the actor.

void ASetGetActorLocation::Sim3dStep(float DeltaSeconds)

{

unsigned int numElements = 3;

float array[3];

int statusR = ReadSimulation3DMessage(SignalReader, sizeof(float)*numElements, array);

FVector NewLocation;

NewLocation.X = array[0];

NewLocation.Y = array[1];

NewLocation.Z = array[2];

SetActorLocation(NewLocation);

float fvector[3] = { NewLocation.X, NewLocation.Y, NewLocation.Z };

int statusW = WriteSimulation3DMessage(SignalWriter, sizeof(float)*numElements ,fvector);
}

Additional Code: Stop Simulation
Add this code so that Unreal Engine stops when you press the Simulink stop button. The code
destroys the pointer SignalReader and SignalWriter.
void ASetGetActorLocation::Sim3dRelease()
{

Super: :Sim3dRelease();

if (SignalReader) {

StopSimulation3DMessageReader(SignalReader);
}
SignalReader = nullptr;

if (SignalWriter) {
StopSimulation3DMessageWriter(SignalWriter);
}

SignalWriter = nullptr;
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Entire Replacement Code: SetGetActorLocation.cpp

This is the entire replacement code for SetGetActorLocation. cpp.

// Copyright 2019 The MathWorks, Inc.
#include "SetGetActorLocation.h"

// Sets default values

ASetGetActorLocation: :ASetGetActorLocation():SignalReader(nullptr), SignalWriter(nullptr)
{

}

void ASetGetActorLocation::Sim3dSetup()
{
Super: :Sim3dSetup();
if (Tags.Num() !'= 0) {
unsigned int numElements = 3;
FString tagName = Tags.Top().ToString();

FString SignalReaderTag = tagName;
SignalReaderTag.Append (TEXT("Set"));
SignalReader = StartSimulation3DMessageReader(TCHAR TO ANSI(*SignalReaderTag), sizeof(float)*numElements);

FString SignalWriterTag = tagName;
SignalWriterTag.Append (TEXT("Get"));
SignalWriter = StartSimulation3DMessageWriter(TCHAR TO ANSI(*SignalWriterTag), sizeof(float)*numElements);

}
}
void ASetGetActorLocation::Sim3dStep(float DeltaSeconds)
{
unsigned int numElements = 3;
float array[3];
int statusR = ReadSimulation3DMessage(SignalReader, sizeof(float)*numElements, array);
FVector NewLocation;
NewLocation.X = array[0];
NewLocation.Y = array[1];
NewLocation.Z = array[2];
SetActorLocation(NewLocation);
float fvector[3] = { NewLocation.X, NewLocation.Y, NewLocation.Z };
int statusW = WriteSimulation3DMessage(SignalWriter, sizeof(float)*numElements ,fvector);
}
void ASetGetActorLocation::Sim3dRelease()
{
Super: :Sim3dRelease();
if (SignalReader) {
StopSimulation3DMessageReader(SignalReader);
}
SignalReader = nullptr;
if (SignalWriter) {
StopSimulation3DMessageWriter(SignalWriter);
}
SignalWriter = nullptr;
}

Step 8: Build the Visual Studio Project and Open Unreal Editor

Press F5 on the keyboard to run the Visual Studio solution TestSim3dGetSet. The Unreal Editor
opens.

Note In the Unreal Editor, save the current level by clicking Save Current (located in the top left)
and name it TestMap. Add this level as default to Project Settings by clicking on Edit > Project
Settings > Maps&Modes. Then select TestMap as the default value for the Editor Startup Map and
Game Default Map. Close Project Settings to save the default values.

6-26



Get Started Communicating with the Unreal Engine Visualization Environment

u

'& Project Settings

Search

Project - Maps & Modes

]_' These settings aved in DefaultEngine.ini, which is currently writable

4 pefault Modes

4 pDefault Maps

Editor Startup Map

Game Default Map

4 Local Multiplayer
Use

Two Fl een Layout

S EET R
File Edit Window Help
47 Modes

_"""l-I' ‘ Y | -T. -
% ® IR

. SetGetActior Location

Step 9: Check Actor

On the World Outliner tab, check that the new instantiated actor, SetGetActorLocationl, is
listed.
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Step 10: Add Mesh
Click on the actor that you created in “Step 9: Check Actor” on page 6-27.

1 In the Details panel, click on Add Component to add a mesh to the actor SetConelLocationl.
Choose Cone as the default mesh.

2  Find the property tags for actor SetConeLocationl. Add a tag by clicking on the plus sign next
to 0 Array elements. Name it ConelLoc.

1 Details
L} SetGetActorLocation] Open SetGetActorLocation

+ Add Component ~ 25 Blueprint/Add Script

rve Source

+ @

4 Component Tags 1 Array elements e . @ |
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Step 11: Set Cone Location

On the Details tab, click Cone. Set the coneto X =0.0,Y=0.0,and Z = 0.0. Also set the actor
Mobility property to Movable.

i) Details @ World Settings

LI SetGetActorLocation] Open SetGetActorLocation

4+ Add Component - o Blueprint/Add Script

doo Rloo Hoo
goo  oRjoor  ~Roor
doo Moo Hoo N8

] Statec .'.T Slaticnar AT

4 Static Mesh

Step 12: Set Parent Class and Save Scene
Set the parent class.

1 Under Blueprints, click Open Level Blueprint, and select Class Settings.

= World outliner

2 In the Class Options, set Parent Class to Sim3dLevelScriptActor.
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4 Blueprint Options
Save the Unreal Editor scene.
Step 13: Run Simulation
Run the simulation. Go to “Run Simulation” on page 6-35.
Reference: C++ Functions for Sending and Receiving Simulink Data

Call these C++ functions from Sim3dSetup, Sim3dStep, and Sim3dRelease to send and receive
Simulink data.

To C++ Functions

Receive data StartSimulation3DMessageReader

ReadSimulation3DMessage

StopSimulation3DMessageReader

Send data StartSimulation3DMessageWriter

WriteSimulation3DMessage

StopSimulation3DMessageWriter

Blueprint Workflow: Set Up Unreal Engine to Send and Receive Data
Step 4: Configure Scenes to Receive Data

To use the Simulation 3D Message Set block, you must configure scenes in the Unreal Engine
environment to receive data from the Simulink model:

1 In the Unreal Editor, instantiate the Sim3DGet actor that corresponds to the data type you want
to receive from the Simulink model. This example shows the Unreal Editor Sim3DGet data types.
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2y Modes

gSim 2d Get Float

8im 2d Get Integer

2 Specify an actor tag name that matches the Simulation 3D Message Set block Signal name
parameter.

3 Navigate to the Level Blueprint.

Find the blueprint method for the Sim3DGet actor class based on the data type and size that you
want to receive from the Simulink model.

For example, in Unreal Editor, this diagram shows that Read Scalar Integer is the method
for Sim3DGetInteger actor class to receive int32 data type of size scalar.

_f'-ﬁad Scalar 1r_1teger

B (D

" ® sim3dGetinteger Target Data

Status

5 Compile and save the scene.
Step 5: Configure Scenes to Send Data
To configure scenes in the Unreal Engine environment to send data to the Simulink model:

1 In the Unreal Editor, instantiate the Sim3DSet actor that corresponds to the data type you want
to send to the Simulink model. This example shows the Unreal Editor Sim3DSet data types.
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5

1y Modes

PP I

. Sim 3d Set Boolean

. 8im 3d Set Float

. Sim 3d Set Integer

Specify an actor tag name that matches the Simulation 3D Message Get block Signal name
parameter.

Navigate to the Level Blueprint.
Find the blueprint method for the Sim3DSet actor class based on the data type and size specified
by the Simulation 3D Message Get block Data type and Message size parameters.

For this example, the array size is 3. The Unreal Editor diagram shows that Write Array

Float is the method for the Sim3DSetFloat3 actor class that sends float data type of array size
3.

”® sm3dSetFloat3  Write Array Float

Compile and save the scene.

Note Optionally, for better performance, set Read Array Float Max Num Elements to Num E1 in
the Actor Blueprint.
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Oy Sim3dGetFloat3
&5 ® Sim3dSetFloat3

18 actors (1 selected)

& world SEHiI'Il;IE i Details

Sim3dGetFloat3

+ Add Component ~

Search Components
_

Search Details

Mathworks Sim 3d Lib

Read Array Float Max Num Elements _

@ Sim3d0etFloat3

(_- Event BeginPlay

» I Read Array Float

£ Evemt Tick

Step 6: Create Blueprint
In the Unreal Editor, create a level blueprint connecting the Get and Set actors.
1  Set the actor tag values.

* Sim3dGetFloatl — Simulation 3D Message Set block Signal name, SigName parameter
value, for example ConeLocSet

* Sim3dSetFloatl — Simulation 3D Message Get block Signal name, SigName parameter
value, for example ConeLocGet

2 Set the parent class.

a  Under Blueprints, click Open Level Blueprint, and select Class Settings.
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Blueprints

Mew

b In the Class Options, set Parent Class to Sim3dLevelScriptActor.

..

LAEEERITOR] | Clas:

L 4

3 In the level blueprint, make the connections, for example:

& Coneloc

[ Read Vector Float

Target

[ Write Vector Float

> Event Tick
P

Step 7: Run Simulation

Run the simulation. Go to “Run Simulation” on page 6-35.
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Run Simulation

After you configure the Simulink model and Unreal Editor environment, you can run the simulation.

Note At the BeginPlay event, Simulink does not receive data from the Unreal Editor. Simulink
receives data at Tick events.

Run the simulation.

1 In the Simulink model, click Run.
Because the source of the scenes is the project opened in the Unreal Editor, the simulation does
not start.

2 Verify that the Diagnostic Viewer window in Simulink displays this message:

In the Simulation 3D Scene Configuration block, you set the scene source
to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the Unreal
Engine 3D environment.

3 Inthe Unreal Editor, click Play. The simulation runs in the scene currently open in the Unreal
Editor.

You can send and receive these data types: double, single, int8, uint8, int16, uintl6, int32,
uint32, boolean. The code in “Step 7: Open SetGetActorLocation.cpp” on page 6-24 reads single
data type values (or float values) from Simulink.

See Also
ASim3dActor | Sim3dSetup | Sim3dStep | Sim3dRelease | Simulation 3D Scene Configuration |
Simulation 3D Message Get | Simulation 3D Message Set

More About

. “Animate Custom Actors in the Unreal Editor” on page 8-23

. “Place Cameras on Actors in the Unreal Editor” on page 8-10

. “Send and Receive Double-Lane Change Scene Data” on page 3-88

External Websites
. Unreal Engine
. Unreal Engine 4 Documentation
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Prepare Custom Vehicle Mesh for the Unreal Editor

6-36

This example shows you how to create a vehicle mesh that is compatible with the project in the
Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package. You can specify
the mesh in the Simulation 3D Vehicle or Simulation 3D Vehicle with Ground Following block to
visualize the vehicle in the Unreal Editor when you run a simulation.

Before you start, install the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support
package. See “Customize 3D Scenes for Vehicle Dynamics Simulations” on page 6-3.

To create a compatible custom vehicle mesh, follow these workflow steps.

Step Description

“Step 1: Setup Bone In a 3D creation environment, setup the vehicle mesh bone hierarchy and
Hierarchy” on page 6-36 |specify part names.

“Step 2: Assign Materials” |Optionally, assign materials to the vehicle parts.
on page 6-37

“Step 3: Export Mesh and |Export the vehicle mesh and armature in .fbx file format.
Armature” on page 6-39

“Step 4: Import Mesh to  |Import the vehicle mesh into the Unreal Editor.
Unreal Editor” on page 6-

40

“Step 5: Set Block Set up the Simulation 3D Vehicle or Simulation 3D Vehicle with Ground
Parameters” on page 6- |Following block parameters.

41

Note To create the mesh, this example uses the 3D creation software Blender® Version 2.80.

Step 1: Setup Bone Hierarchy

1 Import a vehicle mesh into a 3D modeling tool, for example Blender.

2 To ensure that this mesh is compatible with the animation components in the Vehicle Dynamics
Blockset Interface for Unreal Engine 4 Projects support package, use this naming convention for
the vehicle parts in the mesh.

Vehicle Part Name

Chassis VehicleBody

Front left wheel Wheel FL

Front right wheel Wheel FR

Rear left wheel Wheel RL

Rear right wheel Wheel RR

Steering wheel Wheel Steering

Left headlight Lights Headlight Left
Right headlight Lights Headlight Right




Prepare Custom Vehicle Mesh for the Unreal Editor

Vehicle Part Name

Left indicator light Indicator L
Right indicator light Indicator R
Number plate Vehicle Plate
Brake lights Lights Brake
Reverse lights Lights Reverse
Front left brake caliper BrakeCaliper FL
Front right brake caliper BrakeCaliper FR
Rear left brake caliper BrakeCaliper RL
Rear right brake caliper BrakeCaliper RR

3  Set the vehicle body object, VehicleBody as the parent of the wheel objects and other vehicle
objects.

Step 2: Assign Materials

Optionally, assign material slots to vehicle parts. In this example, the mesh uses one material for the
chassis and one for the four wheels.
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1 Create and assign material slots to the vehicle chassis. Confirm that the first vehicle slot
corresponds to the vehicle body. For example, this image shows the hierarchy in Blender.

Body & BodyMat

BodyMat

Use Nodes

Surface Princi

face 0.000

Subsurface Radius 1.000
0.200

2 Create and assign material slots to the wheels.
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v

B, RR Wheel & Wheel

Wheel

Use Nodes

Surface Principled BSDF

0.000

Subsurface Radius 1.000
0.200

Step 3: Export Mesh and Armature

Export the mesh and armature in the .fbx file format. For example, in Blender:

1  On the Object Types pane, select Armature and Mesh.

Object Types  Empty
Camera
Lamp
Armature
Mesh
Other

Custom Properties

2 On the Transform pane, set:

* Scaleto 1.00
* Apply Scalings to A11 Local
* Forward to X Forward

6-39



6 Supporting Data

 UptoZ Up

Select Apply Unit.

¥ Transform

Scale

Apply Scalings  All Local

Forward X Forward
Up ZUp

Apply Unit &

IEXPERIMENTAL! Apply Transform
3  On the Geometry pane:
* Set Smoothing to Face
* Select Apply Modifiers
¥ Geometry
Smoothing Face
Export Subdivision Surface
Apply Modifiers &

Loose Edges

Tangent Space

4 On the Armature pane, set:

* Primary Bone Axis to X Axis
* Secondary Bone Axis to Z Axis

Select Export FBX.

¥ Armature

Primary Bone Axis

Secondary Bone Axis

Export FBX Cancel

Step 4: Import Mesh to Unreal Editor

1  Open the Unreal Engine AutoVrtlEnv.uproject project in the Unreal Editor.

2 In the editor, import the FBX® file as a skeletal mesh. Assign the Skeleton to the
SK_PassengenerVehicle Skeleton asset.
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U FBX Import Options x

Import Skeletal Mesh Reset to Default

Current Asset: /MathWorksSimulation/VehicleCommon/OldCar

4 Mesh
Skeletal Mesh |

Import Content Type Geometry and Skinning Weights. v

""_'f_h" SK_PassengerVehicle_Skeletw

:'. f 2 |

Skeleton

v

4 Animation

Step 5: Set Block Parameters

In your Simulink model, set these Simulation 3D Vehicle or Simulation 3D Vehicle with Ground
Following block parameters:

+ Type to Custom.
» Path to the path in the Unreal Engine project that contains the imported mesh.

See Also

Simulation 3D Scene Configuration | Simulation 3D Vehicle with Ground Following | Simulation 3D
Vehicle

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6

External Websites
. Blender
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Create and Use an Oval Track

You can create a oval track with RoadRunner and use it in a Vehicle Dynamics Blockset simulation
that co-simulates with Unreal. This example provides the workflow for creating the oval track that is
used in the “Follow Waypoints Around Oval Track” on page 7-38 example.

Before you start, make sure that you have the products required to follow the workflow.

Step Required Products

1 “Step 1: Create Track in RoadRunner
RoadRunner” on page 6-42

2 “Step 2: Export Track From RoadRunner

RoadRunner” on page 6-44

3 “Step 3: Import Track to Unreal EIREE) FEEID €749

Engine” on page 6-44 RoadRunner plugin

Visual Studio 2019

4 “Step 4: Co-Simulate in Vehicle Unreal Engine 4.25

Dynamics Blockset” on page 6-47
Vehicle Dynamics Blockset

Vehicle Dynamics Blockset Interface for Unreal Engine 4
Projects

Step 1: Create Track in RoadRunner
In this example, you create the oval track specified in the following figure. The locations and

reference poses are in the RoadRunner coordinate system, (X, Y, 6). The locations, X and Y, are in m.
The reference poses, 0, are in deg.

6-42



Create and Use an Oval Track

(-800,700) o

(-454.65,618.01,180°)
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(-709.3,618.01)
(-709.3,363.36,-90%)

(-709.3,-636.64,-90%)

(-709.3891.29)
L ]

(-454.65,-891.29,0°)

]
(-800,-1000)

e (100,700)

(-254.65,618.01,180°)
°
(0,618.01)

(0,363.36,90°)

& (0,0,90%)

(0,-636.64,90%)

(0,-891.29)
[ ]

(-254.65,-891.29,07)

® (100, -1000)

Legend

Green Locations of patch boundaries, X, Y

Red Intersection points of straight-line segments, X, Y
Black Track locations and reference poses, X, Y, 6

Use RoadRunner to create the oval track. For more information about creating tracks, see

Create Straight Line Segments

gua A W N =

Open the Road Plan Tool.

Navigate to Library Browser > RoadStyles. Select Residential.

Right-click to place the start and endpoints of a straight-line road.

After each straight segment, left-click and repeat the preceding step.

Selecting the road control points. Use the preceding figure to the enter coordinate information.

Create Circular Arc

1

Open the Road Plan Tool. If you are continuing from creating the straight-line segments, the
Residential road is the default road.

Right-click to place the start and endpoints of the arc. If you use this method to connect straight
lines, there might be multiple control points. Delete all but one control point.

To create a control point, right-click anywhere in the road. To position it as specified in red in the
preceding figure, left-click in each arc control point.
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4 To create the circular arc, edit the positions of the control points. If the start of a road marks the
end of another, RoadRunner connects them.

Adjust Road Width

1 Open the Lane Width Tool.

2 Select the road that needs the width adjustment.

3 To adjust the road width, select any purple or red segment.
4

Modify the lines so that the entire width of the road is 14 m, or 7 m from the road centerline to
each edge.

Create Patch

1 Open the Surface Tool.
2 Right-click to create four nodes.

3 Right-click the first node to close the loop. By default, the surface is green.
Add Trees

To provide visual cues that indicate how fast the vehicle is traveling, you can add trees.

1 Open the Prop Curve Tool.
2 Select an asset to place in the scene. For example, select Props\Trees\Eucalyptus SmO1.

3 Right-click to select the inner boundary of the trajectory. To limit the trees in the green areas,
adjust the tangents at the control points.

4 To facilitate faster import into Unreal Engine, choose an appropriate spacing that limits the
number of trees in the scene. The import time is proportional to the number of scene assets.

Step 2: Export Track From RoadRunner

1 In RoadRunner, open the scene.

2 Select File > Export > Unreal (.fbx + .xml)

3 Inthe Export Unreal dialog box, select Split by Segmentation and export folder. Click Export.
Step 3: Import Track to Unreal Engine

After exporting from RoadRunner, you import the data into Unreal Engine.

Create Empty Project

If you do not have an existing Unreal Engine project, create an empty project.

1 In Unreal Engine, select File > New Project.

2 Create a project. For example, select the Games template category. Click Next.
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U
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Architecture, Engineering, and C

: Automotive, Product Design, and Manuf:
= l:": Find ternplates for multi- user esign reviews

3 Select a Blank template. Click Next.

Create Project

Acquire and Rebuild RoadRunner Plugins

1 Download the RoadRunner plugin. For more information, see “Downloading Plugins”
(RoadRunner).
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2  Extract the RoadRunner plugin . zip file. Locate the RoadRunnerImporter and
RoadRunnerMaterials folders under the Unreal Engine plugins.

Note The Unreal Engine plugin folder also contains a RoadRunnerCarla integration plugin. If
you are not using CARLA, do not copy this folder.

3 Copy the RoadRunnerImporter and RoadRunnerMaterials folders into the Plugins folder
under the project folder. If a Plugins folder does not exist, create one.

Config
Content
Intermedeate
Pluging
Saved
& packa geTest uproject

4 Use aor b to rebuild the plugin.
a Generate the project files.

* Windows® - Right-click the .uproject file and select Generate Visual Studio project
files.

+ Linux® - Set environment variable UE4 ROOT to your Unreal Engine installation folder. At
the command line, run this code:

$UE4 ROOT/GenerateProjectFiles.sh -project="<Path to .uproject file>" -game -engine
b  Open the project. Select Yes to build the plugins.

If both a and b fail, try using Visual Studio to build the binaries.

5 Verify that the RoadRunner and MathWorks Interface plugins are enabled. Select Edit >
Plugins. Confirm that Enabled is selected.

Import to Unreal Engine

1 In the Unreal Editor, click Import. Select the . fbx file from Step 2.

Note Selecting File > Import Into Level does not use the exported RoadRunner xml. Instead,
it uses the Unreal importer.

Use the default options in the RoadRunner Import Options Dialog Box. Click Import.
Under the Scene tab, select Import as Dynamic. This enables translation of the whole scene.

Under Static Meshes, clear Remove Degenerates. Set Normal Input Method as Input
Normals. Click Import. The import can take up to 1 hour to complete.

5 In the World Outliner, select the scene that you imported, for example
FbxScene OvalTrackl. To align the RoadRunner and Unreal coordinate systems, enter a 90°
rotation about the Z-axis.
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Optionally, consider using the editor to add terrain and foliage in the scene.

Save the project (.uproject) file. Close the Unreal Editor.

Step 4: Co-Simulate in Vehicle Dynamics Blockset

1
2

Open the Simulink model. Do not open the Unreal Editor.

At the command-line, run these commands:

sim3d.Engine.stop
sim3d.Engine.start

Open the Simulation 3D Scene Configuration block.

d

Set Scene source to Unreal Editor.

Set Project to the project (.uproject) file that you saved in “Step 3: Import Track to
Unreal Engine” on page 6-44.

Click Apply.
Click Open Unreal Editor.

The project opens in the Unreal Editor.

Select Blueprints > Open Level Blueprint.

In the level blueprint:

a
b

(o]

d

e

Select File > Reparent Blueprint.
Select Sim3dLevelScriptActor.
Click Save.

Close the level blueprint.

In the editor, click Save Current.

This ensures that the vehicle identifies the ground properly during co-simulation.

Run the simulation.

In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

Verify that the Diagnostic Viewer window in Simulink displays this message:
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6-48

In the Simulation 3D Scene Configuration block, you set the scene
source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the
scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

¢ In the Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

See Also
Simulation 3D Scene Configuration

Related Examples
. “Follow Waypoints Around Oval Track” on page 7-38

More About
. “Use RoadRunner Scenes in MATLAB and Simulink” (RoadRunner)
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Vehicle Dynamics Blockset Examples

Scene Interrogation with Camera and Ray Tracing Reference
Application

Interrogate a 3D scene with a vehicle dynamics model by using a camera and ray tracing reference
application project.

To create or modify other scenes, you need the Vehicle Dynamics Blockset Interface for Unreal
Engine 4 Projects support package. For more information, see “Customize 3D Scenes for Vehicle
Dynamics Simulations” on page 6-3.

For the minimum hardware required to run the example, see “Unreal Engine Simulation Environment
Requirements and Limitations” on page 8-6.

For more information about the reference application, see “Scene Interrogation in 3D Environment”

on page 3-32.
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See Also

Simulation 3D Vehicle with Ground Following | Simulation 3D Camera Get | Simulation 3D Actor
Transform Get | Simulation 3D Scene Configuration | Vehicle Body 3DOF

More About

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8



Scene Interrogation with Camera and Ray Tracing Reference Application

External Websites
. Unreal Engine


https://www.unrealengine.com/en-US/unreal
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Braking Test Reference Application

Simulate a full vehicle dynamics model undergoing a braking test, including a split-mu test. You can
create your own versions, establishing a framework to test that your vehicle meets the design
requirements under normal and extreme driving conditions. Use this reference application in ride and
handling studies and chassis controls development to characterize the vehicle dynamics during a
braking test. For information about this and similar maneuvers, see standards SAE J299 200901 and
ISO 21994:2007.

For more information about the reference application, see “Braking Test” on page 3-11.
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References

[11]299 200901. Stopping Distance Test Procedure. Warrendale, PA: SAE International, 2009.

[2]1 ISO 21994:2007. Passenger cars — Stopping distance at straight-line braking with ABS — Open-
loop test method. Geneva: ISO, 2007.

[3]1ISO 14512:1999. Passenger cars — Straight-ahead braking on surfaces with split coefficient of
friction -- Open-loop test procedure. Geneva: ISO, 2007.

See Also
3D Engine | Road Track Friction | Straight Maneuver Reference Generator

More About
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
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Simulation Data Inspector
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Longitudinal Motorcycle Braking Test Reference Application

Simulate an in-plane motorcycle undergoing a braking test. You can create your own versions,
establishing a framework to test that your motorcycle meets the design requirements under normal
and extreme driving conditions. Use this reference application in ride and handling studies and
chassis controls development to characterize the vehicle dynamics of a motorcycle during a braking
test.

For more information about the reference application, see “Longitudinal Motorcycle Braking Test” on
page 3-4.
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Longitudinal Motorcycle Braking Test Reference Application
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More About
. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. Simulation Data Inspector



Double Lane Change Reference Application

Double Lane Change Reference Application

Simulate a full vehicle dynamics model undergoing a double-lane change maneuver according to
standard ISO 3888-2. You can create your own versions, establishing a framework to test that your
vehicle meets the design requirements under normal and extreme driving conditions. Use the
reference application for vehicle dynamics ride and handling analysis and chassis controls
development, including yaw stability and lateral acceleration limits.

For more information about the reference application, see “Double-Lane Change Maneuver” on page
3-21.
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References

[1]1ISO 3888-2: 2011. Passenger cars — Test track for a severe lane-change manoeuvre.

See Also
Predictive Driver | Mapped SI Engine | Vehicle Terrain Sensor | 3D Engine

Related Examples
. “Send and Receive Double-Lane Change Scene Data” on page 3-88
. “Yaw Stability on Varying Road Surfaces” on page 1-16

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector
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Swept-Sine Steering Reference Application

Simulate a full vehicle dynamics model undergoing a swept-sine steering maneuver. You can create
your own versions, providing a framework to test that your vehicle meets the design requirements
under normal and extreme driving conditions. Use the reference application for vehicle dynamics ride
and handling analysis and chassis controls development, including the dynamic steering response.

For more information about the reference application, see “Swept-Sine Steering Maneuver” on page
3-39.
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See Also
Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor | 3D Engine

Related Examples
. “Frequency Response to Steering Angle Input” on page 1-47

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector



Increasing Steering Reference Application

Increasing Steering Reference Application

Simulate a full vehicle dynamics model undergoing a slowly increasing steering maneuver according
to standard SAE ]J266. You can create your own versions, establishing a framework to test that your
vehicle meets the design requirements under normal and extreme driving conditions. Use the

reference application for lateral vehicle dynamics ride and handling analysis and chassis controls

development, including the steering response.

For more information about the reference application, see “Slowly Increasing Steering Maneuver” on
page 3-50.
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[1] SAE ]J266. Steady-State Directional Control Test Procedures For Passenger Cars and Light Trucks.

Warrendale, PA: SAE International, 1996.

See Also

Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor | 3D Engine

Related Examples
“Vehicle Steering Gain at Different Speeds” on page 1-27

More About

“Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

Simulation Data Inspector
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Constant Radius Reference Application

Simulate a full vehicle dynamics model undergoing a constant radius maneuver. You can create your
own versions, providing a framework to test that your vehicle meets the design requirements under
normal and extreme driving conditions. Use the reference application for vehicle dynamics ride and
handling analysis and chassis controls development, including the dynamic steering response.

For more information about the reference application, see “Constant Radius Maneuver” on page 3-61.
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[11]J266 199601. Steady-State Directional Control Test Procedures for Passenger Cars and Light
Trucks. Warrendale, PA: SAE International, 1996.

[2]1 ISO 4138:2012. Passenger cars — Steady-state circular driving behaviour — Open-loop test
methods. Geneva: I1SO, 2012.

See Also
3D Engine | Driver Commands | Reference Generator

Related Examples

. “Vehicle Lateral Acceleration at Different Speeds” on page 1-37
More About
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
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Simulation Data Inspector

7-13



7 Vehicle Dynamics Blockset Examples

Kinematics and Compliance Virtual Test Laboratory Reference
Application
Generate optimized suspension parameters for the vehicle dynamics mapped suspension blocks.

Generate Mapped Suspension from Spreadsheet Data uses Model-Based Calibration Toolbox™
to generate calibrated suspension parameters from measured vertical force and suspension geometry
data.

Generate Mapped Suspension from Simscape Suspension uses a Simscape™ Multibody™
suspension system to generate calibrated suspension parameters for the mapped suspension blocks.

Compare Mapped and Simscape Suspension Responses compares the mapped suspension with
the Simscape Multibody suspension results.

For more information about the reference application, see “Kinematics and Compliance Virtual Test
Laboratory” on page 3-71.
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See Also
Independent Suspension - Mapped | Solid Axle Suspension - Mapped
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More About

. Simulation Data Inspector

7-15



7 Vehicle Dynamics Blockset Examples

Three-Axle Tractor Towing a Three-Axle Trailer

This example shows how to use a three degrees-of-freedom (DOF) hitch to tow a three-axle trailer
with a three-axle tractor. To steer and drive the tractor, the model uses a sinusoidal wave steering
input and an axle torque applied to the rear wheels.

To view the simulation in the 3D visualization environment, use the Vehicle Monitor 3D variant. Right-
click the Vehicle Monitor block and select Variant > Label Mode Active Choice > Vehicle Monitor
3D. See Run Simulation in 3D Visualization Environment.

To implement the tractor and trailer, by default, the three DOF model uses the Vehicle Body 3DOF
and Trailer Body 3DOF blocks. You can use the Toggle Between 3DOF and 6DOF button to
configure a six DOF model that uses the Vehicle Body 6 DOF block, Trailer Body 6DOF block, and a
6DOF hitch subsystem. See Six Degrees-of-Freedom Model.

Model
Three-Axle Tractor Towing Three-Axle Trailer
sm

7-16

Run Simulation

On the Simulation tab, click Run. As the simulation runs, the Vehicle Position window provides the
trace of the tractor and trailer.



Three-Axle Tractor Towing a Three-Axle Trailer
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Three-Axle Tractor Subsystem

To steer and drive the tractor, the three-axle tractor subsystem uses a sinusoidal wave steering input
and an axle torque applied to the rear wheels. The subsystem includes models for the wheels,
suspension, and vehicle body.

7-17



7 Vehicle Dynamics Blockset Examples
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Three-Axle Trailer Subsystem

The three-axle trailer subsystem includes models for the wheels, suspension, and the trailer body.
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When you select the three DOF model variant, the hitch model allows relative longitudinal, lateral,
and yaw motion between the tractor and trailer. To limit the longitudinal and lateral motion, the hitch
model implements a stiff translational spring-damper in the xy plane of the vehicle-fixed reference

frame. The resulting spring-damper forces approximately limits the relative motion between the

tractor and trailer to yaw rotation about a vertical axis at the hitch connection point. The hitch model
transfers the vertical hitch force from the trailer to the tractor.

When you select the six DOF model variant, the hitch model allows relative longitudinal, lateral,
vertical, and yaw motion between the tractor and trailer. The hitch model implements another
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Three-Axle Tractor Towing a Three-Axle Trailer

translational spring-damper along the z -axis of the vehicle-fixed reference frame. The effects of hitch
moments due to the relative rotations of the hitches are considered negligible.

» Spring forces are linear functions of the planar distance from the tractor hitch location to the first

trailer front hitch location in the inertial reference frame.

» Damper forces are linear functions of the planar velocity from the tractor hitch location to the first

trailer front hitch location in the inertial reference frame.
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Run Simulation in 3D Visualization Environment

In the Vehicle Monitor subsystem, use the Vehicle Monitor 3D variant to visualize the tractor and
trailer in the 3D simulation environment.

1 Right-click the Vehicle Monitor block and select Variant > Label Mode Active Choice >
Vehicle Monitor 3D.

Variant 3 Open » |
— Mask 3 Label Mode Active Choice  » Vehicle Monitor 2D (Vehicle Monitor 2D)
Library Link Open in Variant Manager . Vehicle Monitor 3D (Vehicle Monitor 3D)
3
=i Signals & Ports L4
- L_ r:f Requirements »
_*| =1 ahicle
) Coverage 4
_,-""f Traiker )
= s Madel Advisor 4

2. Click Run. In the AutoVrtlEnv window, view the tractor and trailer in the 3D visualization
environment. You can use the key numbers to change camera views of the tractor and trailer. For
example, press 7 for a front left camera view.

Six Degrees-of-Freedom Model

To implement a 6 DOF tractor, trailerc and hitch model, click Toggle Between 3DOF and 6DOF.
Then, on the Simulation tab, click Run.
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Three-Axle Tractor Towing Three-Axle Trailer
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To view the simulation in the 3D visualization environment, use the Vehicle Monitor 3D variant.

See Also
Trailer Body 3DOF | Trailer Body 6DOF | Vehicle Body 3DOF | Vehicle Body 6DOF

More About

. “Two-Axle Tractor Towing a One-Axle Trailer” on page 7-33
. “Two-Axle Tractor Towing a Two-Axle Trailer” on page 7-28
. “Three-Axle Tractor Towing Two Three-Axle Trailers” on page 7-22
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Three-Axle Tractor Towing Two Three-Axle Trailers

This example shows how to use a three degrees-of-freedom (DOF) hitch to tow two three-axle trailers
with a three-axle tractor. To steer and drive the tractor, the model uses a sinusoidal wave steering
input and an axle torque applied to the rear wheels.

To view the simulation in the 3D visualization environment, use the Vehicle Monitor 3D variant. Right-
click the Vehicle Monitor block and select Variant > Label Mode Active Choice > Vehicle Monitor
3D. See Run Simulation in 3D Visualization Environment.

To implement the tractor and trailers, by default, the three DOF model uses the Vehicle Body 3DOF
and Trailer Body 3DOF blocks. You can use the Toggle Between 3DOF and 6DOF button to
configure a six DOF model that uses the Vehicle Body 6 DOF block, Trailer Body 6DOF blocks, and a
6DOF hitch subsystem. See Six Degrees-of-Freedom Model.

Model

Three-Axle Tractor Towing Two Three-Axle Trailers
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Run Simulation

On the Simulation tab, click Run. As the simulation runs, the Vehicle Position window provides the
trace of the tractor and trailer.
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Three-Axle Tractor Subsystem

To steer and drive the tractor, the three-axle tractor subsystem uses a sinusoidal wave steering input
and an axle torque applied to the rear wheels. The subsystem includes models for the wheels,
suspension, and vehicle body.
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Three-Axle Trailer Subsystems

The three-axle trailer subsystems include models for the wheels, suspension, and the trailer body.
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When you select the three DOF model variant, the hitch models allows relative longitudinal, lateral,
and yaw motion between the tractor and trailer. To limit the longitudinal and lateral motion, the hitch
model implements a stiff translational spring-damper in the xy plane of the vehicle-fixed reference

frame. The resulting spring-damper forces approximately limits the relative motion between the

tractor and trailer to yaw rotation about a vertical axis at the hitch connection point. The hitch model
transfers the vertical hitch force from the trailer to the tractor.

When you select the six DOF model variant, the hitch model allows relative longitudinal, lateral,
vertical, and yaw motion between the tractor and trailer. The hitch model implements another
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translational spring-damper along the z -axis of the vehicle-fixed reference frame. The effects of hitch
moments due to the relative rotations of the hitches are considered negligible.

» Spring forces are linear functions of the planar distance from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.

» Damper forces are linear functions of the planar velocity from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.
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Three-Axle Dolly Subsystem

The three-axle dolly subsystem includes models for the wheels and suspension. To implement the

dolly, the subsystem uses a Trailer Body block. If you enable the 3D environment, the model uses the
Simulation 3D Dolly block to visualize the dolly.
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Run Simulation in 3D Visualization Environment

In the Vehicle Monitor subsystem, use the Vehicle Monitor 3D variant to visualize the tractor and

trailer in the 3D simulation environment.

1 Right-click the Vehicle Monitor block and select Variant > Label Mode Active Choice >

Vehicle Monitor 3D.
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2. Click Run. In the AutoVrtlEnv window, view the tractor and trailer in the 3D visualization
environment. You can use the key numbers to change camera views of the tractor and trailer. For
example, press 7 for a front left camera view.
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Six Degrees-of-Freedom Model

To implement a 6 DOF tractor, trailers, and hitch model, click Toggle Between 3DOF and 6DOF.
Then, on the Simulation tab, click Run.

To view the simulation in the 3D visualization environment, use the Vehicle Monitor 3D variant.

See Also

Trailer Body 3DOF | Trailer Body 6DOF | Vehicle Body 3DOF | Vehicle Body 6DOF | Simulation 3D
Dolly

More About

. “Two-Axle Tractor Towing a One-Axle Trailer” on page 7-33
. “Two-Axle Tractor Towing a Two-Axle Trailer” on page 7-28
. “Three-Axle Tractor Towing a Three-Axle Trailer” on page 7-16
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Two-Axle Tractor Towing a Two-Axle Trailer

This example shows how to use a hitch to tow a two-axle trailer with a two-axle tractor. To steer and
drive the tractor, the model uses a sinusoidal wave steering input and an axle torque applied to the
rear wheels of the tractor.

To implement the tractor and trailer, by default, the three degrees-of-freedom (DOF) model uses the
Vehicle Body 3DOF and Trailer Body 3DOF blocks. You can use the Toggle Between 3DOF and
6DOF button to configure a six DOF model that uses the Vehicle Body 6 DOF block, Trailer Body
6DOF block, and a hitch subsystem. See Six Degrees-of-Freedom Model.
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Run Simulation

On the Simulation tab, click Run. As the simulation runs, the Vehicle Position window provides the
trace of the tractor and trailer.
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Two-Axle Vehicle Subsystem

To steer and drive the tractor, the two-axle tractor subsystem uses a sinusoidal wave steering input
and an axle torque applied to the rear wheels of the tractor. The subsystem includes models for the
tires, wheels, suspension, and vehicle body.
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Two-Axle Trailer Subsystem

The two-axle trailer subsystem includes models for the wheels, suspension, and the trailer body.
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Hitch Subsystem

When you select the three DOF model variant, the hitch model allows relative longitudinal, lateral,
and yaw motion between the tractor and trailer. To limit the longitudinal and lateral motion, the hitch
model implements a stiff translational spring-damper in the xy plane of the vehicle-fixed reference
frame. The resulting spring-damper forces approximately limits the relative motion between the
tractor and trailer to yaw rotation about a vertical axis at the hitch connection point. The hitch model
transfers the vertical hitch force from the trailer to the tractor.

When you select the six DOF model variant, the hitch model allows relative longitudinal, lateral,
vertical, and yaw motion between the tractor and trailer. The hitch model implements another
translational spring-damper along the z -axis of the vehicle-fixed reference frame. The effects of hitch
moments due to the relative rotations of the hitches are considered negligible.

» Spring forces are linear functions of the planar distance from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.

» Damper forces are linear functions of the planar velocity from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.
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Six Degrees-of-Freedom Model

To implement a six DOF tractor, trailer, and hitch model, click Toggle Between 3DOF and 6DOF.
Then, on the Simulation tab, click Run.
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Two-Axle Vehicle Towing Two-Axle Trailer
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See Also
Trailer Body 3DOF | Trailer Body 6DOF | Vehicle Body 3DOF | Vehicle Body 6DOF

More About

. “Two-Axle Tractor Towing a One-Axle Trailer” on page 7-33
. “Three-Axle Tractor Towing a Three-Axle Trailer” on page 7-16
. “Three-Axle Tractor Towing Two Three-Axle Trailers” on page 7-22
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Two-Axle Tractor Towing a One-Axle Trailer

This example shows how to use a hitch to tow a one-axle trailer with a two-axle tractor. To steer and
drive the tractor, the model uses a sinusoidal wave steering input and an axle torque applied to the
rear wheels of the tractor.

To implement the tractor and trailer, by default, the three degrees-of-freedom (DOF) model uses the
Vehicle Body 3DOF and Trailer Body 3DOF blocks. You can use the Toggle Between 3DOF and
6DOF button to configure a six DOF model that uses the Vehicle Body 6 DOF block, Trailer Body
6DOF block, and a hitch subsystem. See Six Degrees-of-Freedom Model.
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Run Simulation

On the Simulation tab, click Run. As the simulation runs, the Vehicle Position window provides the
trace of the tractor and trailer.
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Two-Axle Vehicle Subsystem

To steer and drive the tractor, the two-axle tractor subsystem uses a sinusoidal wave steering input

and an axle torque applied to the rear wheels of the tractor. The subsystem includes models for the
tires, wheels, suspension, and vehicle body.
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One-Axle Trailer Subsystem

The one-axle trailer subsystem includes models for the wheels, suspension, and the trailer body.
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Hitch Subsystem

When you select the three DOF model variant, the hitch model allows relative longitudinal, lateral,
and yaw motion between the tractor and trailer. To limit the longitudinal and lateral motion, the hitch
model implements a stiff translational spring-damper in the xy plane of the vehicle-fixed reference
frame. The resulting spring-damper forces approximately limits the relative motion between the
tractor and trailer to yaw rotation about a vertical axis at the hitch connection point. The hitch model
transfers the vertical hitch force from the trailer to the tractor.

When you select the six DOF model variant, the hitch model allows relative longitudinal, lateral,
vertical, and yaw motion between the tractor and trailer. The hitch model implements another
translational spring-damper along the z -axis of the vehicle-fixed reference frame. The effects of hitch
moments due to the relative rotations of the hitches are considered negligible.

» Spring forces are linear functions of the planar distance from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.

» Damper forces are linear functions of the planar velocity from the tractor hitch location to the first
trailer front hitch location in the inertial reference frame.
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Six Degrees-of-Freedom Model

To implement a six DOF tractor, trailer, and hitch model, click Toggle Between 3DOF and 6DOF.
Then, on the Simulation tab, click Run.
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See Also
Trailer Body 3DOF | Trailer Body 6DOF | Vehicle Body 3DOF | Vehicle Body 6DOF

More About

. “Two-Axle Tractor Towing a Two-Axle Trailer” on page 7-28

. “Three-Axle Tractor Towing a Three-Axle Trailer” on page 7-16

. “Three-Axle Tractor Towing Two Three-Axle Trailers” on page 7-22
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Follow Waypoints Around Oval Track

This example simulates a 3 degree-of-freedom (DOF) vehicle driving around an oval track that is
specified by waypoints. The model loads a minimum number of waypoints and uses a MATLAB®
function to determine the next heading waypoint.

To create your own track and use it Unreal®, you can use RoadRunner and a RoadRunner plugin. To
simulate a vehicle on the track in Unreal, you need the Vehicle Dynamics Blockset™ Interface for
Unreal Engine® 4 Projects support package. For more information, see “Create and Use an Oval
Track” on page 6-42.
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Load Waypoints
On the model canvas, click Load Waypeoints to load a minimum number of waypoints and

corresponding reference poses. This action loads waypoints that specify an oval track like the Indy
500® racing track.
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Follow Waypoints Around Oval Track

The waypoints are specified as the X and Y locations in the Z -down vehicle coordinate system, in m.
The reference poses are specified in deg.

Loading the waypoints also creates equally spaced intermediate waypoints and reference poses for
the straight-line and circular portions of the track.

Run Simulation

On the Simulation tab, click Run. As the simulation runs, the Vehicle Position window provides the
trace of the vehicle as it moves around the track.
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Oval Track Reference

The Oval Track Reference block includes a MATLAB® Function block that determines the next
heading waypoint based on the current vehicle position and pose. The reference block then provides
the vehicle commands to the driver block.
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See Also
Predictive Driver | MATLAB Function | Vehicle Body 3DOF
More About
. “Create and Use an Oval Track” on page 6-42
. “Install Support Package and Configure Environment” on page 6-5

. “Export to Unreal Using Filmbox (.fbx) File” (RoadRunner)

. “RoadRunner”
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Read and Write Block Parameters to Excel

If you manage model data in external files, you can use scripts to pass the data between the data file
and a Simulink® model. This example shows you how to read block parameter data from and write
parameter data to an Excel® data file. Specifically, the example provides functions that read and
write Mapped SI Engine parameter data. You can adapt the functions to read and write parameters
for additional blocks.

Open Mapped Sl Engine Block

Open the Mapped SI Engine block in the double-lane change reference application.
Open the Double-Lane Change Reference Application

workDir = pwd;

vdynblksDblLaneChangeStart;
cd(workDir);

Set a variable equal to the block path.
bp = 'SiMappedEngineV/Mapped SI Engine'; % block path
Open Mapped SI Engine Block

In the DLCReferenceApplication model, navigate to Passenger Vehicle > Ideal Mapped
Engine > SiMappedEngineV. Open the Mapped SI Engine block. The Breakpoints for
commanded torque, Breakpoints for engine speed input, Number of cylinders, Crank
revolutions per power stroke, and Total displaced volume parameters are set to workspace
variables.

Breakpoints for commanded torque input, f_thrake_t_bpt [Nm): |f_tbrake_t_bpt

Breakpoints for engine speed input, f_thrake_n_bpt [rpm]: | f_tbrake_n_bpt

Engine Characteristics
Number of cylinders, NCyl [J: | NCyl
Crank revolutions per power stroke, Cps []: | Cps

Total displaced volume, Wd [m~3]: |vd
The functions in the example overwrite the workspace variables with the values in the data file.

Specify Data File Configuration

First, specify the file name. This example file SiEngineData.x1sx contains three sheets. The first
sheet contains scalar values for commanded torque breakpoints, breakpoints for engine speed input
breakpoints, number of cylinders, crank revolutions, and total displaced volume. The second sheet
contains a table values for the brake torque map. The third sheet contains table values for the fuel
torque map.

fileName = 'SiEngineData.xlsx';

Note that the first sheet in the file specifies the Number of cylinders, Ncyl parameter as 6.
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Next, define the configuration data for the engine subsystem. This example sets a configuration for
double variables of size scalar, vector, or a 2D array.

* Scalar data structure specifies the data on the first sheet.

* Vector data structure specifies the data on the second sheet.

* Array data structure specifies the data on the third sheet.

engData = struct(); % engine parameter data

% Scalar data

engData.Ncyl = struct('xlSheet', 'Main', 'x1lRange','C7:C7', 's1BlockPath',bp, 'slBlockParam', 'Ncy
engData.Cps = struct('xlSheet', 'Main', 'xlRange','C8:C8', 'slBlockPath',bp, 'slBlockParam', 'Cps'
engData.Vd = struct('xlSheet', 'Main', 'x1lRange','C9:C9', 'slBlockPath',bp, 'slBlockParam','Vd');

% Vector data
engData.t bpt
engData.n bpt

struct('xlSheet', 'Main', 'x1lRange','C3:R3', 'slBlockPath',bp, 'slBlockParam','f
struct('xlSheet', 'Main', 'x1lRange','C4:R4', 'slBlockPath',bp, 'slBlockParam','f

% 2D array data
engData.torque = struct('xlSheet', 'Brake Torque', 'xlRange', 'B2:Q17', 'slBlockPath',bp, 'slBlockl
engData.fuel = struct('xlSheet', 'Fuel Map', 'xlRange', 'B2:Q17', 's1BlockPath',bp, 'slBlockParam'

Read Mapped SI Engine Block Parameters

Update the Mapped SI Engine block to the values specified in the data file.

Read Data File and Update Parameters

Use this code to read the data file and update the Mapped SI Engine block parameters.

f = fields(engData);
for idx = 1l:length(f)
try
var = getfield(engData, f{idx});
% read value from Excel
val = readmatrix(fileName, 'Sheet',var.xlSheet, 'Range',var.xlRange);
% open Simulink model
mdl = fileparts(var.slBlockPath);
open_system(mdl);
% set parameter value and save model
set param(var.slBlockPath, var.slBlockParam, mat2str(val));
save_system(mdl);
catch ME
% return any error info



Read and Write Block Parameters to Excel

disp(getReport(ME, 'extended', 'hyperlinks', 'on'))
fprintf('\nContinuing to next variable...\n\n');
end
end
fprintf('Done writing values to Simulink\n')

Done writing values to Simulink

Open Mapped Sl Engine Block

In the DLCReferenceApplication model, navigate to Passenger Vehicle > Ideal Mapped
Engine > SiMappedEngineV. Open the Mapped SI Engine block. The Breakpoints for
commanded torque, Breakpoints for engine speed input, Number of cylinders, Crank
revolutions per power stroke, and Total displaced volume parameters are set to the values
specified in the data file. Confirm that the Brake torque map and Fuel flow map parameters are
the same as the values specified in the data file.

Breakpolnts for commanded torgue input, f_tbrake_t_bpt [Nm]: 21 262.14 281.07 300] | &
Breakpoints for engine speed input, f_tbrake_n_bpt [rpm]: 6.3 3755.8 4015.4 4274.9] |

Engine Characteristics
Number of cylinders, NCyl []: |6
Crank revolutions per power stroke, Cps | |: .2

Total displaced volume, Vd [m~3]: -D.DG359‘}9‘98939 17068

Write Modified Parameters to Data File

In the Mapped SI Engine block, change the Number of cylinders, NCyl parameter from 6 to 8.
Click Apply. Save the model.

Breakpoints for commanded torque input, f_tbrake_t_bpt [Nm]: 21 262.14 281.07 300] |
Breakpoints for engine speed input, f_tbrake_n_bpt [rpm]: §6.3 3755.8 4015.4 4274.9] |

Engine Characteristics

Number of cylinders, NCyl []: |8 E

Crank revolutions per power stroke, Cps []: :2

Tatal displaced volume, Wd [m~3]: |0.003599998593917068

Alternatively, use this code to update the parameter and save the model.

set param(bp, ‘Ncyl','8");
save_system('SiMappedEngineV"');

Write Parameter Data to File
Create a copy of the data file. Write the modified parameter data to the copy of the data file.

copyfile('SiEngineData.xlsx"', 'SiEngineDataCopy.xlsx','f");
fileName = 'SiEngineDataCopy.xlsx";
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Next, use this code to write the Mapped SI Engine block Breakpoints for commanded torque,
Breakpoints for engine speed input, Number of cylinders, Crank revolutions per power
stroke, Total displaced volume, Brake torque map, and Fuel flow map parameters to the data
file.

% Read data from Simulink model then write to Excel
f = fields(engData);
for idx = 1l:length(f)
try
var = getfield(engData, f{idx});
% open Simulink model
mdl = fileparts(var.s1lBlockPath);
open_system(mdl);
% read value from Simulink
val = str2num(get param(var.slBlockPath, var.slBlockParam));
% write value to Excel
writematrix(val, fileName, 'Sheet',var.x1Sheet, 'Range',var.xlRange);
catch ME
% return any error info
disp(getReport(ME, 'extended', 'hyperlinks', 'on'))
fprintf('\nContinuing to next variable...\n\n'");
end
end
fprintf('Done writing values to Excel\n'")

Done writing values to Excel

Open the file with the modified data. Confirm that the number of cylinders in the data file is 8.

SiEngineDataCopy.xisx

A B C
MappedSIEngineBlock VarName2 VarName3 V:
Text * Text *MNumber TML
1 |Mapped & k
2|Ir on Faramete (=
3 |Breakpoin 0]
4 |Brea nts for engine speed input e n_bpt |rpm 0
5 ! !
6 E e Cha 1
8| Crank f 2
9| Tota aced vo e,Vd m*3 | 0.0036
See Also

Mapped SI Engine

Related Examples

. “Double Lane Change Reference Application” on page 7-9
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3D Simulation for Vehicle Dynamics Blockset

Vehicle Dynamics Blockset provides a co-simulation framework that models driving algorithms in
Simulink and visualizes their performance in a 3D environment. This 3D simulation environment uses
the Unreal Engine from Epic Games.

Ul

EREREY
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Simulink blocks related to the 3D simulation environment can be found in the Vehicle Dynamics
Blockset > Vehicle Scenarios > Sim3D block library. These blocks provide the ability to:

* Configure prebuilt scenes in the 3D simulation environment.

* Place and move vehicles within these scenes.

» Set up cameras the vehicles.

* Simulate camera outputs based on the environment around the vehicle.

This simulation tool is commonly used to supplement real data when developing, testing, and
verifying the vehicle performance of automated driving algorithms. In conjunction with a vehicle
model, you can use these blocks to perform realistic closed-loop simulations that encompass the
entire automated driving stack, from perception to control.

For more details on the simulation environment, see “How 3D Simulation for Vehicle Dynamics
Blockset Works” on page 8-8.

3D Simulation Blocks
Scenes

To configure a model to co-simulate with the 3D simulation environment, add a Simulation 3D Scene
Configuration block to the model. Using this block, you can choose from a set of prebuilt 3D scenes
where you can test and visualize your vehicle performance. The following image is from the Virtual
Mcity scene.



3D Simulation for Vehicle Dynamics Blockset

The toolbox includes these scenes.

Scene Description

Straight Road Straight road segment

Curved Road Curved, looped road

Parking Lot Empty parking lot

Double Lane Change Straight road with barrels and traffic signs that
are set up for executing a double lane change
maneuver

Open Surface Flat, black pavement surface with no road objects

US City Block City block with intersections, barriers, and traffic
lights

US Highway Highway with cones, barriers, traffic lights, and
traffic signs

Large Parking Lot Parking lot with parked cars, cones, curbs, and
traffic signs

Virtual Mcity City environment that represents the University
of Michigan proving grounds (see Mcity Test
Facility); includes cones, barriers, an animal,
traffic lights, and traffic signs

If you have the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package,
then you can modify these scenes or create new ones. For more details, see “Customize 3D Scenes for
Vehicle Dynamics Simulations” on page 6-3.
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Vehicles, Tractors, and Trailers

To define a virtual vehicle in a scene, add a Simulation 3D Vehicle with Ground Following, Simulation
3D Vehicle, Simulation 3D Tractor, or Simulation 3D Trailer block to your model. Using the blocks,
you can control the movement of the vehicle by supplying the X, Y, and yaw values that define its
position and orientation at each time step.

You can also specify the color and type of vehicle. The toolbox includes these vehicle types:

* Box Truck

* Hatchback

* Muscle Car

* Sedan

* Small Pickup Truck

* Sport Utility Vehicle
* Conventional Tractor
* Two-Axle Trailer

* Three-Axle Trailer

Communication

You can define virtual sensors and attach them at various positions on the vehicles. The toolbox
includes these sensor modeling and configuration blocks.

Block Description

Simulation 3D Camera Get Provides an interface to an ideal camera in the
3D visualization environment. The image output
is a red, green, and blue (RGB) array.

Simulation 3D Actor Transform Get Gets the actor translation, rotation, and scale for
the Simulink simulation environment.

Simulation 3D Actor Transform Set Sets the actor translation, rotation, and scale in
the Unreal Engine 3D visualization environment

Simulation 3D Message Get Retrieves data from the Unreal Engine 3D
visualization environment.

Simulation 3D Message Set Sends data to the Unreal Engine 3D visualization
environment.

Algorithm Testing and Visualization

Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects 3D simulation blocks provide the
tools for testing and visualizing path planning, vehicle control, and perception algorithms.

Closed-Loop Systems

After you design and test a perception system within the 3D simulation environment, you can then
use it to drive a control system that actually steers a vehicle. In this case, rather than manually set up
a trajectory, the vehicle uses the perception system to drive itself. By combining perception and
control into a closed-loop system in the 3D simulation environment, you can develop and test more
complex algorithms, such as lane keeping assist and adaptive cruise control.
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See Also

More About

. “Get Started Communicating with the Unreal Engine Visualization Environment” on page 6-20
. “How 3D Simulation for Vehicle Dynamics Blockset Works” on page 8-8
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Unreal Engine Simulation Environment Requirements and
Limitations

Vehicle Dynamics Blockset provides an interface to a simulation environment that is visualized using
the Unreal Engine from Epic Games. This visualization engine comes installed with the toolbox. When
simulating in this environment, keep these requirements and limitations in mind.

Software Requirements

*  Windows 64-bit platform
* Visual Studio

* Microsoft® DirectX® — If this software is not already installed on your machine and you try to
simulate in the environment, the toolbox prompts you to install it. Once you install the software,
you must restart the simulation.

In you are customizing scenes, verify that Visual Studio and your Unreal Engine project is compatible
with the Unreal Engine version supported by your MATLAB release.

MATLAB Release

Unreal Engine Version

Visual Studio Version

R2018a-R2019b 4.19 2017
R2020a-R2021a 4.23 2019
R2021b 4.25 2019

Note Mac and Linux platforms are not supported for Unreal Engine simulation.

Minimum Hardware Requirements

* Graphics card (GPU) — Virtual reality-ready with 8 GB of on-board RAM
* Processor (CPU) — 2.60 GHz
* Memory (RAM) — 12 GB

Limitations

The Unreal Engine simulation environment blocks do not support:

* Code generation

* Model reference

* Multiple instances of the Simulation 3D Scene Configuration block
* Multiple Unreal Engine instances in the same MATLAB session

» Parallel simulations

* Rapid accelerator mode

* Multiple instances of the same actor tag. To refer to the same scene actor when you use the 3D
block pairs, such as Simulation 3D Actor Transform Get and Simulation 3D Actor Transform Set,
specify the same Tag for actor in 3D scene, Actortag parameter.
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In addition, when using these blocks in a closed-loop simulation, all Unreal Engine simulation
environment blocks must be in the same subsystem.

See Also

More About

. “Vehicle Scenarios”

External Websites

. Unreal Engine 4 Documentation
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How 3D Simulation for Vehicle Dynamics Blockset Works

The vehicle dynamics models run programmable maneuvers in a photorealistic 3D visualization
environment. Vehicle Dynamics Blockset integrates the 3D simulation environment with Simulink so
that you can query the world around the vehicle for virtually testing perception, control, and planning
algorithms. The Vehicle Dynamics Blockset visualization environment uses the Unreal Engine by Epic
Games.

Understanding how this simulation environment works can help you troubleshoot issues and

customize your models.

Communication with 3D Simulation Environment

When you use Vehicle Dynamics Blockset to run your algorithms, Simulink co-simulates the
algorithms in the visualization engine.

In the Simulink environment, Vehicle Dynamics Blockset:

* Determines the next position of objects by using 3D visualization environment feedback and
vehicle dynamics models.

* Configures the 3D visualization environment, specifically:

* Ray tracing
* Scene capture cameras
+ Initial object positions

In the visualization engine environment, Vehicle Dynamics Blockset positions the objects and uses ray
tracing to query the environment.

The diagram summarizes the communication between Simulink and the visualization engine.

8-8
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« Determine positions of ] Translation, rotation, scale = Position objects in 3D
objects » environment
« Configure 3D environment J Scene information . Query 3D environment
Simulink Visualization
Engine

Block Execution Order

During simulation, the 3D simulation blocks follow a specific execution order:
1 The vehicle blocks initialize the vehicles and send their X, Y, and Yaw signal data to the
Simulation 3D Scene Configuration block.

2 The Simulation 3D Scene Configuration block receives the vehicle data and sends it to the sensor
blocks.

3 The sensor blocks receive the vehicle data and use it to accurately locate and visualize the
vehicles.



How 3D Simulation for Vehicle Dynamics Blockset Works

The Priority property of the blocks controls this execution order. To access this property for any
block, right-click the block, select Properties, and click the General tab. By default, Simulation 3D
Vehicle with Ground Following blocks have a priority of -1, Simulation 3D Scene Configuration blocks
have a priority of 0, and sensor blocks have a priority of 1.

If your sensors are not detecting vehicles in the scene, it is possible that the 3D simulation blocks are
executing out of order. Try updating the execution order and simulating again. For more details on
execution order, see “Control and Display Execution Order”.

Also be sure that all 3D simulation blocks are located in the same subsystem. Even if the blocks have
the correct Priority settings, if they are located in different subsystems, they still might execute out
of order.

See Also

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-88

More About

. “Unreal Engine Simulation Environment Requirements and Limitations” on page 8-6
. “Scene Interrogation in 3D Environment” on page 3-32

External Websites
. Unreal Engine
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Place Cameras on Actors in the Unreal Editor

8-10

To visualize objects in an Unreal Editor scene, you can place cameras on static or custom actors in
the scene. To start, you need the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects
support package. See “Install Support Package and Configure Environment” on page 6-5.

To follow this workflow, you should be comfortable using Unreal Engine. Make sure that you have
Visual Studio 2019 installed on your computer.

Place Camera on Static Actor

Follow these steps to place a Simulation 3D Camera Get block that is offset from a cone in the Unreal
Editor. Although this example uses the To Video Display block from Computer Vision Toolbox™, you
can use a different visualization block to display the image.

1 In a Simulink model, add the Simulation 3D Scene Configuration, Simulation 3D Camera Get, and
To Video Display blocks.

Simulation 3D Scene Configuration

To Vidao
Display

¥

Image Image

To Video Display

Simulation 30 Camera Get

Set these block parameters. In the Simulation 3D Scene Configuration block, select Open
Unreal Editor.

Block Parameter Settings
Simulation 3D Scene * Scene Source — Unreal Editor
Configuration .

Project — Specify the path and name of the support
package project file. For example, C:\Local
\AutoVrtlEnv\AutoVrtlEnv.uproject



https://www.mathworks.com/matlabcentral/fileexchange/65966-vehicle-dynamics-blockset-interface-for-unreal-engine-4-projects

Place Cameras on Actors in the Unreal Editor

Block

Parameter Settings

Simulation 3D Camera Get

Sensor identifier — 1

* Vehicle name — Scene 0rigin

* Vehicle mounting location — Origin

* Specify offset — on

¢ Relative translation [X, Y, Z] — [-5, 0, 1]

This offsets the camera location from the cone mounting
location, 5 m behind, and 1 m up.

In the Unreal Editor, from the Place Actors tab, add a Sim 3d Scene Cap to the world, scene,

or map.

*{;r Place Actors

Sim 3d Scene Cap

. Sim8d Scene Cap

In the Unreal Editor, from the Place Actors tab, add a Cone to the world, scene, or map.

*{;,r Place Actors

Label

A28 HwStrght (Editor)
[ M Environment
4 @& Main Scene
& Landscapel
'‘® StraightRoad
4 % Cone
G 'y Sim3dSceneCapl

On the Details tab, under Transform, add a location offset of -500,0,100 inthe X, Y, and Z
world coordinate system, respectively. This attaches the camera 500 cm behind the cone and 100
cm above it. The values match the Simulation 3D Camera Get block parameter Relative

translation [X, Y, Z] value.
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12 actors (1 selected) € View Options~

(N Sim3dSceneCap]

4+ Add Component ~ &2 Blueprint/Add Script

Search Delaibenents

4 Transform
Location + X m ¥ m 2
Rotaticn n:Mvm.zm

6

Details
.
4+ Add Component = & Blueprint/Add Script
Search Domtstinents
Rendermg
Repheation
Inpuit

4 petor

7 Run the simulation.
a In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

b  Verify that the Diagnostic Viewer window in Simulink displays this message:
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In the Simulation 3D Scene Configuration block, you set the scene
source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the
scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

¢ In the Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

Observe the results in the To Video display window. The window displays the image from the
camera.

" S : b - T—

Place Camera on Vehicle in Custom Project

Follow these steps to create a custom Unreal Engine project and place a camera on a vehicle in the
project. Although the example uses the To Video Display block from Computer Vision Toolbox, you can
use a different visualization block to display the image.

To start, you need the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support
package. See “Install Support Package and Configure Environment” on page 6-5.

1 In a Simulink model, add the Simulation 3D Scene Configuration, Simulation 3D Camera Get, To
Video Display, Simulation 3D Actor Transform Set, and three Constant blocks.
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Simulation 3D Scene Configuration

Image * Image Tgi:;f:;

To Wideo Display

Simulation 3D Camera Get

‘ [-11310.0 - 300 8140.0 1001100 |—> Translation

ActTranslation

‘ [0o0] |—>Ro1au‘on

ActRotation

‘ [111] |—>s-:a|e

ActScale

Simulation 30 Actor Transform Set

Save the model.

2 Create a new project using the Vehicle Advanced template from the Epic Games Launcher by
Epic Games.

a In the Epic Games Launcher, launch Unreal Engine 4.25.

@ FOE tiresl Svgine Market Library winmoti UnroalfﬂE:gll:ahmA n

A Home ENGINE VERSIONS

g 42
cme |

Unreal Engine

MY PROJECTS

For more information about the Epic Games Launcher, see Unreal Engine.

b In the Unreal Project Browser, select Games and Next.
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Place Cameras on Actors in the Unreal Editor

Cancel
Ga o the next step

In Select Template, select the Vehicle Advanced template and Next.
11_ Unreal Project Bri
Select Template

Handheld
AR

Vehicle

In Project Settings, create a Blueprint or C++ project, and select a project name and
location. Click Create Project.
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1'( Unreal Project Browser

Project Settings

m whether to
|l

Blueprint C++ project Desktop / Console

Hardware

section of

t a location for your project te ed
CUE25 Jpoect ]

Folder Name

Create Project

The Epic Games Launcher creates a new project and opens the Unreal Editor.
e Enable the MathWorks Interface plugin.

i  Select Edit > Plugins.
ii  On the Plugins tab, navigate to MathWorks Interface. Select Enabled.

u

" Pligine

¢ Installed

i Installe ¢
= MathWorks METhWOI’kS Interface m

En connectivity between MATLAB/Simulink and UE4

4 ® Built-In

]
|

dvertising
|

Enabled
L3

ul al ml

> b

& Support

f  Save the project. Close the Unreal Editor.

Open the Simulink model that you saved in step 1. Set these block parameters. In the Simulation
3D Scene Configuration block, select Open Unreal Editor.

Block Parameter Settings
Simulation 3D Scene ¢ Scene Source — Unreal Editor
Configuration

Project — Specify the path an project that you saved in
step 2. For example, myProjectPath
\myProject.uproject




Place Cameras on Actors in the Unreal Editor

Block Parameter Settings

Simulation 3D Camera Get Sensor identifier — 1
* Vehicle name — Scene 0rigin

* Vehicle mounting location — Origin

Simulation 3D Actor * Tag for actor in 3D scene — MainCameral
Transform Set
ActTranslation * Constant value — [-11310.0 - 300 8140.0
100]/100

* Interpret vector parameters as 1-D — of f
ActRotation * Constant value — [0 0 0]

¢ Interpret vector parameters as 1-D — off
ActScale * Constant value — [1 1 1]

* Interpret vector parameters as 1-D — of f

4 In the Simulation 3D Scene Configuration block, select Open Unreal Editor.

5 In the Unreal Editor, from the Place Actors tab, add a Sim 3d Scene Cap to the world, scene,
or map.
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::f;

5 p .

§ o . <

K Add New = = Save All

e
m'u

6 On the vehicle VehicleBlueprint, drag and drop a camera. Choose a vehicle socket or bone to

attach the camera to.
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7  On the Details tab, tag the Sim3dSceneCapl with the name Cameral.

—~
1) Details

.
+ Add Component = & Blueprint/Add Script

=eaich Lomponenls

ARG LG Always Spawn, Ignore Collisions v

Femd Camera Component when 'V

1 Array elements + @ -

8 Set the parent class.

a Under Blueprints, click Open Level Blueprint, and select Class Settings.
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b

In the Class Options, set Parent Class to Sim3dLevelScriptActor.

w »

4 Class Options

d | HEEEEEUTOE

4 Blueprint Options

9 Save the project.

10 Run the simulation.

In the Simulink model, click Run.

Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

Verify that the Diagnostic Viewer window in Simulink displays this message:

In the Simulation 3D Scene Configuration block, you set the scene
source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the
scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

In the Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

Observe the results in the To Video Display window.
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See Also
Simulation 3D Camera Get | Simulation 3D Scene Configuration

More About
. “Animate Custom Actors in the Unreal Editor” on page 8-23
. “Get Started Communicating with the Unreal Engine Visualization Environment” on page 6-20

External Websites
*  Unreal Engine


https://www.unrealengine.com/en-US/unreal

Animate Custom Actors in the Unreal Editor

Animate Custom Actors in the Unreal Editor

Follow these steps to animate a custom actor in the Unreal Editor. Before you start, make sure you
that you have Visual Studio 2019 and the Vehicle Dynamics Blockset Interface for Unreal Engine 4
Projects support package installed on your machine. For more information, see “Install Support
Package and Configure Environment” on page 6-5.

Additionally, make sure that:

* You are comfortable coding with C++ in Unreal Engine.

* Your Unreal Editor C++ project contains a skeletal actor mesh. This example uses a bicycle mesh.

This examples provides the workflow for animating a bicycle actor. The general workflow is adapted
from the Unreal Engine Vehicle User Guide.

Set up Simulink Model

Step 1: Set up Simulink Model

Open a new Simulink model and add these blocks:

Two Ramp blocks

Constant block

Simulation 3D Actor Transform Set block
Simulation 3D Scene Configuration block
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Connect and name the blocks as shown.

'

_/’/ # Translation
Translation

_/’/ | Ralation
Rotation

|3=3) ] Scale

Scale

Simulation 30 Scene Configuratian

Simulafiaon 30 Acior Transfarm Set

Step 2: Configure Blocks

Configure blocks with these parameter settings.

Block Parameter Settings
Simulation 3D Scene * Scene source — Unreal Editor
Configuration + Project — Name and location of the installed support package

project file, for example, C:\Local\AutoVrtlEnv
\AutoVrtlEnv.uproject.

Scene view — Scene 0Origin

Simulation 3D Actor
Transform Set

Actor Setup tab:

+ Tag for actor in 3D scene, ActorTag — Bikel

Note This tag should match the Unreal Editor tag name in
“Step 6: Instantiate the Bicycle Actor” on page 8-37.

* Number of parts per actor to set, NumberOfParts — 3

Initial Values tab:

* [Initial array values to translate actor per part,
Translation — [0 0 0;0 0 0;0 0 O]

+ [Initial array values to rotate actor per part, Rotation —
[000;000;00 0]

* Initial array values to scale actor per part, Scale — [1 1
1;111;111]

Translation Ramp

Slope — [0.35 0 0;0 0 0;0 0 0]

Rotation Ramp

Slope — [0 0 0;0 -pi/5 0;0 -pi/5 0]

Scale Constant

Constantvalue — [1 1 1;1 1 1;1 1 1]
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Set up Unreal Editor to Animate Bicycle

Step 3: Set up Animation Instance

1 In your Simulink model, use the Simulation 3D Scene Configuration block Open Unreal Editor
parameter to open the Unreal Editor.

2 Select File > New C++ Class. In the Choose Parent Class dialog box, select Show All
Classes. Search for AnimInst. Add the AnimInstance parent class.

U

Choose Parent Class

code file to your game project B show Al Classes

arhnimingt
3 TranlerAniminst
niminsd
niminstance

imingt

Cancel

3 Name the new C++ class SimulinkBikeAnimInst. Select Public. Click Create Class.

Path C:/Local/AutoVrtlIEnv/Source/AutoVrtlEnv/Public/ Choose Folder

Header File c:/Local/AutoVrtiEnv/Source/AutoVrtlEnv/Public/SimulinkBikeAnimInst.h

Source File C:/Local/AutoVrtiEnv/Source/AutoVrtiEnv/Private/SimulinkBikeAnimInst.cpp

4 In Visual Studio 2019, open the C:\Local\AutoVrtlEnv\AutoVrtlEnv.sln file. Navigate to
the SimulinkBikeAnimInst.cpp and SimulinkBikeAnimInst.h source files.
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Solution Explorer
@B~ o-Ssa@| o fp-
Search Solution Explorer (Ctrl+;)

4 [%] AutoVrtlEnv
P =-m References
P 1 External Dependencies
P Config
b Plugins
4 Source
4 . AutoVrtlEnv
4 ] Private
++ BicycleActor.cpp
4 2] Public

4 [ BicycleActor.h
#= ABicycleActor

Edit the files as shown.

Tip For this example, the code includes FWheelRotation and RWheelRotation properties to
animate the bicycle wheel rotation. You can add additional properties to animate other parts of
the bicycle.

Code: SimulinkBikeAnimInst.h

// Copyright 2019 The MathWorks, Inc.
#pragma once

#include "CoreMinimal.h"
#include "Animation/AnimInstance.h"
#include "SimulinkBikeAnimInst.generated.h"

/**

ES

*/

UCLASS(transient, Blueprintable, hideCategories = AnimInstance, BlueprintType)
class AUTOVRTLENV_API USimulinkBikeAnimInst : public UAnimInstance

GENERATED_UCLASS_BODY ()
public:
UPROPERTY (EditAnywhere, BlueprintReadWrite, Category = WheelRotation)
float FWheelRotation;

UPROPERTY (EditAnywhere, BlueprintReadWrite, Category = WheelRotation)
float RWheelRotation;
};

Code: SimulinkBikeAnimInst. cpp

// Copyright 2019 The MathWorks, Inc.
#include "SimulinkBikeAnimInst.h"

USimulinkBikeAnimInst::USimulinkBikeAnimInst(const FObjectInitializer& ObjectInitializer)
: Super(ObjectInitializer) {
FWheelRotation 0.0f;
RWheelRotation 0.0f;
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5 In the Unreal Editor click Compile.

World Outliner

Step 4: Create Animation Blueprint

1 Inyour Simulink model, use the Simulation 3D Scene Configuration block Open Unreal Editor

parameter to open the Unreal Editor.

2 Inthe Unreal Editor, on the Content Browser tab, under View Options, select Show Engine

Content and Show Plugin Content.

¥ pe
® Tiles
List

Columns

| Show Folders

Show Collections

Show Developers Content
| Show Engine Content
| Show Plugin Content

Show Localized Content

#| Search Collection Names

Thumbnail Edit Mode

#| Real-Time Thumbnails

w View Options

3 Add the animation mesh. On the Content Browser tab, navigate to MathWorksSimulation

Content > Vehicles > Bicyclist > Meshes.

8-27



8 3D Simulation

== Content Browser

B AddNew~ & Import Save All

€ | &= MathWorksSimulation Content
PEN Search Paths

>3 MathWorksAerospace C++ Classes

4 @ MathWorksSimulation Content

[ @m Characters
[ #m Landscape

I SensorAssets
[ Im VehicleCommon
4 & Vehicles

4 &= Bicyclist

[ W Male_Rider1
| Materials

Il Texiures

4 Select Add New > Animation > Animation Blueprint.

== Content Brows % Blueprint Class Aim Off

j Add New ~
. LI‘ Level r_ Aim Offset 1D
= .~ i

Material

'-'.‘ Particle

"5;5 Animation Layer Interface

b : ——

: Hdie F"l' ed Asset = Animation Monta
Viateria i

B Texture:  Artificial Intelligence

fa s

Animation ! 1|I-|IIIII'.'| S ETLD

5 In the Create Animation Blueprint dialog box, select:

* Parent Class: SimulinkBikeAnimInst
+ Target Skeleton: SK Bicycle Skeleton
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P . v
U Create Animation Blueprint | ]

Parent Class:

SimulinkBikeAniminst X

X simulinkBikeAniminst

€ View Options~

Target Skeleton:

SK_Bicycle_Skeleton| XPp3
( None )

MName i Type

M SK_Bicycle_Skeleton :

« View Options -

Click OK.
Name the blueprint BikeAnimation. Right-click and select Save.

| & MathWorksSimulation Content » Vehicles » Bicyclist » Meshes »

T Filters « [EEEEiraR NIt

BikeAnimation (Animation Blueprint)

fMath) imulation/Vehicles/Bicyclist/Meshes
h Length 60
AutoVrl ulinkBikeAniminst
Class: AutoVrtlEnv SimulinkBikeAniminst

4 items |1 El':"ll':l.u:l.l_ll
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7 Open the BikeAnimation blueprint. Make the connections as shown.

——
.~ Make Rotator

Tranzform (Modify) Bone 4

Retun Value @
" @ Rotation

* Compone

B
Output Pose
o Alpha [10] -
Mesh Space Ref Pose
Component To Local

] * —lp aﬂﬁ:—'.-.]!l

nent Pose ,

Retum Value @ @ Rotation
] Compone

e Alpha [10

= Make Rotator

Make sure that you set:

* Bone to Modify to the correct bone
* Rotation Mode to Replace Existing
* Rotation Space to Bone Space
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i Skeletal Control

Bane 10 Modif
(FTransform (Modity) Bone

@ Rotaban

ok

ranslorm (Modity) Bone

8 Compile and save the blueprint.
Step 5: Create Bicycle Actor C++ Class

1 In the Unreal Editor, on the Content Browser tab, under View Options, select Show Engine
Content and Show Plugin Content.
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® Tiles

List

Columns

55 Names
Search Asset Path

| Search Collection Names

Thumbnail Edit Mode

| Real-Time Thumbnails

2 From the MathWorksSimulation C++ Classes folder, select Sim3dActor.
== Content Browser
I Add New ~ . Imp Save All & =& K& MathWorksSimulation C++ Classes » MathWorksSimulati

el sim x LRZICER M Soarch Public

" mm MathWorksSimulation Content

4 g MathWorksSimulation C++ Classes
4 =y MathWorksSimulation
5t

3dActor.h
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Right-click and select Create C++ class derived from Sim3dActor.

4.: | &= Create C++ class derived from Sim3dActor

™ i . w s e 1 - O e - i
g Create Bluepnnt class based on Sim3dActor

™ Showin F

® show in Explorer

Tip If you do not see the MathWorksSimulation C++ Classes folder, use these steps to check that
you have the MathWorksSimulation plugin installed and enabled:
a In the Unreal Editor toolbar, select Edit > Plugins.
In the Plugins window, verify that the MathWorks Interface plugin is listed in the installed
window. If the plugin is not already enabled, select the Enabled check box.
If you do not see the MathWorks Interface plugin in this window, repeat step 3 in
“Configure Environment” on page 6-5 and reopen the editor from Simulink.
¢ Close the editor and reopen it from Simulink.

3 Name the new Sim3dActor BicycleActor. Select Public. Click Create Class.

Path C:/Local/AutoVrtlEnv/Source/AutoVrtlIEnv/Public/ Choose Folder

Header File c:/Local/AutoVrtiEnv/Source/AutoVrtlEnv/Public/BicyeleActor.h

Source File G:/Local/AutoVrtIEnv/Sou rce/AutoVrtlEnv/Private/BicycleActor.cpp

4 In Visual Studio, navigate to BicycleActor.h and BicycleActor.cpp.

8-33



8 3D Simulation

Solution Explorer
(;j EJ* - .k) -5 8 qu <> 4“ —
Search Solution Explarer (Ctrl+;)

31 Solution ‘AutoVrtiEny' (2 of 2 projects)

4 Engine
P [ UE4
4 Games

4 %] AutoVrtilEnv

=B References

= External Dependencies
Config
Plugins

i
B
b
b
4 . Source
4 . AutoVrtlEnv
4 Private
++ BicycleActor.cpp
P #+ SimulinkBikeAnimInst.cpp
4 .| Public
P [M BicycleActorh
P [9) SimulinkBikeAniminst.h
; tests
c* AutoVrtlEnv.Build.cs

P ++ AutoVitlEnv.cpp

b

Edit the files as shown.

Tip For this example, the code includes logic to animate the bike body (BIKE BODY), front
wheel (FRONT_WHEEL), and rear wheel (REAR_WHEEL). You can add additional logic to animate
other parts of the bicycle.

Code: BicycleActor.h

// Copyright 2019 The MathWorks, Inc.
#pragma once

#include "CoreMinimal.h"
#include "Sim3dActor.h"
#include "BicycleActor.generated.h"

UCLASS()
class AUTOVRTLENV API ABicycleActor : public ASim3dActor

{
GENERATED_BODY ()

// Reference to animation blueprint and skeletal mesh
UClass* BicycleAnimation;
USkeletalMesh* BicycleMesh;

//Enum for parts that we want to control from simulink

enum {
BIKE BODY = 0,
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FRONT WHEEL = 1,
REAR WHEEL =2,
NumberOfParts = 3

I

enum {
X =0,
Y =1,
Z=2

I

enum {
PITCH = 0,
ROLL = 1,
YAW = 2

I

public:

//Containers to receive data from Simulink
float Translation[NumberOfParts][3];

float Rotation[NumberOfParts][3];

float Scale[NumberOfParts][3];

ABicycleActor();

//0verride functions for enabling Simulink to control this actor
virtual void Sim3dInit() override;

virtual void Sim3dSetup() override;

virtual void Sim3dStep(float DeltaSeconds) override;

virtual void Sim3dRelease() override;

//Some helper functions
void SetMesh(FString MeshRef);
void SetAnim(FString AnimRef);

//Function to update position/orientation of actor at each step
virtual void Transform();

// Returns Mesh subobject
class USkeletalMeshComponent* GetMesh() const;

//Reference to skeletal mesh component
UPROPERTY (Category = Bicyclist,
VisibleDefaultsOnly,
BlueprintReadOnly,
meta = (AllowPrivateAccess = "true"))
class USkeletalMeshComponent* Mesh;

protected:
virtual int GetNumberOfParts() { return (NumberOfParts); }

}i

// Returns Mesh subobject

FORCEINLINE USkeletalMeshComponent* ABicycleActor::GetMesh() const {
return Mesh;

}

Code: BicycleActor.cpp

// Copyright 2019-2021 The MathWorks, Inc.
#include "BicycleActor.h"

#include "SimulinkBikeAnimInst.h"
#include "Math/UnrealMathUtility.h"

ABicycleActor: :ABicycleActor() {
//Create mesh component
Mesh = CreateOptionalDefaultSubobject<USkeletalMeshComponent>(TEXT("ABicycleMesh"));

RootComponent = Mesh;

}

void ABicycleActor::Sim3dInit() {
Super::Sim3dInit();
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}

void ABicycleActor::Sim3dSetup() {
SetMesh (TEXT("/MathWorksSimulation/Vehicles/Bicyclist/Meshes/SK Bicycle"));
SetAnim(TEXT("/MathWorksSimulation/Vehicles/Bicyclist/Meshes/BikeAnimation.BikeAnimation C"));

GetMesh()->SetSkeletalMesh(BicycleMesh);
GetMesh()->SetAnimationMode (EAnimationMode: :AnimationBlueprint);
GetMesh()->SetAnimInstanceClass(BicycleAnimation);

Transform();

}

void ABicycleActor::Sim3dStep(float DeltaTime) {
Transform();
}

void ABicycleActor::Sim3dRelease() {
Super::Sim3dRelease();
}

void ABicycleActor::Transform() {
//Initialize
int status = 0;
FVector ActorLocation;
FRotator ActorRotation;
FVector ActorScale;
USimulinkBikeAnimInst* Animation = NULL;
Animation = Cast<USimulinkBikeAnimInst>(GetMesh()->GetAnimInstance());

//Read data from simulink
status = ReadSimulation3DActorTransform(readerTransform, Translation, Rotation, Scale);

//Set bicycle position and orientation

ActorLocation.Set(Translation[BIKE BODY][X], Translation[BIKE BODY][Y], Translation[BIKE BODY][Z]);
ActorRotation.Pitch = Rotation[BIKE BODY][PITCH];

ActorRotation.Roll = Rotation[BIKE BODY][ROLL];

ActorRotation.Yaw = Rotation[BIKE BODY][YAW];

//Unit conversion from simulink to UE, meteres to cm and radians to degrees
ActorLocation = ActorLocation * 100.0f;

ActorRotation = FMath::RadiansToDegrees(ActorRotation);
ActorScale.Set(Scale[BIKE BODY][X], Scale[BIKE BODY][Y], Scale[BIKE BODY][Z]);

SetActorLocation(ActorLocation);
SetActorRotation(ActorRotation);
SetActorScale3D(ActorScale);

//Set properies in animation blueprint
Animation->FWheelRotation = FMath::RadiansToDegrees(Rotation[FRONT WHEEL][ROLL]);
Animation->RWheelRotation = FMath::RadiansToDegrees(Rotation[REAR WHEEL][ROLL]);

//Unit conversion from UE to simulink

ActorLocation = GetActorLocation();

ActorLocation = ActorLocation * .01f; // cm ->m
ActorRotation = GetActorRotation();

ActorRotation = FMath::DegreesToRadians(ActorRotation);
ActorScale = GetActorScale3D();

Translation[BIKE BODY][X] ActorLocation.X;
Translation[BIKE BODY][Y] ActorLocation.Y;
Translation[BIKE BODY][Z] ActorLocation.Z;
Rotation[BIKE BODY][X] = ActorRotation.Pitch;
Rotation[BIKE BODY][Y] = ActorRotation.Roll;
Rotation[BIKE BODY][Z] = ActorRotation.Yaw;

Scale[BIKE BODY][X] = ActorScale.X;

Scale[BIKE BODY][Y] = ActorScale.Y;

Scale[BIKE BODY][Z] = ActorScale.Z;

Translation[FRONT WHEEL][X] = 0.0f;
Translation[FRONT WHEEL][Y] = 0.0f;
Translation[FRONT WHEEL][Z] = 0.0f;

Translation[REAR WHEEL][X] = 0.0f;
Translation[REAR WHEEL][Y] = 0.0
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Translation[REAR WHEEL][Z] = 0.0f;

Rotation[FRONT WHEEL][PITCH] = 0.0f;

Rotation[FRONT WHEEL][ROLL] = FMath::DegreesToRadians(Animation->FWheelRotation);
Rotation[FRONT WHEEL][YAW] = 0.0f;

Rotation[REAR WHEEL][PITCH] = 0.0f;

Rotation[REAR WHEEL][ROLL] = FMath::DegreesToRadians(Animation->RWheelRotation);
Rotation[REAR WHEEL][YAW] = 0.0f;

Scale[FRONT_WHEEL][X] = 1.0f;
Scale[FRONT_WHEEL][Y] = 1.0f;
Scale[FRONT_WHEEL][Z] = 1.0f;
Scale[REAR_WHEEL][X] = 1.0f;
Scale[REAR_WHEEL][Y] = 1.0f;
Scale[REAR_WHEEL][Z] = 1.0f;

//Write data back to simulink
WriteSimulation3DActorTransform(writerTransform, Translation, Rotation, Scale);

}
void ABicycleActor::SetMesh(FString MeshPath) {
BicycleMesh =
Cast<USkeletalMesh>(StaticLoadObject (USkeletalMesh::StaticClass(), NULL, *MeshPath));
}

void ABicycleActor::SetAnim(FString AnimPath) {
BicycleAnimation = StaticLoadClass(USimulinkBikeAnimInst::StaticClass(), NULL, *AnimPath);
}

Tip In the code, make sure to use relative paths when you specify the mesh and animation asset
locations.

void ABicycleActor::Sim3dSetup() {
SetMesh(TEXT("/MathWorksSimulation/Vehicles/Bicyclist/Meshes/SK Bicycle"));
SetAnim(TEXT("/MathWorksSimulation/Vehicles/Bicyclist/Meshes/BikeAnimation.BikeAnimation C"));

GetMesh () ->SetSkeletalMesh(BicycleMesh);
GetMesh()->SetAnimationMode (EAnimationMode: :AnimationBlueprint);
GetMesh()->SetAnimInstanceClass(BicycleAnimation);

Transform();

}

5 In the Unreal Editor click Compile.

= World Outliner

Search...

Step 6: Instantiate the Bicycle Actor

1 Inyour Simulink model, use the Simulation 3D Scene Configuration block Open Unreal Editor
parameter to open the Unreal Editor.

2 Place the Bicycle Actor in the scene.

8-37



8 3D Simulation

s Modes

“Urar 1

{ Rpective }Hﬂl&ﬂ_

Dicycle

. Bicyele Actor

o b i -7 am S e,

3  Set the tag to the same value as the Simulation 3D Actor Transform Set block Tag for actor in
3D scene, ActorTag. For this example, set the value to Bikel.
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= World Outliner

Label

BicycleActor
o Ve

i Details ® World Settings

.
4+ Add Companent ~

Search Components

BicycleActor] (Instance)

1 Array elements =+ ﬂ L~

m - B

Set up Camera View (Optional)

Optionally, set up a camera view to override the default view. You can use either Simulink or a level
blueprint to set up the camera view. For the recommended option, use Simulink.

Step 7: Use Simulink (Recommended)
To setup a camera view that follows along with the bicycle:
1  Add these blocks to the model.

* One Ramp block
* One Add block
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* Three Constant blocks

* Simulation 3D Actor Transform Set block

Connect and name the blocks as shown.

[0 -5.1 0.56]

CamRamp_|—’ +

=+

CamTranslation

W Translation

[0 0 deg2rad(85)]

CamRotation

P Ratation

[1 1 1]

- M Scale

CamScale

2 Set these block parameters.

Simulation 3D Actor Transform Sel: Camera Control

Block

Parameter Settings

Simulation 3D Actor

Transform Set: Camera

* Tag for actor in 3D scene, ActorTag — MainCameral

Control
CamTranslation * Constant value — [0 -5.1 0.56]

* Interpret vector parameters as 1-D — off
CamRotation * Constant value — [0 0 deg2rad(85)]

¢ Interpret vector parameters as 1-D — off
CamScale * Constant value — [1 1 1]

* Interpret vector parameters as 1-D — off

Step 7: Use Level Blueprint

To override the default camera view:

1 Add a camera actor. Assign it as a child of the BicycleActor.

2 Use the Transform settings to specify the location and viewing angle.
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40w Main Scene

12 actors (1 selected)

1 [etails ® World sett
b
4 Add Component = o Blueprint/Add Script

search Components

w7 CameraActor(instance)

4 & SceneComponent (Inhenited)
%y CameraComponent (Inhented)

Search Detalls

4 Transform

Location «

4 Camera Settings

= an Mode Perspective

Open the level blueprint.
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{nrl

Yy -

Cinematics

== T

4 In the level blueprint, make these connections. If you right-click on the Event Graph to find
nodes, clear Context Sensitive. If you have a CameraActor, you can drag it to the Event Graph
from the World Outliner view in the editor.

f Delay o

» completed [P

O» Duration 0.0 - s
g UENON 100 f Set View Target with Blend
> Event BeginPlay Target syer Cont
. o o ol .
g Target
[ Get Player Controller -
; New View Target
» Player Index | g | Return Value £
] C» Blend Time [0.0]

Blend Func
VTBlend Linear

» Blend Exp [0.0]

Lock Outgoing D

f % CameraActor

5 Save the blueprint and project. Close the Unreal Editor.

Run Simulation

After you configure the Simulink model and Unreal Editor environment, run a simulation.
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In your Simulink model, make sure that you have set the Simulation 3D Scene Configuration
parameters to these values:
* Scene source — Unreal Editor

* Project — Name and location of the installed support package project file, for example,
C:\Local\AutoVrtlEnv\AutoVrtlEnv.uproject.

* Scene view — Scene 0Origin

Use the Simulation 3D Scene Configuration block Open Unreal Editor parameter to open the
Unreal Editor.

Run the simulation.

a In the Simulink model, click Run.
Because the source of the scenes is the project opened in the Unreal Editor, the simulation
does not start.

b  Verify that the Diagnostic Viewer window in Simulink displays this message:
In the Simulation 3D Scene Configuration block, you set the scene

source to 'Unreal Editor'. In Unreal Editor, select 'Play' to view the
scene.

This message confirms that Simulink has instantiated the vehicles and other assets in the
Unreal Engine 3D environment.

¢ Inthe Unreal Editor, click Play. The simulation runs in the scene currently open in the
Unreal Editor.

See Also
Simulation 3D Actor Transform Set | Simulation 3D Scene Configuration

More About

“Get Started Communicating with the Unreal Engine Visualization Environment” on page 6-20
“Place Cameras on Actors in the Unreal Editor” on page 8-10

External Websites

Unreal Engine
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